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Глава 1. Краткий обзор StarUML
Эта глава содержит общий обзор StarUML ™, включая краткую характеристику UML. 

Что такое StarUML
StarUML ™ - программный инструмент моделирования, который поддерживает UML 

(Унифицированный язык моделирования). StarUML ориентирован на UML версии 1.4 и 
поддерживает одиннадцать различных типов диаграмм, принятых в нотации UML 2.0. Он активно 
поддерживает подход MDA (Модельно-управляемая архитектура), реализуя концепцию профилей 
UML. Среда разработки StarUML ™ превосходно настраивается в соответствии с требованиями 
пользователя и имеет высокую степень расширяемости, особенно в области своих 
функциональных возможностей. Использование StarUML ™, одного из ведущих программных 
инструментов моделирования, гарантирует достижение максимальной производительности и 
качества ваших программных проектов.

Инструмент UML, который адаптируется к пользователю

StarUML ™ предоставляет максимальную степень адаптации среды разработки пользователя, 
предлагая настройку параметров, которые могут влиять на методологию разработки программного 
обеспечения, проектную платформу и язык.

Истинная поддержка MDA

Разработка методологии описания архитектуры программ - важный процесс, который будет 
развиваться ещё 10 или более лет. Намерение OMG (Ассоциация объектно-ориентированного 
управления) состоит в том, чтобы использовать технологию MDA (Модельно-управляемая 
архитектура) для создания платформенно-независимых моделей, на базе которых можно 
автоматически формировать платформенно-зависимые модели или программные коды. StarUML ™ 
полностью поддерживает стандарт UML 1.4, нотацию UML 2.0 и концепцию профилей UML, 
позволяя создавать платформенно-независимые модели. Пользователи могут легко 
документировать их с помощью простых документных шаблонов.

Превосходная расширяемость и гибкость 

StarUML™ обеспечивает превосходную расширяемость и гибкость. Он предоставляет механизм 
аддинов, чтобы расширять свои функциональные возможности. Этот механизм разработан 
специально, чтобы предоставлять доступ ко всем функциям модели/мета-модели посредством 
COM Automation и расширять меню и набор свойств элементов. Также, пользователи могут 
создавать собственные подходы и механизмы согласно своим собственным методологиям. 
Программа может также быть интегрирована с любыми внешними инструментальными 
средствами.

Главные особенности 
StarUML ™ имеет следующие новые возможности.
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Точное соответствие стандарту UML 

StarUML ™ строго придерживается спецификации UML, разработанной OMG для 
моделирования программ. Следует понимать, что использование нерегулярного синтаксиса UML в 
информационных проектах через 10 или более лет может привести к печальным последствиям. 
StarUML ™ максимально соответствует стандарту UML 1.4 и следует нотации UML 2.0 на основе 
устойчивой мета-модели.

Открытый формат программной модели

В отличие от многих существующих программ, которые используют собственные 
неэффективные форматы файла модели, StarUML ™ оперирует файлами в стандартном формате 
XML. Коды, написанные в легких для чтения структурах и форматах, могут быть легко изменены с 
помощью синтаксического анализатора XML. Учитывая факт, что XML является мировым 
стандартом, это, конечно, большое преимущество, которое гарантирует, что программные модели 
останутся полезными больше чем через десятилетие.

Истинная поддержка MDA 

StarUML ™ действительно поддерживает профили UML. Это максимизирует расширяемость 
UML, делая моделирование на UML применимым даже в области финансов, обороны, электронной 
коммерции, страховании и аэронавтике. На самом деле можно создавать платформенно 
независимые модели (PIM), а платформенно зависимые модели (PSM) и исполняемые коды могут 
быть всегда автоматически сгенерированы на их основе.

Применимость методологий и платформ 

StarUML ™ использует концептуальный подход, который применим к любым 
методологиям/процессам. Легко создаются не только модели под средства разработки для 
конкретных платформ типа .NET или J2EE, но также и для других основных структур 
программных моделей (например модель представления 4+1, и т.д.).

Превосходная расширяемость

Все функции StarUML ™ реализованы в соответствии с Microsoft COM. Любой язык, который 
поддерживает COM (Visual Basic Script, Java Script, VB, Delphi, C++, C#, VB.NET, Python, и т.д.), 
может использоваться, чтобы вызывать StarUML ™ или разрабатывать интегрированные 
дополнения (аддины).

Программная функция проверки модели

Пользователи могут допускать ошибки в процессе моделирования. Такие ошибки могут дорого 
обойтись, если они не будут исправлены к заключительной стадии формирования кода. Чтобы 
предотвращать такие ситуации, StarUML автоматически проверяет модель программы, 
разрабатываемую пользователем, облегчая раннее обнаружение ошибок и способствуя 
безупречной и полной разработке программного обеспечения.
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Полезные аддины 

StarUML ™ включает много полезных аддинов с различными функциональными 
возможностями: генерация исходных текстов на языках программирования, конвертация исходных 
текстов в модели, импорт файлов Rational Rose, обмен модельной информацией с другими 
программными средствами, с использованием XMI, поддержка шаблонов проектирования. Эти 
аддины предоставляют дополнительные функции, увеличивают производительность, гибкость и 
функциональную совместимость моделей.

Системные требования
Ниже указаны минимальные системные требования, необходимые для функционирования 

StarUML™.

• Intel ® Pentium ® 233MHz или выше 
• Windows ® 2000, Windows XP ™, или выше 
• Microsoft ® Internet Explorer 5.0 или выше 
• 128 Мбайт RAM (256 МБ рекомендуется) 
• 110 Мбайт на жестком диске (150 МБ рекомендуется) 
• Устройство CD-ROM 
• SVGA или монитор с более высокой разрешающей способностью (1024x768 рекомендуется) 
• Мышь или другое устройство позиционирования 
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Глава 2. Основные концепции
Эта глава вводит фундаментальные концепции, которые требуется знать для эффективного 

использования StarUML ™. Она содержит описание моделей, визуальных элементов и диаграмм, 
проектов, секций, подходов, фреймворков, модельных фрагментов, их различий относительно 
разных профилей UML. 

• Модель, 
• Представление (view) и Диаграмма 
• Проект и проектная секция (unit) 
• Модуль (module) 

Модель, Представление и Диаграмма

StarUML ™ предполагает ясное понимание концептуального различия между моделями, 
представлениями и диаграммами. Модель - элемент, который содержит всю информацию о модели 
программы. Представление - визуальное выражение информации, содержавшейся в модели, а 
Диаграмма - коллекция визуальных образов, которая отображает определенные аспекты проекта. 

Проект и проектная секция 

Проект

Проект - основная структурная единица в StarUML ™.

Проект может содержать одну или более программных моделей. Проект - корневой пакет 
верхнего уровня, который всегда существует в любой программной модели. В общем случае, один 
проект сохраняется в одном файле.

Структура проекта

Проект содержит следующие суб-элементы.

Модель
Элемент, который соответствует одной программной модели. 

Подсистема
Элемент, который соответствует модели подсистемы. 
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Пакет
Самый общий элемент для группировки других элементов. 

Проектный файл

Проектные файлы сохраняются в формате XML и имеют расширение ".UML". Все модели, 
представления и диаграммы, созданные в StarUML™ сохраняются в одном проектном файле. 
Проект может также быть разделен и сохранен в нескольких проектных секциях. Проектный файл 
содержит следующую информацию

• профиль UML, используемый в проекте 
• файлы секций, на которые ссылается проект 
• информация по всем моделям, содержавшимся в проекте 
• информация по всем диаграмм и представлениям, содержавшимся в проекте 

Секции

Хотя проект обычно сохраняется в одном файле, бывают случаи, когда его целесообразно 
хранить в нескольких небольших файлах так, чтобы несколько разработчиков могли работать над 
проектом одновременно. В этом случае, проект представляется в виде набора секций. Секция 
может иметь иерархическую структуру; она может содержать несколько подсекций. Секции 
сохраняются как XML-файлы на которые ссылаются проектные файлы (.UML) или другие файлы 
секций (.UNT). 

Состав секции

Только пакет, подсистема или модель могут составлять секцию. Все элементы внутри пакетов 
этих типов сохраняются в соответствующем файле секции (.UNT). 

Иерархическая структура секции

Также, как проект может содержать много секций внутри себя, секция тоже может включать 
много подсекций. Так как родительская секция имеет ссылки на свои дочерние секции, всё 
множество секций имеет иерархическую структуру. 

Фрагменты модели

Фрагмент модели - часть проекта, сохраненная как отдельный файл. Только модель, подсистема 
или пакет может являться фрагментом модели. Файлы модельных фрагментов сохраняются с 
расширением ".MFG". Они могут быть легко включены в любой проект в любое время. Фрагменты 
модели существенно отличаются от секций, которые полностью едины с остальной частью 
проекта. 
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Модуль

Модуль

Модуль - пакет, предназначенный для предоставления новых функций и возможностей 
расширяющих StarUML™. Модуль может быть создан как комбинация нескольких элементов 
расширения. В модуле также, Вы можете не только конфигурировать готовые элементы 
расширения, но и создавать новые типы таких элементов. 

• Модуль StarUML™ предоставляет следующие функции. 
• Расширение главного меню или всплывающего меню. 
• Добавление нового подхода 
• Добавление нового профиля 
• Добавление нового элемента посредством стереотипа или расширения нотации 
• Реализация новой функции (через COM-сервер или простой файл скрипта) 
• Интеграция с другими приложениями 
• Другие функции 

Подходы (approaches)

Есть многочисленные методологии разработки программного обеспечения, и каждая компания 
или организация либо разрабатывает свою собственную методологию, либо использует уже 
существующую, изменяя её, чтобы она лучше удовлетворяла требованиям групп разработчиков 
проектов. Предметные области, языки программирования и платформы также различаются для 
разных частей разрабатываемого программного обеспечения. Следовательно, на начальной стадии 
программного моделирования должно быть согласовано много разных элементов. StarUML ™ 
предлагает концепцию подходов, чтобы облегчить конфигурирование таких элементов. 

Структура подхода

Подход состоит из следующих элементов. 

• Структура проекта
Определяет основную структуру проекта. Эта структура может быть определена с помощью 
пакетов, подсистем и модельных элементов. Для диаграмм определяется формат по 
умолчанию. 

• Импорт профиля
Автоматическое включение заданного по умолчанию профиля UML в проект. 

• Импорт фреймворков
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Автоматическая загрузка и включение заданных по умолчанию фреймворков в проект. 
• Импорт фрагментов модели

Автоматическая загрузка и включение заданных по умолчанию фрагментов модели в 
проект. 

Фреймворки 

Фрэймворки (инструментарии) в StarUML ™ - это библиотеки спецификаций классов для 
прикладных инструментов типа MFC, VCL или JFC. Включение и использование фреймворков в 
проекты позволяет намного проще моделировать программное обеспечение, которое зависит от 
определенных библиотек классов или прикладных инструментариев. 

Структура фреймворка 

Фреймворк состоит из одного головного файла (.FRW) и одного или более файлов секций 
(.UNT). 

• Головной файл фреймворка (.FRW)
Файл фреймворка содержит информацию о секциях фреймворка и используемых профилях 
UML. 

• Файл секции (.UNT)
Файлы секций содержат актуальную модельную информацию для фреймворка. 

Профиль UML 

UML (Унифицированный язык моделирования) является настолько общим, что может 
использоваться для выражения любых мыслей или концепций. Эта общность может являться и 
недостатком, поскольку концепции определенных предметных областей не всегда могут быть 
выражены достаточно подробно. Чтобы преодолеть этот недостаток, StarUML™ поддерживает 
профили UML, которые расширяют UML. StarUML™ поддерживает простое расширение UML, 
непосредственно размещая концепции в профилях UML.

Структура профиля UML

Профиль UML состоит из следующих компонентов. 

• Стереотип
Стереотипы даются определенным элементам UML, чтобы прояснить их семантику и 
предоставить атрибуты расширения, делая моделирование более точным. Стереотипу 
соответствует не только файл с иконкой, задающей графическое изображение, но также и 
метод схемы расширения нотации, определяемый файлом (.PNX). Для получения более 
подробной информации о расширении нотации, обратитесь к документу "Руководство 
разработчика". 

• Определение тэгов (дополнительных свойств)
Когда стандартных свойств элемента UML недостаточно для точного моделирования, 
определение дополнительных свойств (тэгов) позволяет предоставить дополнительную 
информацию. В StarUML™ тэги могут быть включены в определенные стереотипы или 
существовать независимо. 

• Тип данных
Тип данных, который содержится в профиле по умолчанию. 
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• Тип диаграммы
Тип диаграммы - элемент расширения предлагаемый StarUML ™ для того, чтобы 
пользователь мог определить новую диаграмму. 

• Прототип элемента
Прототип элемента - элемент расширения предлагаемый StarUML ™ для того, чтобы 
пользователь мог определить образец для создания нового элемента 
переконфигурированием атрибутов уже существующего элемента. Эти определенные 
прототипы элементов могут создавать элементы через привязку к палитре или через 
внешний API. 

• Модельный прототип
Модельный прототип - элемент расширения предлагаемый StarUML ™ , подобный 
прототипу элемента, но применительно к модели. Определенный модельный прототип 
отображается дополнительным модельным меню. 

• Палитра
Палитра - элемент расширения предлагаемый StarUML ™ для того, чтобы пользователь мог 
расширять стандартную палитру элементов. Для детального ознакомления с написанием 
профилей, см. Руководство разработчика StarUML™. 

Приложение профиля UML 

Профили UML могут использоваться для описанных ниже целей. OMG (Ассоциация объектно-
ориентированного управления) также определяет стандартные профили UML для указанных 
целей. 

• Профили для определенных языков программирования (C/C++, Java, C#, Python, и т.д.) 
• Профили для определенных методологий разработки (RUP, Catalysis, компоненты UML, и 

т.д.) 
• Профили для определенных областей (EAI, CRM, SCM, ERP, и т.д.) 

Добавление модуля

Если Вы устанавливаете модули, разработанные пользователями или поставляемые третьими 
лицами, Вы можете использовать функции расширения StarUML ™. Чтобы установить новые 
дополнительные модули в систему, не требуется сложной аутентификации. Если Вы хотите 
установить модуль, скопируйте файлы, из которых он состоит, во вновь созданный подкаталог 
каталога \modules\. 

Добавление модуля в StarUML™

StarUML ™ содержит следующие базовые модули. 

• StarUML ™ предоставляет стандартный профиль UML для нескольких подходов и 
стандартный модуль для взаимных преобразований диаграмм коллабораций и следования. 

•  Предоставляет модуль Generator для генерации документов и кода. 
• Предоставляет модуль Java, поддерживающий профиль Java, Инструментарий J2SE/J2EE, 

генерацию объектного кода и реинжениринг. 
• Предоставляет модуль C++, поддерживающий профиль C++, Framework MFC, генерацию 

объектного кода и реинжиниринг. 
• Предоставляет модуль C#, поддерживающий профиль C#., NET BCL Framework, генерацию 

объектного кода и реинжениринг. 
• Предоставляет модуль XMI, поддерживающий импорт и экспорт в формате XMI для обмена 
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моделями. 
• Предоставляет модуль Rose, чтобы читать файлы Rational Rose. 
• Предоставляет модуль Pattern, поддерживающий шаблоны проектирования. 
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Глава 3. Управление проектом
Эта глава подробно описывает операции по управлению проектом: создание нового проекта, 

размещение части проекта в секции, создание и импорт фрагментов модели, импорт фреймворков, 
подключение и исключение профилей UML. 

• Управление проектом 
• Управление секциями 
• Работа с фрагментами модели 
• Импорт фреймворка 
• Работа с профилями UML 

Управление проектом 

Создание нового проекта

Чтобы начать разработку программного обеспечения, нужно инициировать новый проект. Вы 
можете начать абсолютно пустой проект или инициализировать новый проект согласно 
определённому подходу. 

Процедура создания нового проекта #1 - New Project:

1. выберите меню [File] -> [New Project]. 
2. Новый проект будет создан в соответствии с подходом по умолчанию, ранее выбранным 

пользователем. В зависимости от подхода могут быть подгружены определённые профили 
и/или инструментарии. 

Процедура создания нового проекта #2 - Select Select New Project

1. Выберите меню [File] -> [Select New Project…]. 
2. В диалоговом окне New Project будет отображен список доступных подходов. Выберите 

нужный из списка и нажмите кнопку [OK].
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3. Новый проект будет создан и инициализирован согласно указанному подходу. В 

зависимости от подхода могут быть подгружены определённые профили и/или фреймворки. 

Примечание 

• Список доступных подходов зависит от инсталлированной среды разработки пользователя. 
• Чтобы изменить заданный по умолчанию подход, откройте диалоговое окно "Select New 

Project", выберите нужный подход и затем установите опцию "Set As Default Approach" 
(Использовать как подход по умолчанию). 

Открытие проекта

Чтобы начать работать с существующим проектом, его проектный файл нужно открыть. Если 
проект включает более одной секции, все связанные секции будут также загружены вместе с 
проектом. 

Процедура открытия проекта:

1. Выберите меню [File] -> [Open…]. 
2. В диалоговом окне "Open Project", выберите файл проекта (.UML) и нажмите кнопку 

[Open]. 
3. Выбранный проектный файл будет открыт. 

Примечание 

Проекты могут также быть открыты через диалоговое окно "Select New Project". 

Сохранение проекта

Чтобы изменения, сделанные в проекте, не пропали, проектный файл должен быть должным 
образом сохранен. Ваша работа может быть сохранена в существующий проектный файл или в 
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новый проектный файл. Когда проектный файл сохраняется, то вместе с ним сохраняются данные 
из связанных с ним секций. 

Процедура сохранения проекта:

1. Выберите меню [File] -> [Save]. 
2. Если имя файла проекта не было определено, появится диалоговое окно "Save Project". 

Введите имя файла, и нажмите кнопку [Save].

  
3. Проектный файл будет сохранен. 

Процедура сохранения проекта в новом файле:

1. выберите меню [File] -> [Save As…]. 
2. В диалоговом окне "Save As", введите новое имя файла, и нажмите кнопку [Save]. 
3. Проект будет сохранен в указанном файле. 

Примечание 

• Если проект содержит одну или более секций, и есть изменённые секции, диалоговое окно 
будет запрашивать подтверждение на сохранение каждой измененной секции. Выберите 
[Yes], чтобы сохранить измененную секцию вместе с проектом. 

Закрытие проекта

Проект может быть закрыт, если больше не требуется его редактирование. 
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Процедура закрытия проекта:

1. Выберите меню [Файл]->[Close]. 
2. Если проект не был сохранен после внесения изменений, пользователю будет предложено 

сохранить изменения. Пользователь может выбрать "да", "нет" или "отмена".

3. После закрытия проект становится недоступным для редактирования. 

Управление элементами с помощью моделей, подсистем и пакетов

Программная модель состоит из многих элементов и диаграмм. Правильная группировка этих 
элементов и диаграмм очень важна для эффективного управления проектом. StarUML ™ 
поддерживает три типа группирующих элементов (модели, подсистемы и пакеты), которые 
пользователь может использовать соответственно их назначению. 

Способы группировки элементов, реализованные в StarUML 

 Модель
Модель выражает физическую систему в определенном аспекте. Например, это может быть аспект 
анализа, аспект проекта, пользовательский аспект, и т.д. 

 Подсистема
Подсистема группирует элементы, которые составляют полную физическую систему или её части. 

 Пакет
Пакет логически группирует и содержит модельные элементы. Это чрезвычайно обобщенный 
элемент, который может использоваться только для того, чтобы как-то организовать модельные 
элементы. 

Управление секциями

Управление секцией

Хотя проект может быть организован как один файл, тем не менее может быть удобным 
разделить его на несколько секций и управлять ими отдельно, особенно если над проектом 
одновременно работают несколько разработчиков. Этот раздел содержит описание процедур 
создания и управления секциями. 

• Создание секции 
• Присоединение секции 
• Сохранение секции 
• Удаление секции 
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Создание секции

Иногда может понадобиться сохранять части проекта как отдельные секции. Например, когда 
несколько разработчиков ведут проект вместе, проект может быть разделен на несколько секций и 
управляться инструментальными средствами подобными Microsoft Visual SourceSafe или CVS. В 
качестве секций могут быть сохранены только пакеты, модели и подсистемы. 

Процедура создания новой секции:

1. Выберите элемент (пакет, модель или подсистему), из которого нужно сделать секцию. 
2. Щелкните правой кнопкой мыши и выберите [Unit] -> [Separate Unit]. 
3. В диалоговом окне "Save", введите имя файла секции, и нажмите кнопку [Save].

  
4. Выбранный элемент будет сохранен как секция. 

Присоединение секции

Если больше нет необходимости хранить элементы модели в виде секции, файл секции может 
быть объединен с проектом. 

Процедура присоединения секции:

1. Выберите в навигаторе модели элемент (проект, модель, пакет или подсистему), которая 
содержит импортируемую секцию. 

2. Щелкните правой кнопкой мыши и выберите [Unit] -> [Uncontrol Unit…]. 
3. Секция будет объединена с проектом или родительской секцией. 
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Примечание 

• Присоединение секции автоматически не удаляет файл секции (.UNT). Пожалуйста удалите 
его вручную, если он больше Вам не требуется. 

Сохранение секции

Если в данные секции внесены изменения, секция должна быть сохранена. Сохранение может 
быть выполнено в существующий файл или в другой (новый) файл секции. 

Процедура сохранения секции:

1. Выберите сохраняемую секцию в навигаторе модели. 
2. Щелкните правой кнопкой мыши и выберите [Unit] -> [Save Unit]. 
3. Файл секции будет сохранен. 

Процедура сохранения секции другом файле:

1. Выберите сохраняемую секцию в навигаторе модели. 
2. Щелкните правой кнопкой мыши и выберите [Unit] -> [Save Unit As…]. 
3. В диалоговом окне "Save Unit As", введите новое имя файла секции, и нажмите кнопку 

[Save]. 
4. Новый файл секции будет создан. 

Примечание 

• При сохранении секции в другом файле, первоначальный файл секции не удаляется. 
Пожалуйста удалите его вручную, если он больше не требуется. 

Удаление секции

Если секция больше не нужна в проекте, она может быть удалена. Удаление секции приводит к 
удалению всех элементов, содержавшихся в ней, а секция больше не загружается в проект 
автоматически. Пожалуйста обратите внимание, что Вы должны использовать “Merge Unit” вместо 
"Remove Unit”, если Вы намереваетесь присоединить секцию к проекту и перестать управлять ею 
отдельно. 

Процедура удаления секции: 

1. Чтобы удалить секцию, выберите в навигаторе модели элемент (пакет, модель или 
подсистему), которая содержит секцию. 

2. Щелкните правой кнопкой мыши и выберите [Unit] -> [Delete Unit]. 
3. Появится диалоговое окно с запросом подтверждения на удаление секции. Щелкните [Yes].
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4. Секция будет полностью удалена из проекта. 

Примечание 

• Выбор элемента, который содержит секцию, и выбор [Edit] -> [Delete From Model], имеет 
тот же самый эффект. 

• Вы должны сами решить, удалять ли полностью секцию из проекта или объединить секцию 
с проектом. 

• Удаление секции не удаляет файл секции (.UNT). Пожалуйста удалите его вручную, если он 
больше не требуется. 

Работа с фрагментами модели
Фрагменты модели могут использоваться для того, чтобы сохранять части проекта. 

• Создание фрагмента модели 
• Импорт фрагмента модели 

Создание фрагмента модели

Части проекта могут быть сохранены как отдельные файлы фрагментов модели для облегчения 
доступа к ним со стороны других пользователей или для обеспечения их многократного 
использования. В отличие от секций, фрагменты модели не ссылаются на другие фрагменты, и 
никакие файлы не ссылается на фрагменты модели. Они - независимые объекты. Фрагменты 
модели могут быть включены в проект в любое время. 

Процедура создания фрагмента модели:

1. Выберите в навигаторе модели пакет, подсистему или модель, чтобы сделать из неё 
фрагмент модели. 

2. Выберите [File] -> [Export] -> [Model Fragment…]. 
3. В диалоговом окне "Save Model Fragment" введите имя файла фрагмента модели, и нажмите 

кнопку [Save].
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Импорт фрагмента модели

Элементы, сохраненные в файле фрагмента модели (.MFG) могут быть импортированы в проект. 
Импорт фрагмента модели копирует и включает элементы, содержавшиеся во фрагменте модели в 
проект. Никакие ссылки не используются. 

Процедура импорта фрагмента модели:

1. Выберите [File] -> [Import] -> [Model Fragment…]. 
2. В диалоговом окне "Open Model Fragment" выберите файл (.MFG) фрагмента модели и 

нажмите кнопку [Open], чтобы прочесть его. 
3. Диалоговое окно "Select Element" позволит указать элемент, который будет содержать 

импортируемый фрагмент модели. Выберите элемент (пакет, модель, подсистему или 
проект), в который нужно поместить фрагмент модели и нажмите кнопку [OK]. 

4. Фрагмент модели будет добавлен в выбранный элемент. 

Импорт фреймворка 
Перед тем как использовать фреймворк в проекте, его нужно загрузить. Как только фреймворк 

будет загружен, все элементы, содержавшиеся в нём, могут быть использованы. Обратите 
внимание, что секции во фреймворках обычно являются файлами "только для чтения", а элементы 
фреймворка не могут непосредственно изменяться. 

Процедура импорта фреймворка:

1. Выберите [File] -> [Import] -> [Framework…]. 
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2. В диалоговом окне "Import Framework", выберите нужный файл фреймворка, и нажмите 
кнопку [OK].

  
3. Диалоговое окно "Select Element" позволит определить элемент, который будет содержать 

импортированный фреймворк. Выберите нужный элемент (пакет, модель, подсистему или 
проект) и нажмите кнопку [OK].

  
4. Фреймворк будет добавлен к выбранному элементу. 

Примечание 

• Импорт фреймворка не помещает элементы фреймворк в проект. Секции фреймворка, на 
которые есть ссылки в проекте, должны всегда присутствовать при открытии проекта. 
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• Чтобы удалить импортированный фреймворк, Вы должны удалить все его секции вручную. 

Работа с профилями UML 

Подключение профиля UML 

Предопределенные профили UML могут быть подключены для использования в текущем 
проекте. Как только профиль UML будет включен в проект, стереотипы, определения тэгов и типов 
данных, заданные в профиле могут быть использованы в проекте. 

Процедура включения профиля UML:

1. Выберите [Model] -> [Profiles…]. 
2. В окне "Profile Manager" выберите профиль из списка доступных профилей слева, нажмите 

кнопку [Include] и затем нажмите кнопку [Close].

  
3. Выбранный профиль будет включен в текущий проект. 

Примечание 

• Список профилей в менеджере профилей зависит от инсталлированной среды разработки 
пользователя. 

Исключение профиля UML 

Профиль UML, включенный в текущий проект, может быть исключен из него. Как только 
профиль UML исключается из проекта, стереотипы, определения тэгов и типов данных, описанные 
в профиле перестают использоваться в проекте. 
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Процедура исключения профиля UML:

1. Выберите [Model] -> [Profiles…]. 
2. В окне "Profile Manager" выберите профиль в списке включенных профилей справа, 

нажмите кнопку [Exclude] и затем нажмите кнопку [Close]. 
3. Выбранный профиль будет исключен из текущего проекта. 

Примечание 

• Исключение профиля, стереотипы и определения тэгов которого используются в проекте, 
может привести к потере информации в зависимых элементах. Пожалуйста, будьте 
осторожны, исключая профили. 

• Список профилей в менеджере профилей может различаться в зависимости от 
инсталлированной среды разработки пользователя. 
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Глава 4. Моделирование с помощью StarUML 
Эта глава подробно описывает, как создавать и редактировать элементы диаграммы, включая 

способы организации структуры модели с помощью навигатора модели.

• Редактирование элементов и диаграмм 
• Организация структуры модели 

Редактирование элементов и диаграмм

Создание новой диаграммы 

StarUML ™ поддерживает 11 типов диаграмм UML. Пользователь может свободно создавать и 
манипулировать диаграммами различных типов, как ему необходимо. 

Процедура создания новой диаграммы:

1. Выберите в навигаторе модели или на диаграмме элемент, который будет содержать новую 
диаграмму. 

2. Щелкните правой кнопкой мыши и выберите [Add Diagram]. Новая диаграмма будет 
создана после выбора типа диаграммы. 

Доступные типы диаграмм

•  Диаграмма классов (Сlass diagram)
Диаграмма классов - визуальное отображение различных статических отношений между 
класс-подобными элементами. Диаграмма классов может содержать не только классы, но 
также и интерфейсы, перечислимые типы, пакеты, различные отношения, инстанции и их 
связи. 

•  Диаграмма прецедентов (Use case diagram)
Диаграмма прецедентов - отображение отношений между вариантами использования 
(прецедентами) определенной системы или объекта и внешними акторами. Вариант 
использования отображает функции системы и то, как эти функции взаимодействуют с 
внешними акторами. 

•  Диаграмма сообщений (Sequence Diagram)
Диаграмма сообщений отображает взаимодействие инстанций. Она является прямым 
отображением множества взаимных воздействий (InteractionInstanceSet) между элементами 
множества инстанций (CollaborationInstanceSet). В то время как Диаграмма сообщений роли 
ориентирована на классификаторы-роли, обычная Диаграмма сообщений - на инстанции. 

•  Диаграмма сообщений роли (Sequence Role Diagram)
Диаграмма сообщений роли отображает взаимодействия в концепции ролей. Она является 
прямым отображением Interaction (множества взаимных сообщений между 
классификаторами-ролями) в пределах Collaboration. В то время как Диаграмма сообщений 
- отображение инстанций, Диаграмма сообщений роли - отображение классификаторов-
ролей. 

•  Диаграмма коллаборации (Collaboration Diagram)
Диаграмма коллаборации отображает взаимодействие между инстанциями. Она является 
прямым отображением модели взаимодействия инстанций, входящих в 
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CollaborationInstanceSet. В то время как диаграмма коллаборации ролей - отображение 
классификаторов-ролей, обычная диаграмма коллаборации - отображение инстанций. 

•  Диаграмма коллаборации ролей
Диаграмма коллаборации ролей отображает взаимодействия между ролями. Она является 
прямым отображением модели взаимодействия классификаторов-ролей внутри 
коллаборации. В то время как обычная диаграмма коллаборации ориентирована на 
отображение инстанций, диаграмма коллаборации ролей - отображение классификаторов-
ролей. 

•  Диаграмма состояний (Statechart Diagram)
Диаграмма состояний выражает статическое поведение определенного объекта через 
состояния и переходы состояний. Хотя диаграмма состояний обычно используется, чтобы 
выразить поведение инстанций классов, она может также использоваться, чтобы выражать 
поведение и других элементов. 

•  Диаграмма действий (Activity Diagram)
Диаграмма действий - специальная форма диаграммы состояний, которая является 
подходящей для того, чтобы отображать поток выполнения действий. Диаграмма действий в 
общем случае используется для отображения любых потоков обработки, но чаще всего 
применительно к объектам подобным классам, пакетам и операциям. 

•  Диаграмма компонентов (Component Diagram)
Диаграмма компонентов отображает зависимость между программными компонентами. 
Элементы, которые составляют программные компоненты и элементы, которые реализуют 
эти компоненты, могут быть отображены на диаграмме компонентов. 

•  Диаграмма развертывания (Deployment Diagram)
Диаграмма развертывания отображает аппаратные элементы компьютера, другие 
устройства и программные компоненты, а также процессы и объекты, которые им 
назначены. 

•  Композиционная структурная диаграмма (Composite Structure Diagram)
Композиционная структурная диаграмма - диаграмма, выражающая внутреннюю структуру 
классификатора. Она показывает его точки зрения взаимодействия с другими частями 
системы. 

Примечание 

• Типы доступных диаграмм изменяются при переходе от одного типа элемента к другому. 

Создание элемента на диаграмме

Чтобы создать на диаграмме новый элемент, диаграмму сначала нужно открыть. Палитра 
элементов содержит различные типы элементов, доступных для создания в зависимости от типа 
диаграммы. Список доступных элементов изменяется при переходе от диаграммы одного типа к 
диаграмме другого типа. 

Процедура создания элемента из палитры элементов:

1. Выберите тип создаваемого элемента на палитре элементов. 
2. Щёлкните желаемое место для нового элемента на диаграмме, чтобы создать там элемент. 

(Перетаскивайте указатель мыши, чтобы определить область и размер нового элемента. При 
создании элемента, который соединяет два других элемента, убедитесь, что соединение 
сделано правильно.) 
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Процедура одновременного создания нескольких однотипных элементов:

1. Выберите тип создаваемого элемента на палитре элементов. 
2. Нажмите [Lock] на палитре или тот же тип элемента еще раз. 
3. Создайте несколько элементов подряд. 
4. Снова нажмите элемент в палитре, когда создание группы элементов будет закончено. 

Примечание 

• Создание элемента на диаграмме с помощью палитры элементов фактически означает 
создание как собственно модельного элемента, так и его визуального образа. 

Создание визуального образа элемента (View element) на диаграмме

Помимо создания нового элемента из палитры элементов, на диаграмме также могут быть 
созданы визуальные образы уже существующих модельных элементов. 

Процедура создания нового визуального образа (перетаскиванием):

1. Выберите в навигаторе модели элемент, который будет представлен новым визуальным 
образом. 

2. Перетащите этот модельный элемент на диаграмму, чтобы создать его визуальный образ (в 
этом случае будут автоматически отображены и все связи этого элемента). 

Примечание 

• Метод перетаскивания может не работать при создании образов для некоторых типов 
модельных элементов и типов диаграмм. 

• Модельные элементы также могут быть созданы и без создания визуального образа. Для 
детального изучения создания модельных элементов см. Создание модельного элемента. 

Редактирование элемента на диаграмме

Элементы могут редактироваться непосредственно на диаграмме. 

Процедура редактирования элемента:

1. Дважды щелкните образ на диаграмме. 
2. В "горячем диалоге" редактируйте имя элемента, область видимости и т.д., или нажмите 

кнопку, чтобы создать подчинённые элементы для выбранного элемента. 
3. Нажмите [Enter] или щёлкните другое место на диаграмме, чтобы принять изменения. 

Примечание 

• Для детального описания работы с горячим диалогом, см. Горячие диалоги. 

Изменение размеров и перемещение 

Вы можете оптимизировать размер визуального образа и его позицию внутри диаграммы, а 
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также Вы можете плавно менять его позицию и устанавливать размеры комбинацией клавиш 
<Специальная>+<Клавиша курсора>. 

Процедура изменения размера образа:

1. Щёлкните образ на диаграмме. 
2. Изменяйте размер образа перетаскиванием в нужном направлении одного из маркеров, 

которые показываются после выделения образа. 

Процедура изменения размеров образа, используя клавиатуру:

1. Выделите образ, щёлкнув его на диаграмме. 
2. Для изменения размеров образа пользователь может применить комбинацию Shift +Cusor 

key. Эта комбинация обеспечивает изменение шагами установленного размера, но Вы 
можете изменять размер образа плавно комбинацией Shift +Alt+Cursor. 

Процедура перемещения образа: 

1. Выделите передвигаемый образ щёлкнув его на диаграмме. Если нужно выделить несколько 
образов, выделяйте их комбинацией Shift+Click или очертите мышью область на диаграмме. 

2. Переместите образы в нужное место перетаскиванием, используя мышь. 

Процедура перемещения образа, используя клавиатуру:

1. Выделите передвигаемый образ щёлкнув его на диаграмме. Если нужно выделить несколько 
образов, выделяйте их комбинацией Shift+Click или очертите мышью область на диаграмме. 

2. Переместите образы куда нужно, используя Ctrl+Cursor Key. Эта комбинация обеспечивает 
передвижение шагами установленного размера, но Вы можете передвигать образ плавно 
комбинацией Ctrl+Alt+Cursor Key. 

Создание элемента с использованием "горячего синтаксиса" 

Элементы также могут быть созданы без использования мыши, использованием горячего 
синтаксиса. 

Процедура создания элемента с помощью горячего синтаксиса:

1. Выберите образ на диаграмме. 
2. Вызовите горячий диалог, нажав [Enter]. 
3. Введите нужный синтаксис в горячем диалоге. 

Горячий синтаксис генерации

Горячий синтаксис позволяет генерировать элементы модели и отношения через написание 
несложного текста. Основное правило горячего синтаксиса состоит в следующем. Напишите имя 
целевого модельного элемента и установленный нотационный знак, чтобы создать отношение 
соответствующее этому знаку между текущим и целевым элементом. Если целевое имя не указано, 
будет сгенерирован новый модельный элемент и указанное отношение. Нотация знаков отношений 
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горячего синтаксиса приведена ниже: 

  
Тип диаграммы Нотация Текущий элемент Описание

Диаграмма 
классов, 

Диаграмма 
компонентов, 

Диаграмма 
развёртывания, 

Композитная 
структурная 
диаграмма

<= Классификатор
Целевой элемент, связанный с текущим 
элементом, создаёт отношение 
специализации

=> Классификатор
Целевой элемент, связанный с текущим 
элементом, создаёт отношение 
генерализации

-- Классификатор Целевой элемент, связанный с текущим 
элементом, создаёт отношение ассоциации

<- Классификатор Создаётся направленная ассоциация от 
целевого элемента к текущему

-> Классификатор
Целевой элемент, связанный с текущим 
элементом, создаёт направленную 
ассоциацию

<>- Классификатор Целевой элемент, связанный с текущим 
элементом, создаёт отношение агрегации

-<> Классификатор Создаётся отношение агрегации от 
целевого элемента к текущему элементу

<*>- Классификатор Целевой элемент, связанный с текущим 
элементом, создаёт отношение композиции

-<*> Классификатор Создаётся отношение композиции от 
целевого элемента к текущему элементу

<-- Классификатор Создаётся зависимость от целевого 
элемента к текущему

--> Классификатор
Целевой элемент, связанный с текущим 
элементом, создаёт отношение  
зависимости

)- Классификатор Создаётся отношение требования от 
целевого элемента к текущему

-( Классификатор Целевой элемент, связанный с текущим 
элементом, создаёт отношение требования

@- Классификатор Создаётся отношение реализации от 
целевого элемента к текущему

-@ Классификатор Целевой элемент, связанный с текущим 
элементом, создаёт отношение реализации.

Диаграмма 
прецедентов

()- Прецедент
Целевой элемент  (Актор), связанный с 
текущим элементом, создаёт отношение 
коммуникации

-() Актор
Целевой элемент  (Прецедент), связанный с 
текущим элементом, создаёт отношение 
коммуникации

<i- Прецедент Создаётся отношение включения от 
целевого элемента к текущему элементу
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Тип диаграммы Нотация Текущий элемент Описание

-i> Прецедент Целевой элемент, связанный с текущим 
элементом, создаёт отношение включения

<e- Прецедент Создаётся отношение расширения от 
целевого элемента к текущему элементу

-e> Прецедент Целевой элемент, связанный с текущим 
элементом, создаёт отношение расширения

Диаграмма 
сообщений, 

Диаграмма 
сообщений (ролей)

<- Объект, 
классификатор-роль

Целевой элемент, связанный с текущим 
элементом, создаёт отношение сообщения

-> Объект, 
классификатор-роль

Создаётся отношение сообщения от 
целевого элемента к текущему элементу

<-> Объект, 
классификатор-роль

Создаётся сообщение, которое возвращает  
отношение от целевого элемента к 
текущему 

<- Стимул, сообщение Создаётся под-сообщение (приходящее из 
целевого элемента), в текущем сообщении

-> Стимул, сообщение Создаётся под-сообщение (уходящее из 
целевого элемента), в текущем сообщении

<-> Стимул, сообщение
Создаётся под-сообщение (с возвратом 
уходящим из целевого элемента), в 
текущем сообщении

<~ Стимул, сообщение
Создаётся сообщение (приходящее из 
целевого элемента), перед текущим 
сообщением

~> Стимул, сообщение
Создаётся сообщение (уходящее из 
целевого элемента), перед текущим 
сообщением

<_ Стимул, сообщение
Создаётся сообщение (приходящее из 
целевого элемента), после текущего 
сообщения

_> Стимул, сообщение
Создаётся сообщение (уходящее из 
целевого элемента), после текущего 
сообщения

Диаграмма 
коллаборации, 

Диаграмма 
коллаборации 
(ролей)

<- Объект, 
классификатор-роль

Целевой элемент, связанный с текущим 
элементом, создаёт отношение сообщения

-> Объект, 
классификатор-роль

Создаётся отношение сообщения от 
целевого элемента к текущему элементу

<-> Объект, 
классификатор-роль

Создаётся сообщение, которое возвращает  
отношение от целевого элемента к 
текущему 
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Тип диаграммы Нотация Текущий элемент Описание

Диаграмма 
состояний, 
диаграмма 
действий

<- Состояние, Акция Создаётся отношение перехода от целевого 
элемента к текущему элементу

-> Состояние, Акция Целевой элемент, связанный с текущим 
элементом, создаёт отношение перехода

-= Состояние, Акция
Создаётся отношение перехода от целевого 
элемента (начальное состояние) к 
текущему элементу

-@ Состояние, Акция
Целевой элемент (конечное состояние), 
связанный с текущим элементом, создаёт 
отношение перехода

<-<> Состояние, Акция Создаётся отношение перехода от целевого 
элемента (решение) к текущему элементу

-><> Состояние, Акция
Целевой элемент (решение), связанный с 
текущим элементом, создаёт отношение 
перехода

-(H)-(h) Состояние, Акция
Целевой элемент (хронология), связанный с 
текущим элементом, создаёт отношение 
перехода

-(H*) -(h*) Состояние, Акция
Целевой элемент (глубокая хронология), 
связанный с текущим элементом, создаёт 
отношение перехода

<-I Состояние, Акция
Создаётся отношение перехода от целевого 
элемента к текущему элементу (с 
соединением)

I-> Состояние, Акция
Целевой элемент (с ветвлением), связанный 
с текущим элементом, создаёт отношение 
перехода

Копирование и вставка

При копировании в буфер модельных элементов для последующей вставки необходимо ясно 
понимать различие между модельными элементами и их визуальными образами. Если скопирован 
модельный элемент, он должен быть вставлен в модельный элемент. В этом случае, все 
подэлементы, содержащиеся в выбранном элементе, копируются вместе с ним. Визуальные образы 
могут копироваться в пределах той же самой диаграммы или в другие диаграммы. Скопированный 
в буфер визуальный образ может быть вставлен только в диаграмму; он не может быть вставлен в 
модельный элемент. Возможность копирования и вставки может быть ограничена в зависимости от 
типа визуального образа и типа диаграммы. 

Процедура копирования и вставки модельных элементов:

1. Выберите модельный элемент для копирования в навигаторе модели. 
2. Щелкните правой кнопкой мыши и выберите меню [Copy]. Модельный элемент будет 

скопирован в буфер обмена. 
3. Выберите в навигаторе модели модельный элемент, в который будет вставлен 

скопированный элемент. 
4. Щелкните правой кнопкой мыши и выберите меню [Paste]. Скопированный модельный 

элемент будет вставлен из буфера обмена под выбранный элемент. 
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Скопированные модельные элементы могут быть вставлены только в те элементы, которые 
могут их содержать. 

Процедура копирования и вставки визуального образа в диаграмме:

1. Выберите на диаграмме визуальный образ для копирования. (Вы можете выбрать несколько 
элементов, очертив мышью прямоугольную область, или щёлкая мышью образы, удерживая 
нажатой клавишу [Shift]) 

2. Щелкните правой кнопкой мыши и выберите меню [Copy]. Визуальные образы будут 
скопированы в буфер обмена. 

3. Откройте диаграмму, в которую нужно вставить скопированные элементы. (Дважды 
щелкните визуальный образ в навигаторе модели или проводнике диаграмм, или выберите 
визуальный образ на вкладке диаграммы) . 

4. Щелкните правой кнопкой мыши и выберите меню [Paste]. Скопированные визуальные 
образы будут вставлены в активную диаграмму. 

Копирование/вставка для различных типов диаграмм

• Диаграмма классов
Элементы могут свободно копироваться или вставляться между диаграммами классов, 
прецедентов, компонентов, композиционной структуры и развертывания. 

• Диаграмма прецедентов
Элементы могут свободно копироваться или вставляться между диаграммами классов, 
прецедентов, компонентов, композиционной структуры и развертывания. 

• Диаграммы следования
Элементы не могут быть скопированы или вставлены 

• Диаграммы коллаборации
Элементы не могут быть скопированы или вставлены 

• Диаграмма состояний
Элементы могут быть скопированы или вставлены только между диаграммами в пределах 
той же самой модели состояний 

• Диаграмма действий
Элементы могут быть скопированы или вставлены только между диаграммами в пределах 
той же самой модели активности 

• Диаграмма компонентов
Элементы могут свободно копироваться или вставляться между диаграммами классов, 
прецедентов, компонентов, композиционной структуры и развертывания. 

• Диаграмма развертывания
Элементы могут свободно копироваться или вставляться между диаграммами классов, 
прецедентов, компонентов, композиционной структуры и развертывания. 

• Структурная диаграмма
Элементы могут свободно копироваться или вставляться между диаграммами классов, 
прецедентов, компонентов, композиционной структуры и развертывания. 

Конфигурирование свойств

Модельные элементы содержат различные свойства. Пользователь может изменять модельные 
элементы различными способами, редактируя эти значения свойств. Следующие типы свойств 
доступны. 

• Name
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Указывает имя модельного элемента. 
• Stereotype

Указывает стереотип для модельного элемента. 
• TypeExpression

Указывает выражение для определения типа. 
• String

Указывает строку. 
• Boolean

Указывает Истину или Ложь. 
• Enumeration

Один из множества различных литералов. 
• Reference

Указывает определенный элемент. 
• Collection

Указывает множество элементов (доступно для редактирования посредством редактора 
коллекции). 

Редактирование свойства имени

Введите имя элемента в строку "Name" редактора свойств. Имена не могут содержать символ 
":". Имена должны быть уникальны в пределах пространства имён. Например, имена классов в 
пределах пакета должны быть уникальны. Если имя конфликтует с именами других элементов, 
выводится предупреждающее сообщение. 

Редактирование свойства стереотипа

Введите название стереотипа в строку "Stereotype" редактора свойств. Название стереотипа 
может быть константой, определенной в профиле UML, или может быть простым не 
предопределённым именем. Редактировать стереотип можно следующими способами. 

• Ввод определенного стереотипа: введите имя стереотипа, которое определено в профиле, 
включенном в текущий проект. Это прямая ссылка на стереотип. 

• Ввод неопределенного стереотипа: введите имя стереотипа, которое не было определено в 
профилях, включенных в текущий проект. Это указание простого несвязанного строкового 
значения. 

• Выбор в диалоге стереотипов: откройте диалоговое окно "Stereotype" и выберите стереотип 
из списка предопределенных стереотипов. 

Редактирование свойства TypeExpression

Свойство TypeExpression имеют атрибуты, параметры и т.д. Введите выражение типа в строку 
"Type" редактора свойств. Для редактирования типа можно использовать следующие способы. 

• Ввод определенного имени типа: Введите имя классификатора (класса, интерфейса, 
сигнала, исключения, компонента, узла, подсистемы, и т.д.) содержащегося в текущем 
проекте. Будет создана ссылка на этот элемент. 

• Ввод определенного маршрута типа: Прямо введите имя маршрута к элементу 
классификатора, включенному в текущий проект (например “::Logical 
View::Package1::Class1”) 

• Ввод неопределенного имени типа: Введите имя, которое не связано ни с одним из 
классификаторов, включенных в текущий проект. Это только простое несвязанное 
строковое значение. 
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• Использование диалогового окна выбора элемента: Откройте диалоговое окно "Select 
Element" и непосредственно выберите тип данных, определенный в профиле. 

Документирование модельного элемента 

Для модельных элементов могут быть созданы детальные описания. 

Процедура документирования модельного элемента:

1. Выберите в навигаторе модели или на диаграмме элемент, который нужно описать. 
2. В основном окне инспектора выберите закладку [Documentation]. 
3. Введите описание в доступную для редактирования область. 

Присоединение файла или URL 

Ссылки на связанные файлы или web-страницы могут быть присоединены к модельным 
элементам. К присоединенным файлам или web-страницам можно легко обратиться через 
ассоциированные приложения или web-браузер. 

Процедура присоединения файла или URL:

1. Выберите элемент в навигаторе модели или на диаграмме. 
2. В основном окне инспектора выберите закладку [Attachments]. 
3. Щелкните правой кнопкой мыши и выберите меню [Add] или нажмите кнопку [Add] на 

инструментальной панели. 
4. В диалоговом окне "Attachment" введите полный путь и имя присоединяемого файла или 

web-страницы (или воспользуйтесь кнопкой обзора справа) и нажмите [OK].

 

Процедура удаления присоединенного объекта: 

1. Выберите элемент в навигаторе модели или на диаграмме. 
2. В основном окне инспектора выберите закладку [Attachments]. 
3. Выберите удаляемый элемент в списке. Щелкните правой кнопкой мыши и выберите меню 

[Delete] или нажмите кнопку  на инструментальной панели. 

Запись ограничений

Для модельных элементов могут быть заданы различные ограничения (констрэйнты). 
Ограничения - инструкции, относящиеся к элементам. Они могут быть написаны на легком для 
понимания естественном языке или на языке OCL (Объектный Язык Ограничений), определенном 
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в рамках UML. 

Процедура добавления ограничений:

1. Выберите элемент, к которому нужно добавить констрэйнт. 
2. Щелкните на нём правой кнопкой мыши и выберите [Constraint Editor…]. 
3. В редакторе ограничений нажмите кнопку [Add].

  
4. В диалоговом окне Constraint введите имя и содержание консрэйнта, а затем нажмите 

кнопку [OK].

 

Процедура удаления ограничения: 

1. Выберите элемент, у которого нужно удалить ограничение. 
2. Щелкните на нём правой кнопкой мыши и выберите [Constraint Editor…]. 
3. В редакторе ограничений выберите ограничение, которое нужно удалить, и затем нажмите 

кнопку [Delete]. 
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Процедура редактирования ограничения: 

1. Выберите элемент, у которого нужно редактировать ограничение. 
2. Щелкните на нём правой кнопкой мыши и выберите [Constraint Editor…]. 
3. В редакторе ограничений выберите ограничение, которое нужно изменить, и затем нажмите 

кнопку [Edit]. 
4. В диалоговом окне "Constraint" отредактируйте имя и содержание ограничения. Нажмите 

кнопку [OK]. 

Редактирование тэгов (дополнительных свойств) 

Помимо основных свойств модельного элемента могут быть отредактированы и значения тэгов, 
добавленных профилями UML. 

Процедура редактирования тэгов: 

1. Выберите в навигаторе модели или на диаграмме элемент для редактирования. 
2. Щелкните правой кнопкой мыши и выберите меню [Tagged Values…]. 
3. В редакторе тэгов выберите закладку, которая соответствует профилю, содержащему 

нужный тег.

  
4. Выберите в поле [Tag Definition Set] набор, который содержит нужный тег. Выберите тег в 

списке [Tagged Values] и измените его значение. 

Процедура возвращения отредактированному тэгу его значения по умолчанию: 

1. Выберите в навигаторе модели или на диаграмме элемент для редактирования. 
2. Щелкните правой кнопкой мыши и выберите меню [Tagged Values…]. 
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3. В редакторе тэгов выберите закладку, которая соответствует профилю, содержащему 
нужный тег. 

4. Выберите в поле [Tag Definition Set] набор, который содержит нужный тег Выберите тег в 
списке [Tagged Values] и и нажмите кнопку [Set to Default]. 

Удаление визуального образа элемента 

Удаление визуального образа означает именно удаление только визуального образа, 
обозначающего модельный элемент на диаграмме, но не удаляет сам модельный элемент. 

Процедура удаления визуального образа: 

1. Выберите визуальный образ на диаграмме. 
2. Нажмите клавишу [Del] или выберите меню [Edit] -> [Delete]. 

Примечание 

• Удаление визуального образа не удаляет его модельный элемент. 

Присваивание цвета линии 

Цвета окаймления визуальных образов или соединительных линий могут быть изменены. 

Процедура установки цвета линии: 

1. Выберите элемент на диаграмме. 
2. Щелкните правой кнопкой мыши и выберите меню [Format] -> [Line Color…]. 
3. В диалоговом окне "Color", выберите цвет и нажмите [OK].
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Назначение цвета заливки 

Цвета заливки визуальных образов может быть изменен. 

Процедура изменения цвета заливки: 

1. Выберите элемент на диаграмме. 
2. Щелкните правой кнопкой мыши и выберите меню [Format] -> [Fill Color…] . 
3. В диалоговом окне "Color", выберите цвет и нажмите [OK]. 

Выбор шрифта 

Текстовая форма, цвет, размер шрифта визуальных образов могут быть изменены. 

Процедура изменения шрифта: 

1. Выберите элемент на диаграмме. 
2. Щелкните правой кнопкой мыши и выберите меню [Format] -> [Font…]. 
3. В диалоговом окне "Font" выберите форму шрифта, размер, цвет, и т.д. и нажмите кнопку 

[OK]. 

 

Примечание 

• Атрибуты шрифта некоторых визуальных образов недоступны для редактирования. Это 
сделано потому, что установленные атрибута шрифта зафиксированы соглашениями UML и 
не могут быть изменены. 

Показ стереотипов 

Визуальные образы могут отображаться в виде различных фигур, в зависимости от стереотипа 
элемента. Доступны следующие режимы отображения. 
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• Скрытый [Shift +Ctrl+N]: Скрывает стереотип. 
• Показ в виде текста [Shift +Ctrl+T]: имя стереотипа показывается внутри скобок “<<” и 

“>>”. 
• Показ иконки [Shift +Ctrl+I]: визуальный образ отображается как значок стереотипа. Чтобы 

использовать эту опцию, стереотип должен быть зарегистрирован со значком. Иначе 
стереотип будет показываться в виде текста. 

• Декоративный вид [Shift +Ctrl+I]: визуальные образы отображаются как в текстовом виде, 
но с небольшой иконкой сбоку. Для этого иконка должна быть зарегистрирована в 
стереотипе, иначе стереотип будет отображён в виде текста. 

Некоторые элементы, подобные Акторам, Интерфейсам, Компонентам, Узлам и Артефактам 
отображаются изображениями по умолчанию, которые не зарегистрированы в стереотипе. 

Установка стиля линии

Линейные визуальные образы типа Ассоциации, Зависимости и Обобщения могут отображаться 
двумя типами линий. 

• Прямолинейный: Линия всегда изгибается в углах на 90 градусов. 
• Наклонный: Линия изгибается под любым углом. 

Процедура изменения стиля линии:

1. Выберите линию на диаграмме. 
2. Щелкните правой кнопкой мыши и выберите меню [Format] -> [Line Style]. 
3. Укажите стиль: "rectilinear" или "oblique" (прямолинейный или наклонный). 

Установка автоматической регулировки размера

Хотя пользователь может в любое время изменить размеры визуального образа, образ может 
быть конфигурирован так, чтобы изменять свой размер автоматически. 
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Процедура установки автоматической регулировки размера:

1. Выберите элемент на диаграмме. 
2. Щелкните правой кнопкой мыши и щёлкните меню [Format] -> [Auto Resize]. 
3. Чтобы отменить автоматическое изменение размеров образа, щёлкните этот пункт меню 

еще раз. 

Подавление отображения атрибутов

Элементы, которые содержат атрибуты, типа класса, исключения или прецедента, обычно 
отображаются вместе с атрибутами. Пользователь может указать, следует ли показывать атрибуты, 
или их отображение нужно подавить. 

Процедура скрытия отображений атрибутов:

1. Выберите элемент на диаграмме. 
2. Щелкните правой кнопкой мыши и выберите меню [Format] -> [Suppress Attributes]. 
3. Выполните указанные действия еще раз, чтобы включить показ атрибутов. 

Подавление отображения операции

Элементы, которые содержат операции, типа класса, исключения, прецедента или подсистемы, 
по умолчанию отображаются на диаграммах вместе сними. Пользователь может указать, следует 
ли показывать операции, или их отображение нужно подавить. 

Процедура скрытия отображения операций:

1. Выберите элемент на диаграмме. 
2. Щелкните правой кнопкой мыши и выберите меню [Format] -> [Suppress Operations]. 
3. Выполните указанные действия еще раз, чтобы включить показ операций. 

Подавление отображения значений нумераторов 

Перечислимые типы (нумераторы) на диаграмме отображаются вместе с константами. 
Пользователь может подавить отображение констант. 

Процедура подавления изображения литералов:

1. Выберите на диаграмме образ нумераторного типа. 
2. Щелкните правой кнопкой мыши и выберите меню [Format] -> [Suppress Literals]. 
3. Повторите указанные шаги еще раз, чтобы включить отображение литеральных констант. 

Управление разрывом слов

Когда имена элементов состоят из нескольких слов, информативность диаграмм уменьшается, 
так как ширина визуальных образов увеличивается. Если Вы используете режим Word Wrap, Вы 
можете оптимизировать размер образов с длинными именами, поскольку имена отображаются в 
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несколько линий. 

Процедура включения разрыва слов:

1. Выберите элемент на диаграмме. 
2. Щелкните правой кнопкой мыши и выберите меню [Format] -> [Word Wrap Name]. 
3. Повторите указанные выше шаги еще раз для отключения разрыва слов. 

Примечание 

• Для некоторых элементов, типа свимлайнов, режим разрыва не применим. 

Показ составных имён

В общем случае, визуальные образы показывают только собственные имена. Однако, проект, 
содержащий много пакетов, может иметь элементы с одинаковыми именами в различных пакетах, 
и могут быть случаи, когда эти элементы должны быть отображены на одной диаграмме. В таком 
случае, элементы должны отображаться с составными именами, чтобы их можно было отличить 
друг от друга. Составные имена имеют формат вида “ParentName::OwnName”. 

 

Процедура включения показа составных имён

1. Выберите элемент на диаграмме. 
2. Щелкните правой кнопкой мыши и выберите меню [Format] -> [Show Parent Name]. 
3. Выполните эти действия еще раз, чтобы скрыть составные имена. 

Показ свойств

При наличии у элемента тэгов, их изменённые значения отображаются в секции свойств 
визуальных образов. Пользователь может определить, будет ли эта секция показана или скрыта. 

Процедура включения показа свойств:

1. Выберите элемент на диаграмме. 
2. Щелкните правой кнопкой мыши и выберите меню [Format] -> [Show Properties]. 
3. Выполните эти действия еще раз, чтобы скрыть показ свойств. 

Примечание 

• В случае когда значение свойства Changeability элемента AssociationEnd является 
изменяемым или значением свойства Ordering является UNORDERED, относительное 
значение свойства не будет показано в секции свойств визуального образа элемента. 
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Показ сигнатур операций

При отображении элементов, которые содержат операции (классы, подсистемы), имена и типы 
параметров операций могут показываться или быть скрытыми. 

Процедура включения показа сигнатур операций: 

1. Выберите элемент на диаграмме. 
2. Щелкните правой кнопкой мыши и выберите меню [Format] -> [Show Operation Signature]. 
3. Выполните эти действия еще раз, чтобы скрыть сигнатуры операций. 

Показ атрибутов видимости 

Образы элементов, подобных классам, прецедентам и подсистемам, которые содержат атрибуты, 
операции, константы и т.д. имеют области, в которых отображаются их атрибуты, операции и т.д. 
Образ класса содержит области под атрибуты и операции, образ подсистемы имеет область 
операций, а образ перечислимого типа имеет область операций и констант. Значение видимости 
(public, protected ...) элементов, отображаемых в этих областях, может показываться или 
скрываться. 

Процедура включения показа видимости:

1. Выберите элемент на диаграмме. 
2. Щелкните правой кнопкой мыши и выберите меню [Format] -> [Show Compartment 

Visibility]. 
3. Выполните эти действия еще раз, чтобы скрыть отображение видимости. 

Показ стереотипов 

Образы элементов, подобных классам, прецедентам и подсистемам, которые содержат атрибуты, 
операции, константы и т.д. имеют области, в которых отображаются их атрибуты, операции и т.д. 
Образ класса содержит области под атрибуты и операции, образ подсистемы имеет область 
операций, а образ перечислимого типа имеет области операций и констант. Стереотипы элементов, 
отображаемых в этих областях, могут показываться или скрываться на диаграммах. 

Процедура включения показа стереотипов:

1. Выберите элемент на диаграмме. 
2. Щелкните правой кнопкой мыши и выберите меню [Format] -> [Show Compartment 

Stereotypes]. 
3. Выполните эти действия еще раз, чтобы скрыть отображение стереотипов. 

Открытие диаграммы

Чтобы начать редактировать диаграмму, её нужно открыть. Как только диаграмма открывается, в 
главном окне появляется её закладка. Выберите нужную закладку, чтобы сделать 
соответствующую диаграмму активной и доступной для редактирования. 
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Процедура открытия диаграммы:

1. Найдите открываемую диаграмму в навигаторе модели или навигаторе диаграмм. 
2. Дважды щелкните диаграмму, чтобы открыть её. Диаграмма автоматически становится 

активной. 

Активизация диаграммы

Чтобы начать редактировать определенную диаграмму, Вы должны её активизировать, особенно, 
если открыто несколько диаграмм. Чтобы активизировать открытую диаграмму, нажмите её 
закладку. В случае наличия большого количества открытых диаграмм, Вы можете активизировать 
нужную диаграмму, выбрав её с помощью всплывающего меню. 

Процедура активизации диаграммы через меню:

1. Щелкните правой кнопкой мыши на закладке любой диаграммы и выберите меню [Pages]. 
2. Выберите имя нужной диаграммы, чтобы её активизировать. 

Закрытие диаграммы

Закройте диаграмму, если её больше не нужно редактировать. Закрытие диаграммы не удаляет 
её. Закрытая диаграмма может быть снова открыта в любое время. 

Процедура закрытия диаграммы:

1.  Выберите закладку закрываемой диаграммы, сделав её активной. 
2. Щелкните правой кнопкой мыши на закладке, и выберите меню [Close Diagram]. 

Процедура закрытия всех открытых диаграмм:

1. Выберите меню [View] -> [Close All Diagrams]. 

Удаление диаграммы

Диаграмма может быть удалена, если она больше не нужна. Пожалуйста будьте внимательны, 
потому что удаление диаграммы приводит к удалению всей информации, связанной с этой 
диаграммой. 

Процедура удаления диаграммы:

1. Выберите удаляемую диаграмму в навигаторе модели или навигаторе диаграмм. 
2. Щелкните правой кнопкой мыши и выберите меню [Delete from Model]. 

Поиск элемента

Программные модели обычно содержат большое количество элементов. Иногда бывает очень 
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трудно быстро определить местонахождение требуемых элементов среди множества других 
элементов программной модели. В этом случае может помочь функция "Find Element". 

Процедура поиска элемента:

1. Выберите меню [Edit] -> [Find…]. 
2. В диалоговом окне "Find", введите в поле [Find what] полное или частичное имя искомого 

элемента. Чтобы ограничить множество просматриваемых элементов, выберите тип 
элемента в меню [Options-Element type]. Чтобы учитывать регистр символов, отметьте флаг 
[Options-Match case]. Нажмите кнопку [OK].

  
3. Результаты поиска будут выведены в секцию [Messages] информационной области. Дважды 

щелкните сообщение, чтобы найти связанный элемент. 

Выравнивание элемента

Элементы, находящиеся на диаграмме могут быть выровнены в некотором направлении или с 
некоторым интервалом. 

Функции выравнивания элементов 

•  Align Left
Выровнить выбранные элементы налево. 

•  Align Right
Выровнить выбранные элементы направо. 

•  Align Middle
Выровнить выбранные элементы горизонтально по центру. 

•  Align Top
Выровнить выбранные элементы по верху. 

•  Align Bottom
Выровнить выбранные элементы по низу. 

•  Align Center
Выровнить выбранные элементы вертикально по центру. 

•  Space Equally, Horizontally
Равномерно распределить выбранные элементы горизонтально. 

•  Space Equally, Vertically
Равномерно распределить выбранные элементы вертикально. 

•  Bring to Front
Расположить выбранные элементы поверх остальных. 

•  Send to Back
Расположить выбранные элементы под остальными. 
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Процедура выравнивания элементов:

1. Выберите выравниваемые элементы на области диаграмме (должно быть выбрано два или 
более элементов для выравнивания, за исключением "Bring to front" и “Send to Back”). 

2. Щелкните правой кнопкой мыши и выберите меню [Format] -> [Align]. Выберите 
требуемую операцию выравнивания. 

Настройка диаграммы

В случае, когда элементы на диаграмме расположены беспорядочно, они могут быть 
автоматически передвинуты для получения более наглядного изображения. 

Процедура расположения элементов диаграммы:

1. Сделайте диаграмму активной. 
2. Щелкните правой кнопкой мыши и выберите меню [Format] -> [Layout Diagram]. 

Примечание 

• Функция формата диаграммы не доступна для диаграммы следования. 

Настройка масштаба диаграммы

Если диаграмма содержит много элементов или если тексты внутри элементов выводятся 
слишком мелко, масштаб диаграммы может быть увеличен или уменьшен для получения лучшего 
изображения. 

Процедура изменения масштаба диаграммы:

1. Выберите меню [View] -> [Zoom]. Выберите меню [Zoom-In], чтобы увеличить масштаб на 
одно деление (5 %), или меню [Zoom-Out], чтобы на столько же уменьшить масштаб. 

2. Чтобы отобразить диаграмму на экране целиком, выберите меню [Fit to Window]. Вы 
можете также выбирать масштаб изображения (50 %, 75 %, 100 %, 125 %, 150 %, 175 % и 
200 %). 

Сохранение диаграммы в файле 

Диаграммы могут быть сохранены как рисунки. StarUML ™ поддерживает следующие форматы 
изображений: JPEG (.jpg, .jpeg), точечный рисунок (.bmp), метафайл (.wmf), и расширенный 
метафайл (.emf). 

Процедура сохранения диаграммы в файле изображения:

1. Сделайте диаграмму активной. 
2. Выберите в главном меню [File] -> [Export Diagram…]. 
3. В диалоговом окне "Save", введите имя файла, выберите формат изображения, а затем 

нажмите кнопку [Save]. 
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Примечание 

• Файлы формата метафайл (.wmf) не отображаются многими программам просмотра. 
Поэтому рекомендуется использовать формат расширенного метафайла (.emf). 

Копирование диаграммы в формате точечного рисунка

Чтобы вставить диаграмму в другой документ, изображение диаграммы может быть 
скопировано в формате точечного рисунка. Диаграмма может быть вставлена в документ как 
редактируемое изображение копированием её как точечного рисунка, но это может вызвать 
искажение изображения в случае попытки изменить его масштаб. 

Процедура копирования диаграммы как точечного рисунка:

1. Сделайте диаграмму активной. 
2. Выберите [Edit] -> [Copy Diagram As Bitmap] в главном меню. 

Примечание 

• Информация диаграммы копируется как мета изображение при его размещении в буфер по 
команде Ctrl+C. Мета изображение не искажается при изменении его масштаба, но его 
формат может быть изменен при помещении его из буфера в текстовый или графический 
редактор. 

Навигация в диаграмме

Если диаграмма содержит много информации, она может быть очень большой. В этом случае 
показать на экране можно только ограниченную часть диаграммы. Agora Plastic™ предоставляет 
различные методы эффективного управления видимой областью диаграммы, разрешая 
пользователю быстро навигироваться в её произвольные места. Для этого могут использоваться 
следующие методы. 

• Навигация с помощью полосы прокрутки и колеса мыши
Передвигайте видимую область диаграммы, как Вы хотите, используя полосы прокрутки. 
Если Вы используете колесо мыши, Вы можете двигаться вверх и вниз. 

• Навигация с помощью Глаза Бира
Есть маленький значок  в нижнем правом углу области диаграммы. Нажмите этот значок, 
чтобы видеть полностью диаграмму в маленьком окне. Двигайте сектор в нужное место 
диаграммы, удерживая нажатой кнопку мыши, а затем освободите кнопку. Эта функция 
полезна для перемещения на большие расстояния.

  
• Навигация с помощью Ctrl + Мышь

Удерживайте клавишу Ctrl и перемещайте мышь, чтобы перемещать диаграмму. Эта 
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функция полезна для того, чтобы перемещаться на короткие расстояния. 

Установка основной диаграммы  

Проект может содержать много диаграмм. Среди них может быть несколько диаграмм, которые 
являются основными. Например, диаграмма, которая отображает полную структуру проекта, 
может быть определена как основная диаграмма по умолчанию. Только диаграмма классов, 
диаграмма прецедентов, диаграмма компонентов или диаграмма развертывания могут быть 
установлены в качестве основных диаграмм. Основная диаграмма автоматически открывается при 
открытии проекта. 

Для того, чтобы назначить основную диаграмму:

1. Выберите в навигаторе модели или навигаторе диаграмм нужную диаграмму. 
2. Выберите закладку [Properties] в области инспектора. 
3. В редакторе свойств установите флаг “DefaultDiagram”. 

Организация структуры модели

Создание модельного элемента

Модельные элементы могут быть созданы и без размещения на диаграмме. Такой элемент 
сначала не отображается ни на одной диаграмме, но позже его всегда можно поместить на любое 
количество диаграмм. 

Процедура создания модельного элемента:

1. Выберите в навигаторе модели элемент, который будет содержать новый модельный 
элемент. 

2. Щелкните правой кнопкой мыши и выберите меню [Add], затем выберите тип элемента в 
субменю. Или же, выберите меню [Model] -> [Add] в главном меню. 

3. Новый модельный элемент будет создан под выбранным элементом. 

Удаление модельного элемента

Если Вы удаляете модельный элемент, некоторые зависимые элементы удаляются вместе с ним. 
Пожалуйста будьте осторожны, потому что удаление модельного элемента приводит к удалению 
указанных ниже элементов. 

• Включенные модельные элементы: Все модельные элементы, включенные в удаляемый 
элемент также удаляются. 

• Связанные модельные элементы: все отношения типа обобщений, ассоциаций и 
зависимостей, связанные с удаляемым модельным элементом также удаляются. 

• Визуальные образы: все визуальные образы, которые представляют удаляемый элемент на 
других диаграммах, также будут удалены. 



StarUNL. Руководство пользователя. Глава 4. Моделирование с помощью StarUML 51 / 207

Процедура удаления модельного элемента:

1. Выберите в навигаторе модели удаляемый модельный элемент, или выберите его 
визуальный образ на диаграмме. 

2. Нажмите [Ctrl+Del] или выберите [Edit] -> [Delete from Model]. 
3. Выбранный модельный элемент будет удален. 

Перемещение модельного элемента

Модельные элементы могут перемещаться из под одного элемента в другой, например, класс 
перемещается в другой пакет, или атрибут перемещается в другой класс. Модельные элементы 
могут быть перемещены только в те элементы, которые могут их содержать. Они не могут быть 
перемещены в элементы несовместимого типа. 

Процедура перемещения модельного элемента:

1. Выберите элемент в навигаторе модели. 
2. Перетащите элемент и сбросьте его на элементе, который должен его содержать. 

Изменение порядка следования модельных элементов 

Порядок следования модельных элементов иногда целесообразно изменять, чтобы улучшить 
интуитивное восприятие конфигурации программной модели. Изменение порядка следования 
модельных элементов применимо только к элементам одного вида. Также элементы могут 
следовать в порядке хранения (Storage Order). 

Процедура изменения порядка следования модельного элемента:

1. Выберите элемент в модельном навигаторе. 
2. Передвиньте этот модельный элемент на нужную строку нажимая кнопки [Move UP] или 

[Move Down]. 

Процедура изменения порядка следования модельного элемента в редакторе коллекции: 

1. Выберите контейнер этого элемента в навигаторе. 
2. Запустите редактор коллекций выбрав [Model]->[Collection Editor...]. 
3. Выберите нужную закладку с коллекцией. 
4. Выберите элемент. 
5. Измените порядок следования элемента нажимая кнопки [Move Up] или [Move Down]. Вы 

можете передвигать элемент, используя комбинацию Ctrl-Cursor. 

Упорядочивание элементов

Порядок элементов в модельном навигаторе может быть установлен как "изначальный" или 
алфавитный. Переупорядочивание касается только модельного навигатора, реальный порядок 
элементов не изменяется. Чтобы пересортировать элементы, нажмите [Align as saving order] или 
[Align as Alphabetical order]. При изменении порядка сортировки узлы навигатора сворачиваются, а 
узел верхнего уровня раскрывается. 
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Глава 5. Работа с диаграммами

Использование диаграмм прецедентов
В диаграмме прецедентов доступны следующие элементы. 

• Актер 
• Прецедент 
• Ассоциация 
• Направленная ассоциация 
• Обобщение 
• Зависимость 
• Включение 
• Расширение 
• Граница системы 
• Пакет 

Актор 

Семантика

Актор определяет множество ролей, которые пользователи некоторой сущности могут играть 
при взаимодействии с этой сущностью. Актор может играть отдельную роль в отношении с любым 
прецедентом, с которым он связан. 

Процедура создания актора

Чтобы создать актора, нажмите кнопку [Toolbox] -> [UseCase] -> [Actor] и щёлкните позицию на 
диаграмме, куда Вы хотите поместить актора. Актор изображается в виде человечка или 
прямоугольника со значком человечка, если используется декоративный режим отображения. 
Чтобы отображать актора в декоративном режиме, выберите пункт меню [Format] -> [Stereotype 
Display] -> [Decoration] или выберите элемент [Decoration] с помощью комбинированной кнопки 

 на инструментальной панели. 

Процедура создания нескольких прецедентов для одного актора 

Чтобы одновременно создать несколько прецедентов, связанных с одним актором, используйте 
горячий синтаксис создания элементов. 
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1. В горячем диалоге актора, введите имя прецедента после строки "- ()". Чтобы создавать 
несколько прецедентов, укажите несколько имён, разделённых символом ",". 

  
2. Нажмите клавишу [Enter]. Несколько прецедентов, связанных с текущим актором, будут 

созданы и расположены вертикально. 

 

Прецедент

Семантика

Конструкция прецедента используется, чтобы определить поведение системы или другой 
семантической сущности, не показывая внутреннюю структуру этой сущности. Каждый прецедент 
определяет последовательность действий, включая варианты, которые сущность может выполнить, 
взаимодействуя с акторами. 

Процедура создания прецедента 

Нажмите кнопку [Toolbox] -> [UseCase] и щёлкните позицию на диаграмме, где нужно 
разместить прецедент. 

Прецедент может отображаться в текстовом, декоративном или графическом формате. Чтобы 
изменить формат отображения прецедента, выберите пункт меню [Format] -> [Stereotype Display] 
или используйте комбинированную кнопку . 
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Чтобы добавить расширение 

Точка расширения указывает одно или несколько положений в прецеденте, где прецедент может 
быть расширен. 

 

Чтобы редактировать коллекцию точек расширения прецедента, нажмите пункт [Collection 
Editor...] его контекстного меню или щелкните кнопку [ExtensionPoints] свойств коллекции. 

Чтобы ввести спецификацию прецедента 

Чтобы ввести значения свойств "basic flow", "alternative flow" прецедента, выберите [Tagged 
Values...] в его контекстном меню или нажмите кнопку [Ctrl+F7]. В редакторе тэгов выберите 
пункт [UseCaseSpecification] и введите значения указанных свойств. 

Чтобы создать несколько акторов для прецедента 

Чтобы создать несколько акторов, связанных с прецедентом, используйте горячий синтаксис 
создания элементов. 
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1. Дважды щелкните прецедент, или выберите прецедент и нажмите клавишу [Enter]. В 
горячем диалоге, введите имя актора после символов "()-" или несколько имен акторов, 
разделённых символом ",".

  
2. Нажмите клавишу [Enter]. Несколько акторов, связанных с текущим прецедентом будут 

созданы и размещаются вертикально. 

 

Ассоциация / Направленная ассоциация

Семантика

Ассоциация - это некоторое отношение между ровно двумя классификаторами (включая 
возможность ассоциации классификатора с самим собой). 

Чтобы создать ассоциацию

Чтобы создать ассоциацию, нажмите кнопку [Toolbox] -> [UseCase] -> [Association], проведите 
линию (как бы перетащите любую точку образа) от исходного элемента к целевому элементу. 

Чтобы создать направленную ассоциацию 

Процедура аналогична созданию обычной ассоциации, но используйте кнопку 
[DirectAssociation], проводить линию нужно в направлении стрелки. 
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Или ещё: создайте обычную ассоциацию и щёлкните конец ассоциации около актора. В горячем 
диалоге, сбросьте флажок "navigable", и ассоциация станет направленной на прецедент. 

Чтобы создать элемент, связанный с текущим ассоциацией/направленной ассоциацией 

Чтобы создать элемент, ассоциированный с текущим элементом, используйте горячий синтаксис 
создания элементов. 

1. Дважды щёлкните элемент и введите имена ассоциированных элементов после символов 
"--" или "->" в горячем диалоге. Отделяйте имена элементов символом "," , чтобы 
ассоциировать несколько элементов

  
2. Нажмите клавишу [Enter], и несколько элементов, связанных с выбранным элементом, 

будут созданы и выровнены автоматически. 

Обобщение

Семантика

Обобщение - таксономическое отношение между более общим элементом (родителем) и более 
определенным элементом (потомком), который является полностью совместимым с первым 
элементом, но содержит дополнительную информацию. 

Чтобы создать обобщение

Чтобы создать обобщение, нажмите кнопку [Toolbox] -> [UseCase] ->[Generalization], проведите 
линию от дочернего элемента к родительскому элементу. 
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Чтобы создать несколько акторов, наследованных от текущего актора 

Чтобы создать несколько наследников некоторого элемента, 

1. Введите символы "<= " в поле горячего диалога, а после них - несколько имён элементов-
наследников. 

2. Дочерние элементы будут сгенерированы ниже текущего элемента и выровнены 
автоматически.

  

Если Вы хотите создать сразу несколько родителей для текущего элемента, введите "=>" вместо 
"<=". 

Зависимость

Семантика

Зависимость - тип отношений, которые показывают, что один элемент, или группа элементов, 
являясь клиентом, зависят от другого элемента или группы элементов, которые являются 
поставщиками. Это - слабые отношения, которые обозначают, что, если поставщик изменен, 
клиент также требует изменений. Это - однонаправленные отношения. 

Чтобы создать зависимость

Чтобы создать зависимость, нажмите кнопку [Toolbox] -> [UseCase] -> [Dependency], проведите 
линию от элемента-клиента к элементу-поставщику. 
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Чтобы создать прецедент зависящий от текущего прецедента

Введите строку "->" в горячем диалоге. 

Отношение зависимости будет создано между двумя элементами. 

 

Включение

Семантика

Отношение включения определяет, что вариант использования содержит поведение, 
определенное в другом варианте использования. 

Для создания включения

Чтобы создать отношение включения, нажмите кнопку [Toolbox] -> [UseCase] -> [Include], 
проведите линию от включающего элемента к включаемому элементу. 

Чтобы создать другой прецедент, включенный в текущий прецедент 

Введите строку "-i>" и имя поставщика в горячем диалоге прецедента. 

Отношение включения будет создано между двумя элементами. 

Расширение

Семантика

Отношение расширения определяет, что инстанция прецедента может быть расширена 
некоторым дополнительным поведением, определенным в расширяющем прецеденте.
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Для создания расширения

Чтобы создать расширение, нажмите кнопку [Toolbox] -> [UseCase] -> [Extend], проведите 
линию от расширяющего элемента к расширяемому элементу. 

Чтобы создать другой прецедент, расширяющий текущий прецедент 

используйте код  "<e-" в горячем диалоге прецедента. Отношение расширения будет создано 
между двумя элементами. 

Системная граница

Семантика

Системная граница - тип ограничения, которое обозначает границу между сущностью, которую 
Вы представляете прецедентами (внутри границ) и акторами (вне границ). Её самое типичное 
использование - изображение границы системы. Прецеденты могут применяться, чтобы обозначать 
подсистемы и классы, так что граница может специфицироваться аналогично системе. Пакет со 
стереотипом верхнего уровня может использоваться как граница и пространство имён в модели 
прецедентов, чтобы обозначить границу использования прецедента. 

Чтобы создать системную границу

Чтобы создать системную границу, нажмите кнопку [Toolbox] -> [UseCase] -> [System Boundary] 
, а затем очертите сектор от начальной точки к его правому нижнему углу. 
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Пакет 

Семантика

Пакет - инструмент группировки модельных элементов. Сами пакеты могут быть вложены в 
другие пакеты. Пакет может содержать зависимые пакеты так же как другие виды модельных 
элементов. Все виды элементов UML-модели могут быть сгруппированы в пакеты. 

Чтобы создать пакет

Чтобы создать пакет, нажмите кнопку [Toolbox] -> [UseCase] -> [Package] и щелкните на 
диаграмме по месту, куда нужно поместить пакет. 

 

Использование диаграмм классов 
Следующие элементы доступны в диаграмме классов. 

• Подсистема 
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• Пакет 
• Класс 
• Интерфейс 
• Перечисление 
• Сигнал 
• Прерывание 
• Порт 
• Часть 
• Ассоциация 
• Направленная ассоциация 
• Агрегация 
• Композиция 
• Обобщение 
• Зависимость 
• Реализация 
• Класс-ассоциация 
• Соединитель 
• Объект 
• Связь 

Подсистема

Семантика

Если пакет является универсальным средством организации модельных элементов, то 
подсистема представляет собой поведенческую единицу в физической системе, и следовательно в 
модели. 

Чтобы создать подсистему

1. Щелкните кнопку [Toolbox] -> [Class] -> [Subsystem].

  
2. Затем щелкните место или границу, куда нужно поместить подсистему. 
3. Сразу после создания подсистемы на диаграмме классов будет открыт её горячий диалог. В 

горячем диалоге, введите имя подсистемы. 
4. Нажмите клавишу [Enter]. 
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Чтобы создать интерфейс, предоставляемый подсистемой 

Чтобы создать интерфейс подсистемы, 

1. Создайте интерфейс и подсистему. 
2. Щелкните кнопку [Toolbox] -> [Realization]. 
3. Проведите линию от подсистемы к интерфейсу. 
4. Между интерфейсом и подсистемой будет создано отношение реализации интерфейса. 

 

Чтобы создавать интерфейс и отношение реализации одновременно,

1. Дважды щёлкните подсистему для открытия её горячего диалога. 
2. Введите текст в горячем диалоге, как показано ниже 

  
3. Нажмите клавишу [Enter], отношение реализации интерфейса подсистемой будет создано. 

 

Чтобы создать требуемый системе интерфейс 

Чтобы создать требуемый интерфейс, используйте горячий синтаксис. 

1. Дважды щёлкните подсистему для открытия её горячего диалога. Введите текст в горячем 
диалоге, как показано ниже.
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2. Подсистема будет соединена с интерфейсом отношением требования. 

 

Чтобы добавить операцию к подсистеме

Подсистема может иметь операции. Чтобы добавить операцию к подсистеме, 

1. Выберите в контекстном меню подсистемы пункт [Collection Editor...]. 

  
2. В редакторе коллекции добавьте операцию на закладке [operations]. 

  

3. Или щелкните по кнопке  в горячем диалоге подсистемы. 
4. Новая операция будет создана.
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Класс

Семантика

Класс - дескриптор набора объектов, имеющих одинаковую структуру, поведение и отношения. 

Чтобы создать класс

Чтобы создать класс, 

1. Щелкните кнопку [Toolbox] -> [Class] -> [Class]. 
2. Щелкните диаграмму в позиции, куда нужно поместить класс. 
3. На диаграмме будет создан новый класс и будет открыт его горячий диалог. 
4. В горячем диалоге, введите имя класса, и нажмите клавишу [Enter]. 

Чтобы добавить атрибут

Есть три метода добавления атрибута к классу. 

• с использованием горячего диалога 
• с использованием навигатора модели 
• с использованием редактора коллекций. 

В случае использования горячего диалога, 

1. Сделайте двойной щелчок на классе. 
2. Нажмите кнопку [Add Attribute] в горячем диалоге, и атрибут будет добавлен. 

 

В случае использования навигатора модели, 

1. Выберите класс в навигаторе модели. 
2. Щелкните правой кнопкой мыши выбранный класс, выберите пункт [Add] -> [Attribute] в 

контекстном меню. 

В последнем случае, 

1. Выберите в контекстном меню пункт [Collection Editor...]. 
2. В окне свойств щёлкните кнопку [attributes]. 
3. На закладке [attribute] редактора коллекций, Вы можете добавить атрибут, используя 
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специальную кнопку . 

 

Чтобы добавить операцию

Есть три метода добавить операцию в класс. 

• с использованием горячего диалога 
• с использованием модельного элемента 
• с использованием редактора коллекций 

В случае использования горячего диалога, 

1. Дважды щёлкните класс, чтобы вызвать его горячий диалог. 
2. Нажмите кнопку [Add Operation] в горячем диалоге. 

В случае использования модельного элемента, 

1. выберите класс, щелкните его правой кнопкой мыши, и выберите пункт [Add] -> [Operation] 
в контекстном меню. 

 

В последнем случае, 

1. Выберите в контекстном меню пункт [Collection Editor...]. 
2. На закладке [Оperations] редактора коллекций, Вы можете добавить операцию, используя 

специальную кнопку . 
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Чтобы добавить параметр к операции

Чтобы добавить параметр к операции, 

1. Выберите операцию в навигаторе модели, выберите пункт [Add] -> [Parameter] в 
контекстном меню, новый параметр будет добавлен.
 

  
2. Или выберите операцию в навигаторе модели, выберите пункт [Collection Editor...] в 

контекстном меню.

  
3. Или щёлкните кнопку [Parameters] в окне свойств операции.

  
4. В закладке [Parameters], Вы сможете добавить параметр, используя специальную кнопку  

.
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Чтобы добавить прерывание к операции:

Перед этой процедурой, нужно создать одно или несколько прерываний. Чтобы сделать это, см. 
раздел "Чтобы создать сигнал" или "Чтобы создать прерывание". 

1. Нажмите кнопку  свойства [RaisedSignals] в окне свойств.

  
2. В закладке [RaisedSignals] редактора коллекций, Вы сможете добавить прерывание к 

операции, используя специальную кнопку .
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3. В диалоге[Select a Signal] выбирете сигнал или прерывание, порождаемое операцией и 

щелкните кнопку [OK].

  
4. Результат показан ниже. 

 

Чтобы переместить атрибут/операцию в другой класс

Чтобы переместить атрибут или операцию в другой класс, 

1. Щёлкните атрибут (или операция) в навигаторе модели.
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2. Перетащите его в другой класс. /

 

Чтобы добавить параметр шаблона в класс

Есть два способа добавить параметр шаблона в класс. 

• использование спецификации класса на диаграмме или в навигаторе модели 
• использование редактора коллекций 

Выберите класс на диаграмме или навигаторе модели, щелкните правой кнопкой мыши и 
выберите пункт [Add] -> [TemplateParameter] в контекстном меню. 

 

 Выберите пункт [Collection Editor...] в контекстном меню или нажмите кнопку 
[TemplateParameter] в окне свойств. На закладке [TemplateParameters] редактора коллекций Вы 
можете добавить параметр шаблона в класс, используя специальную кнопку. 
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Новый параметр шаблона будет добавлен в класс. Результат показан ниже. 

Чтобы создать порт 

Чтобы создать порт, 

1. Щелкните кнопку [Toolbox] -> [Class] -> [Port]. 
2. Щелкните класс, в котором нужно создать порт.

 

Чтобы создать образ порта 

Вы можете создать образ порта, перетащив его из навигатора модели в основную диаграмму. 

1. Выделите порт в навигаторе модели. 

  
2. Перетащите его на класс в основной диаграмме. Если он передвинут не на класс, а на 

другую область диаграммы, то будет создан новый класс с портом.
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Чтобы создать часть

Чтобы создать часть, 

1. Нажмите кнопку [Toolbox] -> [Class] -> [Part]. 
2. Щелкните класс, в который нужно поместить часть. 

 

Чтобы создать соединитель

Чтобы создавать соединитель, 

1. Нажмите кнопку [Toolbox] -> [Class] -> [Connector]. 
2. проведите линию от одной части к другой на диаграмме. 

  
3. Между двумя частями будет создан новый соединитель. 
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Чтобы установить активность класса 

Чтобы сделать класс активным, 

1. Установите значение свойства [IsActive] в true

  
2. Класс будет отображаться следующим образом.

 

Интерфейс

Семантика

Интерфейс - спецификатор для видимых извне операций класса, компонента или другого 
классификатора (включая подсистемы) без спецификации внутренней структуры. 

Чтобы создать интерфейс

Чтобы создать интерфейс, 

1. Нажмите кнопку [Toolbox] -> [Class] -> [Interface]. 
2. Щёлкните позицию на диаграмме, куда будет помещен интерфейс. Откроется горячий 

диалог интерфейса. Введите имя интерфейса в поле горячего диалога. 
3. Нажмите клавишу [Enter]. Результат будет следующим. 
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Чтобы создать отношение реализации

Чтобы создать отношение реализации, 

1. Щелкните кнопку [Toolbox] -> [Class] -> [Realization]. 
2. проведите линию из класса, порта, части, пакета, подсистемы на интерфейс. 

  
3. Отношение предоставления интерфейса будет создано, как показано ниже.

  

Чтобы создать отношение требования

Чтобы создать отношение требования, 

1. Щелкните кнопку [Toolbox] -> [Class] -> [Dependency]. 
2. проведите линию из класса, порта, части, пакета, подсистемы на интерфейс. 
3. Отношение требования интерфейса будет создано, как показано ниже. 

 

Перечислимый тип 

Семантика

Перечисление - определяемый пользователем тип данных, инстанции которого - упорядоченный 
набор заданных пользователем литералов. Литералы имеют относительный порядок, но никакая 
алгебра для них не определена. 

Чтобы создать перечисление

Чтобы создать перечисление, 

1. Нажмите кнопку [Toolbox] -> [Class] -> [Enumeration]. 
2. Щелкните на диаграмме в позиции, куда нужно поместить перечисление. 



StarUNL. Руководство пользователя. Глава 5. Работа с диаграммами 74 / 207

 

Сигнал

Семантика

Сигнал - спецификация асинхронного сообщения, передаваемого между инстанциями. Сигнал - 
производная от классификатора, с параметрами, выраженными атрибутами. Сигнал всегда 
является асинхронным. Сигнал ассоциируется с поведенческими особенностями (Behavioral 
Features), которые порождают его. 

Чтобы создать сигнал

Чтобы создать сигнал, 

1. Нажмите кнопку [Toolbox] -> [Class] -> [Signal]. 
2. Щелкните на диаграмме в позиции, куда нужно поместить сигнал. 

 

Прерывание

Семантика

Прерывание - сигнал, типично возникающий при возникновении ошибок выполнения. 
Прерывание ассоциируется с поведенческими особенностями, которые порождают его. 

Чтобы создать прерывание

Чтобы создать прерывание, 

1. Нажмите кнопку [Toolbox] -> [Class] -> [Exception]. 
2. Щелкните на диаграмме в позиции, куда нужно поместить прерывание. 
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Ассоциация

Семантика

Ассоциация - отношение между двумя классификаторами (включая возможность ассоциации 
классификатора с самим собой). 

Чтобы создать ассоциацию

Чтобы создать ассоциацию, 

1. Нажмите кнопку [Toolbox] -> [Class] -> [Association]. 
2. На диаграмме проведите линию от одного связываемого элемента к другому. 
3. Новая ассоциация между двумя классами будет создана, как показано ниже.

  

Чтобы добавить квалификатор к ассоциации

Чтобы добавлять квалификатор к ассоциации, 

1. Выберите пункт [Collection Editor...] в контекстном меню ассоциации.

  
2. Или нажмите кнопку [End.Qualifiers] в окне свойств.
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3. В закладке [Qualifiers] редактора коллекций Вы можете добавить спецификатор к 

ассоциации используя специальную кнопку . 

  
4. Результат показан ниже. 

 

Чтобы сразу создать несколько классов, связанных с текущим классом

Если Вы хотите создать классы Dog, Pig, Cat, связанные с классом Me. 
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1. Дважды щелкните класс Me, или нажмите клавишу [Enter]. В горячем диалоге, введите как 
показано ниже. 

  
2. Три класса и ассоциация будут созданы, как показано ниже. 

 

Направленная ассоциация

Чтобы создать направленную ассоциацию

Процедура создания направленной ассоциации аналогична процедуре создания простой 
ассоциации. 

1. Нажмите кнопку [Toolbox] -> [Class] -> [DirectedAssociation]. 
2. проведите линию между двумя элементами в нужном направлении. 
3. Результат будет следующим. 

 

Процедура замены ассоциации на направленную ассоциацию

Чтобы заменить ассоциацию на направленную ассоциацию, щёлкните противоположный от 
стрелки конец ассоциации. В горячем диалоге сбросьте признак направленности роли (navigable), 
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и ассоциация станет направленной. 

Процедура создания направленной ассоциации с помощью горячего синтаксиса 

Чтобы создавать элемент, получающий направленную ассоциацию, используйте горячий 
синтаксис создания элементов. 

1. Дважды щёлкните элемент. В горячем диалоге введите символы "->", а затем имена 
элементов, которые получат направленные ассоциации, разделённые символом ",". 

2. Нажмите клавишу [Enter], и множество заданных элементов, связанных с выбранным 
элементом направленными ассоциациями, будут созданы и автоматически размещены на 
диаграмме. 

Агрегация

Семантика

Агрегация - специфический тип ассоциации. На агрегат показывает полый ромбик в точке, где 
ассоциация соединяется с классификатором (конец ассоциации). Агрегация обозначает отношение 
"целое - часть". Классификатор, близ которого расположен полый ромбик, - целое. 

Процедура создания агрегата

Чтобы создавать агрегацию, 

1. Щелкните кнопку [Toolbox] -> [Class] -> [Aggregation]. 
2. проведите линию от класса-части к классу-агрегату. 
3. Результат будет следующим. 
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Процедура создания агрегированного класса с помощью горячего синтаксиса создания 
элементов 

Чтобы создать класс, агрегированный в выбранный класс, используйте горячий синтаксис 
создания элементов. 

1. Двойным щелчком вызовите горячий диалог текущего класса. В горячем диалоге, введите 
символы "<>-", а затем имена классов, агрегированных в текущий класс. 

2. Нажмите клавишу [Enter], и классы, агрегированные в выбранный класс, будут созданы и 
размещены автоматически.

 

Композиция

Семантика

Композиция - специфический тип ассоциации. Композиция обозначается заполненным 
ромбиком в точке, где ассоциация соединяется с классификатором (конец ассоциации). 
Композиция обозначает отношение целого и её неотделимой составной части, существование 
которой невозможно без целого. Классификатор, близ которого расположен заполненный ромбик, - 
целое. 

Процедура создания композиции

Чтобы создать композицию, 

1. Нажмите кнопку [Toolbox] -> [Class] -> [Composition]. 
2. проведите линию от класса-части к классу-композиту. 
3. Между двумя классами, будет создано новое отношение композиции, как показано ниже. 
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Процедура создания компонентов класса-композита с помощью горячего синтаксиса 

Чтобы создать классы-части выбранного класса-композита, используйте горячий синтаксис

1. Двойным щелчком вызовите горячий диалог. В горячем диалоге введите символы "<*>-", а 
затем имена классов, составляющих выбранный класс, разделённые символом ",". 

2. Нажмите клавишу [Enter], и классы, составляющие выбранный класс, будут созданы и 
размещены автоматически.

 

Обобщение

Семантика

Обобщение - таксономическое отношение между более общим элементом (родителем) и более 
специфичным элементом (потомком), который является полностью совместимым с первым 
элементом, но содержит дополнительную информацию. Оно используется для классов, пакетов, 
прецедентов и других элементов. 

Процедура создания обобщения

Чтобы создать обобщение, 

1. Щелкните кнопку [Toolbox] -> [Class] -> [Generalization]. 
2. Проведите линию от дочернего элемента в родительский элемент в [основном окне]. 
3. Новое обобщение будет создано. 
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Процедура создания нескольких дочерних классов сразу.

Чтобы сразу создать несколько дочерних классов от выбранного класса, используйте горячий 
синтаксис. 

1. Двойным щелчком вызовите горячий диалог. В горячем диалоге после строки "<= ", введите 
имена классов-наследников выбранного класса, разделённые ",". 

2. Дочерние классы будут созданы ниже выбранного класса и размещены автоматически. 

Процедура создания сразу нескольких родительских классов для текущего класса

Чтобы создать сразу несколько родительских классов для выбранного класса, используйте 
горячий синтаксис. 

1. Двойным щелчком вызовите горячий диалог. В горячем диалоге введите после символов " 
=> " имена родительских классов выбранного класса, разделённых ",". 

2. Родительские классы будут созданы выше выбранного класса и размещены автоматически. 

 

Зависимость

Семантика

Зависимость определяет семантические отношения между двумя модельными элементами (или 
двумя множествами модельных элементов). Она связывает модельные элементы непосредственно 
и не требует множества инстанций для их обозначения. Она указывает на ситуацию, когда 
изменение целевого элемента может повлечь необходимость изменения исходного элемента 
зависимости. 
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Процедура создания зависимости

Чтобы создать зависимость, 

1. Щелкните кнопку [Toolbox] -> [Class] -> [Dependency]. 
2. проведите линию между элементами в [основном окне] в направлении зависимости. 
3. Новая зависимость между двумя классами будет создана. 

 

Процедура создания зависимого элемента с помощью горячего синтаксиса

Чтобы создать элемент, зависящий от выбранного элемента, используйте горячий синтаксис. 

1. Двойным щелчком по элементу вызовите горячий диалог. В горячем диалоге после 
символов "->" введите имена зависимых элементов, разделённых запятыми. 

2. Нажмите клавишу [Enter] и зависимые элементы от выбранного класса будут созданы и 
автоматически размещены. 

Реализация

Семантика

Реализация определяет отношение между набором элементов, которые формируют 
спецификацию (клиент), и множеством элементов, которые формируют её реализацию 
(поставщик). 

Процедура создания реализации

1. Щелкните кнопку [Toolbox] -> [Class] -> [Realization]. 
2. проведите линию между элементами в [основном окне] в направлении реализации. 
3. Результат будет следующим. 
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Процедура создания реализующего элемента для выбранного элемента

Чтобы создать целевой элемент интерфейса для выбранного элемента, используйте горячий 
синтаксис. 

1. Двойным щелчком вызовите горячий диалог. В горячем диалоге введите после "-@" имена 
элементов интерфейса, разделённые символом ",". 

2. Нажмите клавишу [Enter] и интерфейсы для выбранного элемента будут созданы и 
размещены автоматически. 

Класс-ассоциатор

Семантика

Класс-ассоциатор - ассоциация, которая является также классом. Она не только соединяет 
классификаторы, но также и определяет набор атрибутов, которые непосредственно принадлежат 
отношению, а не любому из классификаторов. 

Процедура создания класс-ассоциатора 

Чтобы создать класс-ассоциатор, 

1. Щелкните кнопку [Toolbox] -> [Class] -> [AssociationClass]. 
2. проведите линию между ассоциацией и классом ассоциации в [основном окне].

  
3. Результат будет следующим. 
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Объект

Семантика

Объект представляет специфическую инстанцию класса. Он имеет идентификатор и атрибуты со 
значениями. Аналогичный элемент используется для ролей в диаграммах сотрудничества, потому 
что роли имеют характеристики, подобные инстанциям. 

Процедура создания объекта

Чтобы создать объект, 

1. Щелкните кнопку [Toolbox] -> [Class] -> [Object]. 
2. Щелкните позицию, куда нужно поместить объект в [основном окне]. 

Процедура добавления значений атрибутов в объект

Есть два способа добавления значений атрибутов в объект. 

• использование объектной модели в [основном окне] или [навигатора модели] 
• использование [редактора коллекции] 

В случае использования объектной модели, выберите объект в [основном окне] или в 
[навигаторе модели], щелкните правой кнопкой мыши выбранный объект, выберите [Add] -> 
[Attribute Link] в контекстном меню и добавьте значение атрибута. 

 

В другом случае, выберите во всплывающем меню объекта пункт [Collection Editor...] или 
щёлкните соответствующую кнопку в окне свойств. В закладке [Slots] [редактора коллекции] Вы 
можете добавить значение атрибута, используя соответствующую кнопку . 
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Связь

Семантика

Связь - кортеж (список) объектных ссылок. Обычно, это - пара объектных ссылок. Это - 
инстанция ассоциации. 

Процедура создания связи

Чтобы создать связь, 

1. Щелкните кнопку [Toolbox] -> [Class] -> [Link]. 
2. Проведите линию от одного объекта к другому в [основном окне].  

Отношение

Процедура изменения соединения с другим элементом

Чтобы изменить присоединённый элемент связи на другой 

1. Потяните мышью за конец отношений.

  
2. Перетащите его к другому элементу. 

  
3. Тогда конец отношения будет перецеплен. 
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Использование диаграмм сообщений 
Следующие элементы доступны в диаграмме следования. 

• Объект 
• сообщение (импульс) 
• Рекурсивное сообщение 
• Объединенный фрагмент 
• Операнд взаимодействия 
• Рамка подсистемы 

Объект

Процедура создания объекта

Чтобы создать объект, 

1. Щелкните кнопку [Toolbox] -> [Sequence] -> [Object]. 
2. Щелкните на диаграмме в позиции, куда будет помещен объект. 
3. Будет отображён горячий диалог. В горячем диалоге, введите имя объекта. 
4. Нажмите клавишу [Enter].

 

Процедура установки активного объекта

Чтобы установить класс как активный объект, 

1. Установите свойство [IsActive] присвоенного класса в true.
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Для объекта MyObject, измените свойство IsActive класса MyClass. 

Если свойство класса не присвоено, Вы не сможете изменить сделать объект активным. 
Результат будет следующим. 

 

Процедура установки многообъектности 

Чтобы установить объекту статус многообъектности, 

1. Установите свойство [IsMultiInstance] объекта в истину.

  
2. Тогда простой объект превратится в многообъектную сущность.
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Процедуры создания объекта на основе класса

Чтобы создать объект от класса, 

1. Выберите класс в [навигаторе модели]. 
2. Перетащите его в [основное окно]. 
3. Объект будет создан на диаграмме. 

Процедура создания класса на основе объекта

Если класс не присвоен объекту, 

1. Дважды щёлкните объект, чтобы вызвать горячий диалог, щелкните кнопку добавления 
класса

  
2. В диалоге [Enter element name], введите новое имя класса.

  
3. Новый класс будет создан и присвоен объекту.

 
4. Если Вы хотите присвоить объекту существующий класс, щёлкните кнопку 

соответствующего свойства в спецификации объекта и выбирите класс в диалоге [Select a 
model element].
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Процедура создания, исходящего вызова от объекта, используя горячий синтаксис 

Чтобы создать исходящий вызов от выбранного объекта к другому объекту, 

1. Дважды щелкните объект-источник, или выберите объект-источник и нажмите клавишу 
[Ввод], чтобы вызвать горячий диалог. 

2. В горячем диалоге, введите имя сообщения после строки "->" ("<-" строка для входного 
сообщения и " <-> " - для вызова с возвращением). 

3. Нажмите клавишу [Ввод] и исходящий вызов от выбранного объекта к целевому объекту 
будет создан и размещен последним.

 

сообщение 

Семантика

сообщение - связь (импульс) между двумя инстанциями, которая передает информацию об 
ожидании последующего действия. сообщение побуждает выполнить операцию, подать сигнал или 
выполнить создание/уничтожение инстанции. 
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Чтобы создать сообщение, 

1. Щёлкните кнопку [Toolbox] -> [Sequence] -> [Stimulus]. 
2. Проведите линию от одного объекта к другому (объекту или линии жизни) в [главном окне] 

в направлении исходящего сообщения.

  
3. Откроется горячий диалог сообщения. Введите имя сообщения  в горячем диалоге и 

нажмите [Ввод].

  
4. В итоге, сообщение будет создано как показано ниже.

 

Процедура использования операции класса как сообщения 

Если свойство классификатора получателя (объекта) сообщения  присвоено, и Вы хотите 
присвоить операцию сообщению, 

1. Дважды щёлкните сообщение 
2. Нажмите кнопку  в горячем диалоге.



StarUNL. Руководство пользователя. Глава 5. Работа с диаграммами 91 / 207

  
3. Выберите операцию в диалоге [Select an operation] и нажмите [OK].

  
4. Новое сообщение, на основе операции класса будет добавлено следующим образом.

 

Процедура создания операции класса из объекта

Чтобы создать операцию класса на основе принимаемого сообщения и присвоить ее сообщению, 

1. Дважды щелкните сообщение, нажмите кнопку  в горячем диалоге. 
2. Введите новое имя создаваемой операции щелкните [OK].
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3. Новая операция добавится в класс, и текст в горячем диалоге будет заполнен (эта процедура 

допустима, когда существует присвоенный класс). Нажмите [Ввод].

  
4. См. [навигатор модели], чтобы убедиться в создании новой операции.

 

Процедура создания предшествующего сообщения из текущего сообщения, используя 
горячий синтаксис 

Чтобы создать предшествующее сообщение для текущего сообщения, 

1. Дважды щелкните сообщение, или выберите сообщение и нажмите [Ввод].

  
2. В горячем диалоге, после строки "~>" (или "<~" - для входящего сообщения), введите имя 

целевого объекта и имя сообщения.
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3. Нажмите [Ввод], а затем новый объект, и сообщение будет создано и размещено выше 

выбранного сообщения.

 

Процедура создания следующего сообщения из текущего сообщения, используя горячий 
синтаксис 

Чтобы создать последующее сообщение для выбранного сообщения, 

1. Дважды щелкните сообщение, или выберите сообщение и нажмите [Ввод].

  
2. В горячем диалоге, после строки "_>" (или "<_" - для входящего сообщения), введите имя 

целевого объекта и имя сообщения. 
3. Нажмите [Ввод], а затем новый объект, и сообщение будет создано и размещен рядом с 

выбранным сообщением.
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Процедура создания под-сообщения, используя горячий синтаксис 

Чтобы создать под-сообщение из выбранного сообщения, 

1. Дважды щелкните сообщение, или выберите сообщение и нажмите [Ввод].

  
2. В горячем диалоге, после строки "->" (или "<-" - для входящего сообщения), введите имя 

целевого объекта и имя под-сообщения.
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3. Нажмите [Ввод], а затем новый объект, и сообщение будет создано и размещено ниже 

выбранного сообщения.

 

Процедура пересоединения к другому объекту 

Чтобы переподключить сообщение к другому объекту, 

1. Щёлкните конец сообщения.

  
2. Перетащите конец сообщения к другому объекту.
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3. сообщение будет связано с другим объектом.

 

Процедура изменения типа сообщения 

Свойству [ActionKind] сообщения должно быть присвоено одно из пяти следующих значений. 
Чтобы изменить [ActionKind], выберите сообщение и выберите свойство [ActionKind] в окне 
свойств. 

•           CALL 

•          SEND 
•          RETURN 

•      CREATE 

•     DESTROY 

Рекурсивное сообщение 

Процедура создания сообщения себе

Чтобы создать сообщение себе, 

1. Щёлкните кнопку [Toolbox] -> [Sequence] -> [SelfStimulus]. 
2. Щёлкните объект (или линию жизни), где будет помещено сообщение себе в [главном окне]. 
3. Откроется горячий диалог объекта. В горячем диалоге, введите имя сообщения и нажмите 

[Ввод]. 
4. Результат процедуры следующий. Вы можете упорядочивать позицию сообщения, чтобы 

уменьшить перекрывание текста и линий. 



StarUNL. Руководство пользователя. Глава 5. Работа с диаграммами 97 / 207

 

Комбинированный фрагмент

Процедура создания комбинированного фрагмента

Чтобы создать комбинированный фрагмент, 

1. Щёлкните [Toolbox] -> [Sequence] -> [Combined Fragment]. 
2. Щёлкните позицию в [главном окне], куда нужно поместить комбинированный фрагмент. 

  
3. Комбинированный фрагмент будет создан. 
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4. Измените оператор взаимодействия в свойствах следующим образом. 

  
5. Комбинированный фрагмент будет показан следующим образом. 

 

Процедура создания операнда взаимодействия 

Чтобы создать операнд взаимодействия, 

1. Щёлкните [Toolbox] -> [Sequence] -> [Interaction Operand]. 
2. Щёлкните на комбинированном фрагменте, где нужно поместить операнд взаимодействия. 
3. Новый операнд взаимодействия добавится к комбинированному фрагменту. Щелкните 

операнд взаимодействия.

  
4. Когда точки выбора операнда взаимодействия будут показаны, перетащите их, чтобы 

установить его границу.
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Рамка

Процедура создания рамки

Чтобы создать рамку, 

1. Щёлкните [Toolbox] -> [Sequence] -> [Frame]. 
2. Щелкните позицию, где будет помещена Рамка в [главном окне].

  
3. Новая рамка будет создана следующим образом. 
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Диаграмма

Процедура отображения порядковых номеров сообщений на диаграмме 

Чтобы показать или скрыть порядковый номер сообщения, 

1. Выберите диаграмму в [навигаторе модели] или в [главном окне] 

  
2. Установите свойство [ShowSequenceNumber] диаграммы в true. 

  
3. Когда [ShowSequenceNumber] сброшено, диаграмма сообщений показывается следующим 

образом.
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Процедура изменения стиля сигнатур сообщений на диаграмме

Существуют четыре стиля сообщений. Чтобы изменить сигнатуру сообщения, выберите 
диаграмму в [навигаторе модели] или в [главном окне], и установите свойство [MessageSignature] 
диаграммы в одно из следующих значений. 

Процедура изменения стиля активации на диаграмме 

Чтобы показать или скрыть активацию сообщения, выберите диаграмму в [навигаторе модели] 
или в [главном окне], и установите свойство [ShowActivation] диаграммы в true или false. 

  
 Стиль  Пример

NONE

NAMEONLY

TYPEONLY

NAMEANDTYPE

Использование диаграммы коллабораций 
Следующие элементы доступны в диаграмме коллаборации. 

• Объект 
• Связь 
• Рекурсивная связь 
• Сообщение 
• Рамка 

Диаграмма коллабораций является формой диаграммы сообщений, поэтому часть её элементов 
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по своей семантике и процедурам создания аналогичны соответствующим элементам диаграммы 
сообщений.

Объект

Процедура создания объекта

Чтобы создать объект, 

1. Нажмите [Toolbox] -> [Collaboration] -> [Object]. 
2. Затем щелкните позицию главного окна, куда нужно поместить объект. 
3. Отобразится горячий диалог. В горячем диалоге введите имя объекта. 
4. Нажмите [Ввод] 

Процедура создания, исходящего сообщения с помощью горячего синтаксиса 

Чтобы создать исходящий вызов от выбранного объекта к другому объекту 

1. Дважды щелкните объект-источник, или выберите объект-источник и нажмите клавишу 
[Ввод], чтобы отобразить горчий диалог. 

2. В горячем диалоге, введите имя сообщения после строки "-> " (или "<-" - для приходящего 
сообщения, и "<-> " - для исходящего сообщения с возвратом). 

3. Нажмите клавишу [Ввод], и исходящий вызов от выбранного объекта к целевому объекту 
будет создан и расположен последним. 

 

Процедура установки активности объекта

Чтобы присвоить класс активному объекту, 

1. Установите у присваиваемого класса свойство [IsActive] в true.

  
2. Для MyObject, измените свойство [IsActive] класса MyClass.
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3. Если ссылка на класс не установлена, Вы не сможете специфицировать объект как 

активный. 

Процедура установки множественности объекта

Чтобы преобразовать объект в мульти-объект, 

1. Установите свойство IsMultiInstance объекта в true.

  
2. Объект станет мульти-объектом

 

Процедура создания объекта на основе класса

Чтобы создать объект на основе класса, 

1. Выберите класс в [навигаторе модели]. 
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2. Перетащите его на диаграмму коллабораций. 
3. Объект (инстанция класса) будет создан.

 

Процедура создания класса на основании объекта

Если класс не присвоен объекту, 

1. Дважды щелкните объект, чтобы отобразить горячий диалог. 
2. В горячем диалоге, щелкните кнопку добавления класса.

  
3. В диалоге [Enter element name], введите имя класса. 

  
4. Новый класс будет создан и назначен объекту. 

 

Если Вы хотите назначить существующий класс объекту, введите имя существующего класса в 
диалоге [Select a model element]. 
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Процедура добавления AttributeLink к объекту 

Есть два способа добавить связь атрибута к объекту 

• используя объектную модель в главной диаграмме или [навигаторе модели] 
• используя [редактор коллекций] 

В случае использования объектной модели, 

1. Выберите объект в [главном окне] или в [навигаторе модели]. 
2. Щелкните правой кнопкой мыши выбранный объект, выберите [Add] -> [Attribute Link]во 

всплывающем меню и нажмите Attribute Link. 

  
3. Новая атрибутная связь будет создана. 

 

В другом случае, 

1. Выберите [Collection Editor...] в контекстном меню объекта или щёлкните свойство [Slots] в 
окне свойств. 

  
2. В закладке слотов [редактора коллекции], Вы можете добавить связь атрибута, используя 

кнопку.
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Связь

Процедура создания связи

Чтобы создать связь, 

1. нажмите [Toolbox] -> [Collaboration] -> [Link]. 
2. Перетащите линию от одного объекта к другому в [главном окне]. 
3. Между двумя объектами будет создана связь. 

 

Рекурсивная связь

Процедура создания рекурсивной связи 

Чтобы создать рекурсивную связь, 

1. Щёлкните [Toolbox] -> [Collaboration] -> [SelfLink]. 
2. Щёлкните объект на диаграмме, для которого создаётся рекурсивная связь. 

Процедура создания рекурсивного сообщения 

Чтобы создать рекурсивное сообщение, 

1. Щёлкните [Toolbox] -> [Collaboration] -> [ForwardStimulus/ReverseStimulus]. 
2. Щёлкните в [главном окне] рекурсивную связь, для которой нужно создать рекурсивное 

сообщение. 
3. Дважды щёлкните сообщение и введите имя сообщения в горячем диалоге. 
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Сообщение

Процедура создания сообщения

Чтобы создать сообщение, 

1. Щёлкните [Toolbox] -> [Collaboration] -> [ForwardStimulus/ReverseStimulus] 

  
2. Щелкните связь в [главном окне], на которую будет помещено сообщение. 

  
3. Дважды щёлкните сообщение и введите имя сообщения в горячем диалоге.

  
4. Результат будет следующим. 

 

Процедура изменения свойства ActionKind сообщения 

Свойству [ActionKind] сообщения должно быть присвоено одно из пяти значений, указанных 
ниже. Чтобы изменить свойство [ActionKind], выберите сообщение и выберите свойство 
[ActionKind] в окне свойств. 

  
CALL 

SEND 

RETURN 
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CREATE 

DESTROY 

Рамка

Процедуры создания рамки

Чтобы создать рамку, 

1. Щёлкните [Toolbox] -> [Collaboration] -> [Frame]. 
2. Очертите сектор главного окна, куда будет помещена рамка.

  
3. Результат будет следующим. 

 

Диаграмма

Процедура включения отображения порядковых номеров сообщений на диаграмме 

Чтобы показать или скрыть порядковый номер сообщения, выберите диаграмму в [навигаторе 
модели] или в [главном окне], и установите свойство диаграммы [ShowSequence] в true или false. 

Процедура изменения стиля сигнатуры сообщений в диаграмме

Есть четыре стиля сообщения. Чтобы изменить сигнатуру сообщения, 

1. Выберите диаграмму в [навигаторе модели] или в [главном окне]. 
2. Установите свойство [MessageSignature] диаграммы в одно из следующих значений
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• NONE показывать только имя 
• NAMEONLY показывать имя сообщения и мена аргументов 
• TYPEONLY показывать имя сообщения, тип аргументов и возвращаемый тип 
• NAMEANDTYPE показывать имя сообщения, типы и имена аргументов, и возвращаемый 

тип. 

Использование диаграммы состояний 
Следующие элементы доступны на диаграмме состояний. 

• Состояние 
• Субмодель состояний 
• Начальное состояние 
• Конечное состояние 
• Точка соединения 
• Точка выбора 
• Поверхностная хронология 
• Глубокая хронология 
• Синхронизация 
• Заключительный Поток 
• Переход 
• Рекурсивный переход 

Состояние

Семантика

Состояние - жизненное положение объекта, в течение которого он удовлетворяет некоторым 
условиям, исполняет некоторое действие, или ждет некоторого случая. 

Процедура создания состояния

Чтобы создать состояние, 

1. Щёлкните [Toolbox] -> [Statechart] -> [State]. 
2. Щёлкните в позиции главного окна, куда нужно поместить состояние. 
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3. Состояние будет создано. Введите имя состояния в горячем диалоге. 
4. Нажмите клавишу [Ввод], чтобы завершить процедуру.

 

Процедура перемещения одного состояния в другое состояние

Чтобы переместить одно состояние в другое, 

1. Щёлкните состояние, которое содержится в некотором состоянии.

  
2. Перетащите его в другое состояние. 

  
3. Выбранное состояние переместится в другое состояние. 

 

Процедура перемещения нескольких состояний сразу

Чтобы создать несколько состояний с входящим или уходящим переходом от выбранного 
состояния, используйте горячий синтаксис. 

1. Дважды щёлкните состояние. Будет показан горячий диалог. В горячем диалоге, после 
строки "->" (или "<-" - для прихода), введите имена целевых состояний, разделённые 
запятой. 
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2. Нажмите клавишу [Ввод]. Несколько состояний, происходящих (приходящих) от 
выбранного состояния будут созданы и размещены на диаграмме автоматически. 

Процедура добавления акций entry/do/exit 

Есть три способа добавить акцию к состоянию. 

• использование горячего диалога, 
• использование модельного элемента в [главном окне] или [навигаторе модели], 
• использование [редактора коллекции]. 

В случае использования горячего диалога, 

1. Дважды щёлкните состояние, 
2. Нажмите [Add Entry/Add DoAction/Add ExitAction] в горячем диалоге

  
3. Вы добавили действие. 

 

В случае использования модельного элемента, выберите состояние в [главном окне] или в 
[навигаторе модели]. Щелкните правой кнопкой мыши выбранное состояние, выберите [Add]-> 
[Entry/Do/Exit] в контекстном меню. 

 

В последнем случае, 

1. выберите [Редактор коллекции ...] в контекстном меню состояния. 
2. или щёлкните кнопку  в свойстве [EntryActions/DoActions/ExitActions] в окне свойств. 
3. На закладке [Entry Actions/Do Actions/Exit Actions] [редактора коллекции], Вы можете 

добавить действие, используя соответствующую кнопку. 

Субмодель состояний

Семантика

Субмодель состояний - синтаксический элемент, который обеспечивает многократное 
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использование и модульность "модельных спецификаций". Он является как бы 
макрорасширением, для вставки в другой конечный автомат, который семантически эквивалентен 
композиту состояний. 

Процедура создания субмодели состояний 

Чтобы создавать субмодель состояний, 

1. Щёлкните [Toolbox] -> [Statechart] -> [SubmachineState]. 
2. Щёлкните позицию на диаграмме, куда нужно поместить субмодель. Субмодель будет 

создана, и для неё откроется горячий диалог.

  
3. В горячем диалоге, введите имя субмодели состояний и нажмите клавишу [Ввод].

 

Начальное состояние

Семантика

Начальное состояние - своего рода псевдо-состояние, которое обозначает отправную точку в 
области модели состояний. Она имеет единственный исходящий переход к заданному по 
умолчанию состоянию области включения, и не имеет никаких входящих переходов. Может быть 
одно (и только одно) начальное состояние в любой данной области модели состояний. Это - не 
самостоятельное состояние, а скорее некоторый маркер. 

Процедура создания начального состояния

Чтобы создать начальное состояние, 

1. Щёлкните [Toolbox] -> [Statechart] -> [InitialState]. 
2. Затем щёлкните в позиции на диаграмме, где нужно разместить начальное состояние. 

Процедура создания начального состояния из состояния

Чтобы создать начальное состояние с исходящим переходом к выбранному объекту, используйте 
горячий синтаксис. 

1. Дважды щёлкните по состоянию. В горячем диалоге, введите строку "-*", а затем имя 
начального состояния или ничего. 
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2. Нажмите клавишу [Ввод] и начальное состояние с уходящим переходом к выбранному 
состоянию будет создано. 

 

Конечное состояние

Семантика

Заключительное состояние представляет собой последнее или "заключительное" состояние 
модели состояний. Может существовать более чем одно заключительное состояние на любом 
уровне, что означает, что процесс может закончиться различными способами или условиями. 
Когда заключительное состояние будет достигнуто и оно не включает другие состояния, это 
означает, что машина выполнила все переходы, и больше переходов произойти не может. 

Процедура создания заключительного состояния

Чтобы создать конечное состояние, 

1. Нажмите [Toolbox] -> [Statechart] -> [FinalState]. 
2. И щёлкните в позиции на диаграмме, где будет помещено конечное состояние. 

Процедура создания заключительного состояния из состояния

Чтобы создать заключительное состояние с входящим переходом от выбранного объекта, 
используйте горячий синтаксис. 

1. Дважды щелкните состояние. В горячем диалоге, введите строку "-" а затем имя 
заключительного состояния или ничего. 

2. Нажмите клавишу [Ввод] и заключительное состояние со входящим переходом от 
выбранного состояния будет создано. 
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Точка соединения

Семантика

Цепочки точек соединения объединяют несколько переходов в один полный путь. Бывает 
несколько входящих и/или исходящих переходов. Каждый полный путь, образуемый соединениями 
- логически независим и только один из них может использоваться в каждый момент времени. 
Могут быть использованы для конструирования ветвлений и слияний. 

Процедура создания точки соединения

Чтобы создать точку соединения, 

1. Щёлкните [Toolbox] -> [Statechart] -> [JunctionPoint]. 
2. Щёлкните в позиции диаграммы, куда нужно поместить точку соединения. 

 

Точка выбора

Семантика

Точка выбора разбивает входящий переход на несколько непересекающихся исходящих 
переходов. Каждый исходящий переход имеет граничное условие, которое вычисляется после того, 
как предшествующие действия на входящем пути будут выполнены. Не менее одного исходящего 
перехода должно выть определено из данной точки, иначе модель не является корректной. 

Процедура создания точки выбора

Чтобы создать точку выбора, 

1. щёлкните [Toolbox] -> [Statechart] -> [ChoicePoint]. 
2. щёлкните в позиции диаграммы, куда нужно поместить точку выбора. 

 

Поверхностная хронология

Семантика

Когда этот элемент достигается как адресат перехода, он восстанавливает состояние в пределах 
включающего композитного состояния, которое было активно непосредственно перед тем, как это 
включающее состояние было покинуто. Не восстанавливает никаких подсостояний последнего 
активного состояния. 
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Процедура создания поверхностной хронологии 

Чтобы создать поверхностную хронологию, 

1. щёлкните [Toolbox] -> [Statechart] -> [ShallowHistory]. 
2. щёлкните в позиции на диаграмме, куда следует поместить поверхностную хронологию. 

 

Процедура создания поверхностной хронологии от состояния

Чтобы создавать хронологию с уходящим переходом от выбранного объекта, используйте 
горячий синтаксис. 

1. Дважды щелкните состояние. В горячем диалоге, введите один из кодов "-(h)", "-(H)", "-(h 
*)", "-(H *)". 

2. Нажмите клавишу [Ввод], и хронология с уходящим переходом от выбранного состояния 
будет создана. 

Глубокая хронология

Семантика

Когда этот элемент достигается как адресат перехода, он восстанавливает полную 
конфигурацию состояния, которая была актуальна непосредственно перед тем, как композитное 
состояние было последний раз покинуто. 

Процедура создания глубокой хронологии

Чтобы создать глубокое состояние, 

1. Щёлкните [Toolbox] -> [Statechart] -> [DeepState]. 
2. Щёлкните в позиции главного окна, куда следует поместить глубокое состояние. 

 

Синхронизация

Процедура создания области синхронизации

Чтобы создать синхронизацию, 

1. Щёлкните [Toolbox] -> [Statechart] -> [Synchronization]. 
2. Щёлкните в позиции главного окна, куда следует поместить синхронизацию. 
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Процедура создания соединения

Чтобы создать соединение входящих переходов к выбранному объекту, используйте горячий 
синтаксис. 

1. Дважды щелкните состояние. В горячем диалоге, введите код "<-|" и имена соединяемых 
состояний, разделённые запятыми. 

2. Нажмите клавишу [Ввод], и состояния, присоединённые к выбранному состоянию, будут 
созданы и размещены автоматически. 

 

Чтобы создать ветвление исходящих переходов к выбранному объекту, используйте горячий 
синтаксис. 

1. Дважды щелкните состояние. В горячем диалоге, введите код "->|" и имена состояний, к 
которым нужно разветвиться, разделённые запятыми. 

2. Нажмите клавишу [Ввод], и состояния, ответвленные от выбранного состояния, будут 
созданы и размещены автоматически. 
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Заключительный поток

Процедура создания заключительного потока

Чтобы создать заключительный поток, 

1. щёлкните [Toolbox] -> [Statechart] -> [Flow Final]. 
2. щёлкните в позиции на диаграмме, куда следует поместить заключительный поток. 

 

Переход

Семантика

Переход - направленное отношение между исходным состоянием и целевым состоянием. Он 
может быть частью составного перехода, который выполняет машина состояний при переходе от 
одной конфигурации к другой, и который представляет собой реакцию системы на специфическую 
инстанцию события. 

Процедура создания перехода

Чтобы создать переход, 

1. Щёлкните [Toolbox] -> [Statechart] -> [Transition]. 
2. Проведите линию между состояниями в направлении перехода в [главном окне]. 
3. Между двумя состояниями будет создан переход. 

 

Процедура переключения на другой элемент

Чтобы пересоединить переход к другому состоянию, 

1. Щелкните конец перехода. 
2. Перетащите его на другое состояние. 
3. Переход будет пересоединён. 
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Рекурсивный переход

Процедура создания рекурсивного перехода 

Чтобы создать рекурсивный переход, 

1. Щёлкните [Toolbox] -> [Statechart] -> [SelfTransition]. 
2. Щелкните состояние (на диаграмме), для которого создаётся рекурсивный переход

 

Использование диаграммы действий 
Следующие элементы доступны в диаграмме действий. 

• Действие 
• Субдейсвтвие 
• Начальное состояние 
• Конечное состояние 
• Синхронизация 
• Решение 
• Заключительный поток 
• Объектный поток 
• Приём сигнала 
• Передача сигнала 
• Переход 
• Рекурсивный переход 
• Область действия 

Диаграмма действий является частным случаем диаграммы состояний. Поэтому часть её 
элементов по своей семантике и процедурам создания аналогична соответствующим элементам 
диаграммы состояний.

Действие

Семантика

Действие (или состояние действия) представляет собой выполнение простой акции или 
операции. Состояние действия - простое состояние, подразумевающее исполнение акции и выход 
из этого состояния, выполняемый по неявному событию. То есть оно соответствует выполнению 
непосредственно акции и исходящему переходу, который будет активизирован, как только 
выполнение действия будет завершено. 
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Процедура создания действия

Чтобы создать действие, 

1. Щёлкните [Toolbox] -> [Activity] -> [ActionState] 
2. Щёлкните в позиции на диаграмме, куда следует поместить действие. 
3. Состояние действия будет создано, и высветится горячий диалог. 
4. Введите имя состояния действия в горячий диалоге и нажмите клавишу [Ввод]. Результат 

будет следующим.

 

Субдейсвтвие

Семантика

Субдейсвтвие представляет собой выполнение неатомарной последовательности шагов, которая 
имеет некоторую продолжительность; то есть, внутренне оно состоит из набора действий и, 
возможно, ожидания событий. То есть субдействие - “иерархическое действие”, выполняющее 
некоторый связанный граф. 

Процедура создания субдействия 

Чтобы создать субдейсвтвие, 

1. щёлкните [Toolbox] -> [Activity] -> [SubactivityState] 
2. щёлкните в позиции на диаграмме, куда следует поместить субдейсвтвие. Субдействие 

будет создано и высветится горячий диалог. В горячем диалоге, введите имя субдействия и 
нажмите клавишу [Ввод]. Результат будет следующим.

 

Решение

Семантика

Диаграмма состояний (и производная от неё диаграмма действий) использует элемент решения, 
когда вычисляются некоторое граничные условия, необходимые, чтобы указать возможные 
переходы, зависящие от результатов вычисления этих логических условий применительно к 
владеющему объекту. 
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Процедура создания решения

Чтобы создать решение, 

1. щёлкните [Toolbox] -> [Activity] -> [Decision] 
2. щёлкните в позиции на диаграмме, куда следует поместить решение. Решение будет создано 

на диаграмме.

 

Процедура создания решения от состояния

Чтобы создать решение со входящим переходом от выбранного объекта, используйте горячий 
синтаксис. 

1. Дважды щелкните состояние (действие). В горячем диалоге, введите код "-><>" ("<-<>" - 
для входящего перехода от решения). 

2. Нажмите клавишу [Ввод], и решение с исходящим переходом от выбранного состояния 
будет создано. 

 

Объектный поток

Семантика

Объектный поток - один из двух типов действий, являющихся направленным подключением 
между узлами (другой называется потоком управления). Как только узловое действие в источнике 
(хвосте) потока заканчивается, оно посылает сигналы в виде объектного потока в целевой (на него 
указывает стрелка) конец этого потока. Объектный поток может нести только объектные сигналы; 
он не может нести сигналы управления. Есть правила, которые определяют, какие сигналы могут 
течь по объектному потоку, и какие типы узловых действий могут являться источником и 
адресатом потока. В случае законченных действий объектный поток может определять вес, 
который указывает минимальное число сигналов, которые должны следовать по объектному 
потоку в виде группы. 

Процедура создания объектного потока

Чтобы создать объектный поток, 

1. щёлкните [Toolbox] -> [Activity] -> [Object Flow] 
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2. щёлкните в позиции на диаграмме, куда следует поместить объектный поток. Будет 
высвечен горячий диалог объектного потока. 

3. В горячем диалоге, введите имя потока нажмите клавишу [Ввод]. 

 

Состояние приёма сигнала

Семантика

Приём сигнала изображается как вогнутый пятиугольник, который напоминает флаг. Сигнатура 
сигнала показывается внутри символа. Непомеченная стрелка перехода рисуется от предыдущего 
действия к пятиугольнику, а другая непомеченная стрелка - от пятиугольника к следующему 
действию. Штриховая линия со стрелкой может быть проведена от объекта до метки на 
пятиугольнике, чтобы показать отправителя сигнала; но это не является обязательным. 

Процедура создания состояния приёма сигнала

Чтобы создать Состояние приёма сигнала, 

1. щёлкните [Toolbox] -> [Activity] -> [Signal Accept State]. 
2. щёлкните в позиции на диаграмме, куда следует поместить состояние приёма сигнала. 
3. В горячем диалоге, введите имя состояние приёма сигнала и нажмите клавишу [Ввод]. 

 

Состояние передачи сигнала 

Посылка сигнала отображается как выпуклый пятиугольник, с выступом на любой стороне. 
Сигнатура сигнала показывается внутри символа. Непомеченная стрелка перехода рисуется от 
предыдущего действия к пятиугольнику, а другая непомеченная стрелка - от пятиугольника к 
следующему действию. Штриховая линия со стрелкой может быть проведена к объекту от метки 
на пятиугольнике, чтобы показать получателя сигнала; но это не является обязательным. 

Процедура создания состояния передачи сигнала 

Чтобы создать состояние передачи сигнала, 

1. щёлкните [Toolbox] -> [Activity] -> [Signal Send State] 
2. щёлкните в позиции на диаграмме, куда следует поместить состояние передачи сигнала. 
3. В горячем диалоге, введите имя состояние передачи сигнала и нажмите клавишу [Ввод]. 
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Область действия

Семантика

Действия и субдействия могут быть расположены внутри областей действия. Области действия 
используются, чтобы указать ответственность объектов за действия и субдействия. Они часто 
соответствуют организационным модулям бизнес-модели. 

Процедура создания горизонтальной области действия

Чтобы создать горизонтальную область действия, 

1. щёлкните [Toolbox] -> [Activity] -> [Horizontal Swimlane] 
2. Очертите границу, где нужно расположить горизонтальную область действия. 

  
3. Горизонтальная область действия будет создана на диаграмме. Введите имя области 

действия в горячем диалоге и нажмите клавишу [Ввод].

  

Процедура создания вертикальной области действия

Чтобы создать вертикальную область действия, 

1. Щёлкните [Toolbox] -> [Activity] -> [Vertical Swimlane] 
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2. Очертите границу, где нужно расположить вертикальную область действия. 

  
3. Вертикальная область действия будет создана на диаграмме. Введите имя области действия 

в горячем диалоге и нажмите клавишу [Ввод]. 

  

Использование диаграммы компонентов 
Следующие элементы доступны в диаграмме компонентов. 

• Пакет 
• Интерфейс 
• Компонент 
• Инстанция компонента 
• Артефакт 
• Порт 
• Часть 
• Ассоциация 
• Зависимость 
• Реализация 
• Связь 
• Соединитель 

Значительная часть элементов по своей семантике и процедурам создания аналогична 
соответствующим элементам диаграммы классов.
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Компонент

Семантика

Компонент представляет собой модульную, сборную и заменимую часть системы, которая 
исполняется и предлагает набор интерфейсов. 

Процедура создания компонента

Чтобы создать компонент, 

1. Щёлкните [Toolbox] -> [Component] -> [Component] 
2. Щёлкните в позиции диаграммы, куда следует поместить компонент. В горячем диалоге, 

введите имя компонента и нажмите клавишу [Ввод]. Результат будет следующим.

 

Процедура добавления резидентного элемента

Чтобы добавить резидента к компоненту, 

1. Выберите [Collection Editor...] в контекстном меню компонента.

  
2. Щелкните кнопку свойства [Резиденты] в окне свойств.
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3. На закладке [Residents] [редактора коллекции] Вы можете добавить резидентный элемент, 

используя кнопку .

  
4. В диалоге [Select a Resident] выберите резидентный компонент.
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5. Компонент, присвоенный другому компоненту как резидентный компонент, показывается 

следующим образом. 

 

Процедура создания отношения провайдера

Чтобы создать отношение провайдера 

1. Щёлкните [Toolbox] -> [Component] -> [Realization] 
2. Проведите линию на диаграмме от компонента к интерфейсу 
3. Результат будет следующим. 

 

Процедура создания отношения требования

Чтобы создать отношение требования, 
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1. Щёлкните [Toolbox] -> [Component] -> [Dependency] 
2. Проведите линию от компонента к интерфейсу в [главном окне]. 

 

Инстанция компонента 

Семантика

Инстанция компонента - экземпляр компонента, который постоянно находится на инстанции 
узла. Инстанция компонента может иметь состояние. 

Процедура создания инстанции компонента 

Чтобы создать инстанцию компонента, 

1. Щёлкните [Toolbox] -> [Component] -> [ComponentInstance] 
2. Щёлкните в позиции на диаграмме, куда следует поместить инстанцию компонента. 
3. Введите имя инстанции в горячем диалоге и нажмите клавишу [Ввод]. Результат будет 

следующим.

 

Процедура добавления атрибута к инстанции компонента

Есть два способа добавить AttributeLink к инстанции компонента. 

• использование элемента инстанции компонента на главной диаграмме или в [навигаторе 
модели] 

• использование [редактора коллекций] 

В случае использования элемента инстанции компонента, 

1. Выберите инстанцию на диаграмме или в [навигаторе модели].
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2. Щелкните правой кнопкой мыши выбранную инстанцию компонента, выберите[Add] -> 

[Attribute Link] в контекстном меню.

  
3. Вы добавили связь с атрибутом.

 

В другом случае, 

1. Выберите [Редактор коллекции ...] в контекстном меню инстанции компонента. 
2. Щелкните кнопку свойства slots в окне свойств.

  
3. На закладке [Slots] [редактора коллекции] Вы можете добавить связь атрибута, используя 

кнопку .
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Артефакт

Семантика

Артефакт представляет собой физическую единицу информации, которая используется или 
производится процессом. Примерами артефактов являются модели, исходные файлы, скрипты, и 
двоичные исполняемые файлы. Артефакт может представлять собой выполнимый компонент. 

Процедура создания артефакта

Чтобы создать артефакт, 

1. щёлкните [Toolbox] -> [Component] -> [Artifact] 
2. щёлкните в позиции на диаграмме, куда следует поместить артефакт. 
3. Артефакт будет создан на диаграмме. В горячем диалоге введите имя артефакта 
4. Нажмите клавишу [Ввод], чтобы закончить процедуру. 

 

Использование диаграммы развертывания 
Следующие элементы доступны в диаграмме развертывания. 

• Пакет 
• Узел 
• Инстанция узла 
• Артефакт 
• Порт 
• Часть 
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• Ассоциация 
• Направленная ассоциация 
• Зависимость 
• Связь 
• Соединитель 

Большая часть элементов по своей семантике и процедурам создания аналогична 
соответствующим элементам диаграммы классов и диаграммы компонентов.

Узел

Семантика:

Узел - физический объект времени выполнения, который представляет собой вычислительный 
ресурс, обычно имеющий память и другие обрабатывающие возможности, на котором могут быть 
развернуты компоненты. 

Процедура создания узла

Чтобы создать узел в диаграмме развертывания, 

1. Щёлкните [Toolbox] -> [Deployment] -> [Node]. 
2. Щёлкните в позиции на диаграмме, где нужно разместить узел. 
3. Узел будет создан. Введите имя узла в горячем диалоге. 
4. Нажмите клавишу [Ввод]. 

 

Процедура добавления развернутого компонента

Чтобы добавить развернутый компонент к узлу 

1. Выберите [Редактор коллекции ...] в контекстном меню узла.
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2. Или щелкните кнопку  свойства [DeployedComponents] в окне свойств.

  
3. На закладке [DeployedComponents] [редактора коллекции] Вы можете добавить развернутый 

компонент, используя кнопку .

  
4. В диалоге [Select the Component to deploy] выберите развертываемый компонент. Чтобы 

выбирать компонент, Вы должны его предварительно создать.
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5. Щелкните кнопку OK. Компонент будет добавлен к узлу. 
6. Узел изображается как показано ниже. 

 

Процедура добавления развертываемого артефакта

Чтобы добавить развертываемый артефакт к узлу, 

1. Выберите [Редактор коллекции ...] в контекстном меню узла.

  
2. Или щелкните кнопку свойства [DeployedArtifacts] в окне свойств.
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3. На закладке [Развернутые артефакты] [редактора коллекции] Вы можете добавить артефакт, 

используя кнопку .

  
4. В диалоге [Выбор артефакта] выберите артефакт и щелкните кнопку [OK].
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5. Артефакт будет добавлен к узлу, а узел будет выглядеть, как показано ниже 

 

Инстанция узла

Семантика

Инстанция узла - экземпляр узла. Коллекция инстанций компонентов может постоянно 
находиться на инстанции узла. 

Процедура создания инстанции узла

Чтобы создать инстанцию узла на диаграмме развертывания, 

1. Щёлкните [Toolbox] -> [Deployment] -> [NodeInstance] 
2. Щёлкните в позиции на диаграмме, куда следует поместить инстанцию узла. 
3. Введите имя инстанции узла в горячем диалоге и нажмите клавишу [Ввод]. 
4. Результат будет следующим. 

 

Процедура добавления атрибутной связи к инстанции узла

Есть два способа добавить атрибутную связь к инстанции узла. 

• используя элемент инстанции в [главное окне] или [навигаторе модели] 
• используя [редактор коллекции] 

В случае использования элемента инстанции узла 

1. Выберите инстанцию в [главном окне] или в [навигаторе модели], 
2. Щелкните правой кнопкой мыши выбранную инстанцию узла, выберите [Add] -> [Attribute 

Link] в контекстном меню. 
3. Узел не отображает атрибутные связи на своём визуальном образе. 

В другом случае 

1. Выберите [Редактор коллекции ...] в контекстном меню инстанции узла.
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2. Или щелкните кнопку  свойства [Slots] в окне свойств.

  
3. На закладке [Slots] [редактора коллекции] Вы можете добавить атрибутную связь, используя 

кнопку .

 

Использование композиционной структурной диаграммы 
Следующие элементы доступны в композитной структурной диаграмме. 
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• Класс 
• Интерфейс 
• Порт 
• Часть 
• Зависимость 
• Соединитель 
• Коллаборация 

Данный вид диаграммы является частным случаем диаграммы классов. Семантика и процедуры 
создания почти всех элементов данной диаграммы аналогичны последней. Специфика 
композиционной структурной диаграммы заключается в том, что на ней отображаются более 
мелкие детали структурных отношений в рамках композитов. 

Коллаборация

Семантика

Поведение, реализуемое совокупностями инстанций, которые обмениваются сообщениями в 
пределах области взаимодействия, чтобы выполнить некоторую задачу. Чтобы понять механизмы, 
используемые в модели, важно видеть только те инстанции и их взаимное сотрудничество, которое 
направлено на выполнение конкретной цели или связанного набора целей, выделенных из большей 
системы, частью которой они являются. Такую статическую конструкцию называют 
коллоборацией (сотрудничеством) 

Процедура создания коллаборации 

Чтобы создавать коллаборацию в композитной структурной диаграмме, 

1. Выберите пакет в [навигаторе модели], щелкните правой кнопкой мыши, и выберите [Add] 
-> [Collaboration] в контекстном меню.

  
2. Коллаборация будет создана в пакете и показана в [навигаторе модели]. Введите имя 

коллаборации.

  
3. Затем перетащите коллаборацию на диаграмму.
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4. Создание коллаборации завершено.
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Глава 6. Конфигурирование StarUML 
Эта глава подробно описывает опции конфигурирования StarUML T. 

• Общая конфигурация 
• Конфигурация диаграмм 
• Общая конфигурация визуальных образов 
• Специфическая конфигурация визуальных образов 

Общая конфигурация 
Общая конфигурация - группа основных опций программы. Эта категория включает 

подкатегории [General], [Browser] и [Collection Editor] . 

Опции [General] 

Опция Значение по 
умолчанию Описание

Max. number of 
undo actions  30 Определяет, максимальное число отмен и обратных 

восстановлений. Диапазон для максимума отмен - 1~100.

Recent project 
files  10

Определяет максимальное число проектных файлов, которые 
показываются в меню недавних проектов. Диапазон для числа 
недавних проектных файлов - 1~20.

Create backup 
files True  Определяет, создавать ли резервные копии при сохранении 

изменений.
Open the New 
Project dialog 
box at startup

True Определяет, открывать ли диалог New Project при старте 
программы. 

URL of Help 
Document См. описание

Определяет адрес страницы диалоговой помощи StarUML. 
Пользователь не должен переопределять этот параметр, он 
устанавливается изначально и может корректироваться 
программами типа исправлений и обновлений. Адрес по 
умолчанию http://staruml.tigris.org/documentations/doc.html. 

Опции [Browser] 

Show stereotypes True Определяет, показывать ли стереотип каждого элемента в 
навигаторе модели. 

Опции [Collection Editor] 

Show stereotypes True Определяет, показывать ли стереотип каждого элемента в редакторе 
коллекций. 

Show visibility 
with icons True Определяет, показывать ли видимость каждого элемента в редакторе 

коллекций. 
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Show names only False 
Определяет, показывать ли полное наименование или только имя каждого 
элемента в редакторе коллекций (например имя или полная сигнатура для 
операции). 

Конфигурация диаграмм 
Конфигурация диаграмм - группа общих опций, связанных с диаграммами. Эта категория 

включает подкатегории [Diagram Size], [Grid] и [Interaction Diagram] 

Опции [Diagram Size] 

Default 
diagram width 5000 

Определяет максимальную ширину диаграммы. Регулируйте это 
значение, если область диаграммы не является достаточно большой. 
Диапазон для ширины диаграммы - 100~50000. 

Default 
diagram 
height 

5000 

 

Определяет максимальную высоту диаграммы. Регулируйте это значение, 
если область диаграммы не является достаточно большой. Диапазон для 
высоты диаграммы - 1~5000. 

Опции [Grid]

Grid width 4 Определяет ширину сетки, используемой для того, чтобы 
редактировать диаграмму. Диапазон для ширины сетки - 1~20. 

Grid height 4 Определяет высоту сетки, используемой для того, чтобы 
редактировать диаграммы. Диапазон для высоты сетки - 1~20. 

Show grid True Определяет, показывать ли сетку в диаграммах. 

Опции [Interaction Diagram] 

Message 
signature Hide 

Определяет, как сообщения/импульсы будут обозначены в диаграммах 
сообщений и коллаборации (скрываться, показ только типа, показ только 
имени, показ имени и типа). 

Show sequence 
number True Определяет, показывать ли порядковый номер сообщения/импульса в 

диаграммах коллаборации и сообщений. 
Show 
Activation True Определяет, показывать ли активность сообщений/импульсов в 

диаграммах сообщений. 

Общая конфигурация образов (представлений) 
Общая конфигурация образов - группа основных опций, связанных с визуальным 

представлением модельных элементов. Эта категория включает подкатегории [Default View Style] и 
[Default View Format] . 

Опции [Default View Style]

Default fill 
color $00B9FFFF Определяет цвет заливки по умолчанию для визуальных образов 

элементов (по умолчанию, светло-жёлтый). 
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Default line 
color $00000080 Определяет цвет линии по умолчанию для визуальных образов 

элементов (по умолчанию - тёмно-коричневый). 
Default font 
name Tahoma Определяет заданное по умолчанию имя шрифта для визуальных 

образов элементов.

Default font 
size 8

Определяет заданный по умолчанию размер шрифта для визуальных 
образов элементов. Диапазон для заданного по умолчанию размера 
шрифта - 1~50. 

Default font 
color $00000000 Определяет заданный по умолчанию цвет шрифта для визуальных 

образов элементов (значение по умолчанию - чёрный). 

Опции [Default View Format] 

Line style Rectilinear Определяет стиль линии для элементов связи (rectilinear или 
oblique). 

Show stereotype text Определяет заданный по умолчанию метод индикации стереотипа 
(текст, изображение или скрытие).

Show parent 
name False 

Определяет, показывать ли имя родительского элемента, который 
содержит модельный элемент, представленный визуальным 
образом.

Automatic resize False Определяет, изменять ли автоматически размеры визуальных 
образов элементов. 

Show 
compartment 
visibility

True Определяет, показывать ли видимость для суб-элементов 
визуальных образов (например, атрибутов операций и т.д.).

Show 
compartment 
stereotype 

True Определяет, показывать ли стереотип для суб-элементов 
визуальных образов (например, атрибутов операций и т.д).

Show operation 
signature True Определяет, показывать ли сигнатуры операций. 

Show property False Определяет, показывать ли свойства элементов (например, теговые 
значения и т.д.) в визуальных образах.

Suppress attribute False Определяет, подавлять ли отображение атрибутов в визуальных 
образах классов. 

Suppress 
operation False Определяет, подавлять ли отображение операций в визуальных 

образах классов.

Специфическая конфигурация образов 
Специфическая конфигурация образов - группа опций, связанных со специфическими 

представлениями. Эта категория включает подкатегории [UseCase View], [Actor View], 
[Enumeration View], [Interface View], [Artifact View], [Component View / Component Instance View] и 
[Node View / Node Instance View]. 

Опции [UseCase View] 

Show stereotype Text Определяет заданный по умолчанию метод индикации стереотипа в 
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визуальных образах прецедентов (текст, иконка, скрыт, декорация).
Suppress 
attribute True Определяет, подавлять ли отображение атрибутов в визуальных 

образах прецедентов.
Suppress 
operation True Определяет, подавлять ли отображение операций в визуальных 

образах прецедентов.

 Опции [Actor View] 

Show stereotype Text Определяет заданный по умолчанию метод индикации стереотипа в 
визуальных образах акторов (текст, иконка, скрыт, декорация).

Suppress 
attribute True Определяет, подавлять ли отображение атрибутов в визуальных 

образах акторов.
Suppress 
operation True Определяет, подавлять ли отображение операций в визуальных 

образах акторов. 

Опции [Enumeration View] 

Suppress literal False Определяет, подавлять ли отображение констант в визуальных 
образах перечислимых типов.

Опции [Interface View] 

Show stereotype Icon Определяет заданный по умолчанию метод индикации стереотипа в 
визуальных образах интерфейсов (текст, иконка, скрыт, декорация). 

Suppress 
attribute True Определяет, подавлять ли отображение атрибутов в визуальных 

образах интерфейсов.
Suppress 
operation True Определяет, подавлять ли отображение операций в визуальных 

образах интерфейсов. 

Опции [Artifact View] 

Show stereotype Decoration Определяет заданный по умолчанию метод индикации стереотипа в 
визуальных образах артефактов (текст, иконка, скрыт, декорация)

Suppress 
attribute True Определяет, подавлять ли отображение атрибутов в визуальных 

образах артефактов.
Suppress 
operation True Определяет, подавлять ли отображение операций в визуальных 

образах артефактов.

Опции [Component View / ComponentInstance View]

Show 
stereotype Text

Определяет заданный по умолчанию метод индикации стереотипа в 
визуальных образах компонентов и их инстанций (текст, иконка, скрыт, 
декорация)

 Опции [Node View / NodeInstance View] 
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Show stereotype Text 
Определяет заданный по умолчанию метод индикации стереотипа в 
визуальных образах узлов и их инстанций (текст, иконка, скрыт, 
декорация)
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Глава 7. Управление модулями 
Эта глава объясняет, как управлять модулями. Обсуждаются установка модуля, компоновка 

модуля и удаление модуля. 

Установка Модуля 
Способ установки модуля в StarUML ™ очень прост. Пользователь копирует каталог модуля, 

который он хочет установить, в подкаталог модулей StarUML™. StarUML ™ его найдёт и 
выполнит. 

1. Загрузите модуль для установки с сайта StarUML (www.staruml.com). 
2. Скопируйте файл модуля в каталог {StarUML} \modules. Если модуль помещён в архивный 

файл, разархивируйте его в папку с тем же именем, что и имя архива. Если каталог, где 
установлен StarUML, - “C:\Program Files\StarUML”, создайте подкаталог модуля в папке 
C:\Program Files\StarUML\modules. 

  
3. Если StarUML выполнялся, перезапустите его. 
4. Журнал установки модуля будет показан в окне Output, если модуль был установлен 

корректно.

 

 

Журнал загрузки модуля 

Журнал загрузки модуля отображается в окне Output как показано выше. Для получения 
подробной информации см. радел "Основные концепции" во второй главе. 
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Компонент Состояние Сообщение

Профили (.ptf)

Успешное открытие файла 
профиля The Profile "..." is loaded successfully.

Невозможно загрузить файл 
профиля Failed to load the Profile "...".

Подходы (.apr)
Успешное открытие файла подхода The Approach "..." is loaded successfully.
Невозможно загрузить файл 
подхода Failed to load the Approach "...".

Фреймворк (.frw)

Успешное открытие файла 
фреймворка The Framework "..." is loaded successfully.

Невозможно загрузить файл 
фреймворка Failed to load the Framework "...".

Аддин (.aid)

Аддин зарегистрирован успешно AddIn "... AddIn" is registered successfully.
Библиотеки аддина 
зарегистрированы успешно

AddIn sub module "....dll" is registered 
successfully.

Аддин успешно загружен Add-In "..." is loaded successfully.
Невозможно загрузить файл 
аддина Failed to load the Add-In "...".

Меню (.mnu) Файл меню  успешно загружен Add-In "... AddIn" menu is registered 
successfully.

 Невозможно загрузить файл меню Failed to load the menu "...".

Деинсталляция модуля 

Деинсталляция модуля, содержащего аддин 

В случае, когда модуль содержит аддин, в каталоге модуля находится вспомогательный файл 
.aid, который хранит данные об аддине. Этот файл определяет метод деинсталляции. Для 
Основного Модуля (Core Module) StarUML существует специальный файл unreg.bat, 
расположенный в подкаталоге модуля, предназначенный для удаления установленного аддина. 
Пользователь может удалить установленный аддин, выполнив unreg.bat. 

1. Перейдите на деинсталлируемый модуль 

  
2. Выполните unreg.bat в подкаталоге модуля
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3. Удалите подкаталог модуля. 

Деинсталляция модуля, не содержащего аддина 

В случае модуля, не содержащего аддина, для его деинсталляции достаточно удалить подкаталог 
этого модуля. 
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Глава 8. Генерация кодов и документов
Эта глава описывает основные концепции генерации программного кода и документации, а 

также использования пакетной обработки. 

• Основная концепция 
• Генерация с помощью шаблонов 
• Использование пакетов 
• Инсталляция и деинсталляция шаблонов 

Если Вы хотите научиться создавать собственные шаблоны кодов или документов, пожалуйста 
обращайтесь к "Руководству разработчика". 

Основные концепции

Что такое генератор?

Генератор StarUML - модуль, предназначенный для генерации различных артефактов (типа 
документов Microsoft Word, Excel, PowerPoint и других тексто-ориентированных систем) на основе 
шаблонов, зависящих от модельных UML-элементов. Пользователь может создавать собственные 
шаблоны или применять различные виды готовых шаблонов для одной и той же модели UML, 
чтобы легко и в быстро автоматически получать различные артефакты. 

Основные особенности

Генератор StarUML предоставляет следующие возможности. 

• Шаблон, создаваемый пользователем
Шаблон может быть задан пользователем. Вы можете писать шаблоны под .doc .xls .ppt 
непосредственно используя MS Word, MS Excel, MS PowerPoint без дополнительных 
средств проектирования шаблонов. 

• Параметры для шаблонов
В шаблонах можно использовать параметры для настройки операционной среды, целевых 
объектов и т.п. С помощью параметрических шаблонов, Вы можете устранять 
несоответствия и избегать необходимости создавать новый шаблон, из-за наличия 
небольших различий. 

• Пакетная обработка, для одновременной генерации нескольких артефактов
Используя пакетную обработку, Вы можете генерировать несколько артефактов сразу. Вы 
можете зарегистрировать несколько шаблонов как пакет и выполнить его целиком. С 
помощью пакетов большое количество документов может быть сгенерировано 
автоматически без необходимости присутствия при этом. 

• Поддержка стилей MS Word и колонтитулов
Вы можете помещать команды генерации в колонтитулы шаблона MS Word, а также 
использовать стили MS Word в шаблоне. 

• Поддержка таблиц MS Excel
Вы можете извлекать различные данные из UML-моделей и помещать их в ячейки таблиц 
Excel. Таким образом, Вы сможете использовать средства графики, фильтрации, сортировки 
и другие функции Excel. 

• Поддержка слайдов MS PowerPoint
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Возможна генерация слайдов иерархической структуры в MS PowerPoint. При этом нет 
никаких ограничений по типам слайдов, так что Вы можете создавать их без каких либо 
усилий. 

• Поддержка любых текстовых документов
Вы можете генерировать любые текстовые документы, подобные документам XML, HTML, 
исходным текстам программ (Java, C#, C++...), DB Schema и так далее. 

Генерация по шаблону

Генерация артефактов

Чтобы сгенерировать артефакт по шаблону, шаблон должен быть применим к текущей 
обрабатываемой UML-модели. 

• Выберите меню [Tools]->[StarUML Generator...]

  
• На странице [Select templates for generation], укажите нужные шаблоны генерации в списке 

и щёлкните кнопку [Next].
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• Чтобы связать параметры со значениями, нажмите кнопку необходимого элемента шаблона 

в списке  и установите значение параметра, как Вам необходимо. (См. раздел Регистрация 
шаблона для получения дополнительной информации о параметрах шаблона).
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• На странице [Select target path], выберите папку, в которую будет помещен артефакт и 

щелкните кнопку [Next].
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Если Вы хотите создать новую папку, нажмите кнопку [New Folder...] и введите имя новой 
папки.

  
• На странице [Generating...], нажмите кнопку [Generate]. Вы можете контролировать ход 

генерации и содержимое журнала генерации. Если Вы хотите остановить процесс 
генерации, нажмите кнопку [Cancel]. Когда все артефакты будут успешно сгенерированы, 
кнопка [Finish] станет доступной и щелчком по ней можно закончить генерацию артефакта. 
Чтобы просмотреть сгенерированный артефакт, дважды щелкните соответствующий 
элемент в списке[Generation List], и сгенерированный артефакт будет открыт.
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Регистрация шаблона

Ваши собственные шаблоны также могут быть зарегистрированы в генераторе StarUML. 

1. На странице [Select templates for generation] нажмите кнопку [Register Template]. 
2. В диалоге [Register Template] нажмите кнопку  и укажите папку, в которую будут 

помещены файлы шаблона.
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3. Введите информацию о шаблоне в [Properties:] и щелкните кнопку [OK], чтобы завершить 

регистрацию шаблона. 

Секция свойств [Basic]

Основные свойства регистрируемого шаблона следующие. 

• Template Name
Имя регистрируемого шаблона. 

• Group
Имя группы шаблона. Нет никаких ограничений на названия группы шаблона, чтобы 
включить шаблон в группу, укажите её имя в качестве имени группы шаблона (имя группы 
используется для горизонтальной классификации шаблонов, например RUP, CBD, , ...) 

• Category
Имя категории шаблона. Нет никаких ограничений на названия категории шаблона, чтобы 
категоризировать шаблон, дайте его категории имя той категории, в которую нужно его 
включить (категории используются для вертикальной классификации, например 
Требования, Дизайн, Код, Анализ...) 

• Description
Краткое описание шаблона. 

Секция свойства [Detail]

Специальные свойства регистрируемого шаблона следующие. 

• Document Type
Тип шаблона. Выберите DOCUMENT или CODE. 



StarUNL. Руководство пользователя. Глава 8. Генерация кодов и документов 153 / 207

• Format
Тип генерируемого артефакта. Введите название формата или выберите один из уже 
определенных форматов (TXT, DOC, PPT, XLS) 

• Version
Версия шаблона (например) 1.0 

• Related Profile
Профили, связанные с шаблоном. 

• Related Approach
Подход, связанный с шаблоном. (это декларативное свойство, оно не имеет эффекта) 

• Translator Type
Вид транслятора для шаблона. Выберите одно из следующих значений: WORD, EXCEL, 
POWERPOINT, TEXT, COM (задаваемый пользователем генератор на базе COM-объекта), 
SCRIPT (определяемые пользователем скрипты на JScript, VBScript...), EXE (определяемый 
пользователем генератор на базе .EXE-файла). 

• Translator
Укажите здесь имя файла транслятора, определяемого пользователем. Оно используется 
только тогда, когда пользователь хочет использовать собственный транслятор вместо одного 
из встроенных (WORD, EXCEL, POWERPOINT, TEXT) 

• Example
Здесь Вы можете определить модель примера для шаблона. 

• Parameters
Параметры, требуемые для шаблона. 

• Related files
Здесь Вы можете определить все файлы, связанные с шаблоном. 

Свойство [Parameters]

1. Нажмите кнопку  на свойстве Parameters.

 

2. В диалоге [Parameters] нажмите кнопку  чтобы создать новый параметр, а кнопку , чтобы 
удалить существующий параметр.

  
3. В диалоге [New Parameter], определите Имя, Тип и Значение по умолчанию для параметра и 

щелкните кнопку [OK]. 
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Заданные по умолчанию параметры различны в зависимости от типа транслятора. Ниже 
описаны заданные по умолчанию параметры для каждого типа транслятора. 

  
 Свойство  Тип  Тип транслятора  Описание

TemplateFile FILENAME 
или STRING

WORD,EXCEL,PO
WERPOINT

Определите имя файла шаблона 
документа

OutputFile FILENAME 
или STRING

WORD,EXCEL,PO
WERPOINT,TEXT

Определите имя файла 
сгенерированного артефакта. 

Keep Comment BOOLEAN WORD,EXCEL,PO
WERPOINT

Определите комментарий, 
используемый при генерации или 
удалите этот параметр.

ShowGenerationProces
s BOOLEAN WORD,EXCEL,PO

WERPOINT

Определите, нужно ли пока зазывать 
прогресс-бар в процессе генерации или 
нет. Это может замедлить выполнение 
генерации.

Normal Generation BOOLEAN WORD 

Если истина, шаблон применяется к 
пакету верхнего уровня (проект). Если 
ложь, шаблон применяется к текущему 
выбранному пакету (или элементу). 

Generate Index BOOLEAN WORD Определите, нужно ли генерировать 
индекс или нет.

Intermediate STRING TEXT Определите имя промежуточного 
файла, используемого при генерации.

Target STRING TEXT 
Если генерируется более двух 
артефактов, определите путь, куда 
артифакты будут помещены.

Обратите внимание: 

Чтобы определить имя файла в параметрах, можно использовать переменные окружения. 

• $PATH$
Путь, где находятся файлы шаблона (например). $PATH$\BusinessActorReport.doc 

• $GROUP$
Имя группы шаблона. 

• $CATEGORY$
Имя категории шаблона. 

• $NAME$
Имя шаблона. 



StarUNL. Руководство пользователя. Глава 8. Генерация кодов и документов 155 / 207

• $TARGET$
Путь вывода, который выбрал пользователь. 

Клонирование шаблона

Вы можете начать создание шаблона, скопировав существующий шаблон. 

1. В диалоге [Select templates for generation] выберите шаблон для копирования и нажмите 
кнопку [Clone Template] или щёлкните правой кнопкой мыши на шаблоне, который хотите 
клонировать, а затем нажмите пункт [Clone Template] в контекстном меню. 

2. Определите имя клонируемого шаблона щелкните [OK].

  
3. Вы можете найти клонируемый шаблон в списке [List of templates]. Вы можете указать 

дополнительную информацию о клонируемом шаблоне (щелкните кнопку [Template 
Properties]). 

Свойства шаблона

Вы можете редактировать свойства зарегистрированного шаблона. 

1. В диалоге [Select templates for generation] выберите шаблон, свойства которого хотите 
редактировать, и щелкните [Template properties], или щёлкните правой кнопкой мыши на 
нужном шаблоне, а затем нажмите пункт [Show Template Properties] в контекстном меню. 

2. Отредактируйте свойства в диалоге [Modify Template] и щелкните [OK]. (Пожалуйста 
ознакомьтесь с разделом Регистрация шаблона>Основные/Дополнительные параметры для 
получения детальной информации о каждом свойстве) 

Открытие шаблона

Вы можете открыть и редактировать зарегистрированный шаблон. 

1. В диалоге [Select templates for generation] выберите шаблон, который хотите открыть и 
нажмите кнопку [Open Template] или выберите [Open Template] в контекстном меню 
шаблона. 

2. Затем будет запущено заданное по умолчанию приложение, связанное с типом файла (.cot, 
doc, xls, ppt), и Вы сможете отредактировать шаблон в этом приложении. (Пожалуйста 
ознакомьтесь с разделом Руководство Разработчика StarUML 5.0 Глава 11. Написание 
шаблона, для того, чтобы научиться писать шаблоны) 
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Удаление шаблона

В диалоге [Select templates for generation] выберите шаблон, который хотите удалить, вызовите 
контекстное меню и выберите [Delete Template]. 

• Удаление шаблона вызывает удаление папки шаблона и всех файлов, находящихся в ней, 
так что будте внимательны. 

Использование пакетов
На вкладке [List of templates] перечислены зарегистрированные шаблоны. Если Вы хотите 

генерировать несколько артефактов сразу, Вы можете создать пакет, который будет это делать, и 
избавит Вас от выполнения каждого шаблона отдельно. 

Создание нового пакета

Создайте новый пакет, содержащий выбранные шаблоны. 

1. На странице [Select templates for generation] отметьте шаблоны, которые нужно включить в 
пакет, на вкладке [List of templates] и щелкните кнопку [Register to Batch]. 

2. В диалоге [Register to Batch] укажите имя пакета и описание и щелкните [OK].

  
3. Вы можете найти новый пакет на вкладке, а выбранные шаблоны будут отображены в 

списке шаблонов этого пакета. 

Добавление шаблонов в существующий пакет

Вы можете добавить шаблоны в существующий пакет. 

На странице [Select templates for generation] в списке [List of templates] отметьте шаблоны, 
которые нужно добавить в существующий пакет, и нажмите кнопку [Add to Batch]. 

В диалоге [Select Batch] выберите пакет и нажмите [OK]. 
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Выполнение пакета

Вы можете генерировать артефактов сразу, используя пакет. 

1. На странице [Select templates for generation] выберите пакет для выполнения. 
2. Отметьте шаблоны, которые хотите выполнить, и нажмите кнопку [Next]. (По умолчанию, 

все отмечены все шаблоны в пакете.) 
3. Вы можете генерировать артефакты в пакете, используя различные значения свойств. Если 

Вы хотите сделать именно так, нажмите кнопку   каждого шаблона и установите значение 
каждого свойства. Изменение свойств применяется только однажды. (Пожалуйста 
ознакомьтесь с разделом "Регистрация шаблона" для получения дополнительной 
информации о свойствах шаблонов)
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4. Когда страница [Select target path] появится на экране, выберите папку, в которой будет 

сохранен сгенерированный документ и нажмите [Next]. Если Вы хотите создать папку в 
выбранной папке, нажмите [New Folder…] слева внизу и укажите имя новой папки в 
диалоге определения имени 

5. Когда на экране появится страница [Generating…], нажмите кнопку [Generate]. Вы можете 
контролировать генерацию по каждому шаблону в области статуса генерации документа. В 
окне [Logs:] отображается журнал генерации. Если Вы хотите остановить генерацию 
документа, нажмите кнопку [Cancel] и щёлкните OK для подтверждения отмены. 

6. После завершения генерации документа активируется кнопка [Finish]. Если Вы хотите 
закончить генерацию документа, завершите процесс генерации нажатием кнопки [Finish]. 
Либо Вы можете проверить сгенерированный документ, дважды щёлкнув этот документ в 
списке [Generation List]. 

Удаление шаблонов из пакета

Вы можете удалить шаблон из пакета. (Удаление именно из пакета: шаблон не удаляется на 
самом деле, а только исключается из него) 

1. На странице [Select templates for generation] перейдите на закладку пакета и отметьте 
шаблоны, которые хотите удалить, а затем нажмите [Delete Item]. 

2. Вы можете делать выборочное удаление отмеченных шаблонов. 
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Создание пустого пакета

Вы можете создать пакет, не содержащий ни одного шаблона. 

1. На странице [Select templates for generation] щёлкните правой кнопкой мыши на любой 
вкладке и выберите пункт [New Batch]. 

2. В диалоге [Register Batch] укажите [Batch Name], [Description] и нажмите [OK]. 
3. На странице [Select templates for generation] вы увидите вкладку пустого пакета. 

Изменение пакета

Вы можете изменить информацию о пакете. 

1. На странице [Select templates for generation] выберите нужную вкладку, вызовите 
контекстное меню правым кликом и выберите [Modify Batch]. 

2. В диалоге [Register Batch] измените [Batch Name], [Description] и нажмите [OK]. 

Удаление пакета

Вы можете удалить пакет. 

1. На странице [Select templates for generation] выберите вкладку для удаления вызовите 
контекстное меню и нажмите [Delete Batch]. 

2. Вы увидите, что закладка пакета удалена (Удаление пакета не вызывает удаления шаблонов, 
содержавшихся в нём) 

Инсталляция и деинсталляция шаблонов

Организация шаблонов

Шаблоны устанавливаются в папке "...\modules\staruml-generator\templates", а пакеты находятся в 
папке "...\modules\staruml-generator\batches". В общем случае, один шаблон соответствует одной 
папке, а папка содержит все файлы, связанные с шаблоном. Шаблон включает не менее двух 
файлов. Первый - файл описания шаблона (.tdf), второй - документ шаблона (.cot, .doc, .xls, .ppt...). 
Пакет включает один файл, который является пакетным файлом (.btf). 

Структура каталога модуля staruml-генератора следующая. 

staruml-generator\
  templates\ 
       template1\ 
          template1.tdf 
          template1.doc 
  template2\ 
       ... 
  batches\ 
       batch1.btf 
       ... 
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Инсталляция и деинсталляция шаблона

Инсталляция шаблона очень проста. Просто скопируйте папку шаблона в "...\modules\staruml-
generator\templates". 

Деинсталляция шаблона также очень проста. Удалите папку шаблона из "...\modules\staruml-
generator\templates". Это - все. 

Инсталляция и деинсталляция пакета

Инсталляция пакета очень проста. Просто скопируйте пакетный файл (.btf) в 
"...\modules\staruml-generator\batches". 

Чтобы деинсталлировать пакет, удалите пакетный файл (.btf) из "...\modules\staruml-
generator\batches". 
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Глава 9. Проверка модели 
Эта глава описывает программную проверку корректности модели: метод проверки и правила, 

используемые при контроле. 

• Проверка модели 
• Правила контроля 

Проверка модели 
Пользователи могут допустить много ошибок в процессе моделирования программного 

обеспечения. Такие ошибки могут очень дорого обойтись, если их не исправить до 
заключительной стадии генерации кода. Чтобы предотвратить эту проблему, StarUML ™ позволяет 
осуществить проверку модели программного обеспечения, на основе применения основных 
инструкции UML. 

Процедура проверки модели: 

1. Выберите в меню [Model] -> [Verify Model…]. 
2. В диалоге Verify Model, щёлкните кнопку [Verify].

  
3. Когда проверка закончится, в секции [Сообщения] будут показаны имена элементов, 

которые не прошли проверку, а также тексты ошибок. 
4. Дважды щелкните сообщение, чтобы перейти на интересующий элемент. 

Правила контроля 
Тридцать восемь инструкций определены для того, чтобы проверять корректность модели. Эти 

определения - главным образом адаптация инструкций спецификации UML. 

Список правил проверки
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No Содержание правила Модельный 
элемент

1
Концы ассоциации в пределах Ассоциации должны иметь уникальные 
имена. 
AssociationEnds within an Association must have unique names.

Association

2

Два или более агрегатных или композитных конца ассоциаций не могут 
существовать в пределах одной ассоциации.
Two or more Aggregations or Composite AssociationEnds cannot exist within 
an Association.

Association

3 Параметры должны иметь уникальные имена.
Parameters must have unique names. BehavioralFeature

4
Атрибут с тем же самым именем не может существовать в пределах 
классификатора.
Attributes of the same name cannot exist within a Classifier.

Classifier

5
Концы ассоциаций противоположной стороны должны иметь 
уникальные имена.
AssociationEnds on the other side must have unique names.

Classifier

6

Атрибут не может иметь то же имя, что и ассоциация  на 
противоположной стороне или другой элемент, включенный в 
классификатор. 
An Attribute cannot have the same name as the Association on the other side, 
or as elements included in Classifier.

Classifier

7

Конец ассоциации противоположной стороны не может иметь то же 
самое имя, что и элемент, включенный в классификатор, или атрибут.
AssociationEnd on the other side cannot have the same name as elements 
included in Classifier or its Attribute name.

Classifier

8
Корневой элемент иерархии не может содержать элементы, которые 
более обобщены, чем он сам.
Root element cannot have elements that are more generalized than itself.

GeneralizableElement

9
Крайний элемент иерархии не может содержать элементы, которые более 
специализированы чем он сам.
Leaf element cannot have elements that are more specialized than itself.

GeneralizableElement

10 Циклические структуры наследования не допускаются.
Looped inheritance structure is not allowed. GeneralizableElement

11 Все элементы интерфейсов должны иметь общедоступную видимость.
All features of interfaces must be public. Interface

12
Инстанция компонента должна быть назначена компоненту, от которого 
она происходит. 
ComponentInstance must accurately assign a component as its origin.

ComponentInstance

13
Инстанций узла должна быть назначена узлу, от которого она 
происходит.
NodeInstance must accurately assign a node as its origin.

NodeInstance

14
Роли концов ассоциаций должны быть связаны с ролями 
классификаторов.
AssociationEndRole must be connected with ClassifierRole.

AssociationEndRole

15 Роль классификатора не может иметь собственных составных частей.
ClassifierRole cannot have its own features. ClassifierRole

16
Роль классификатора не может стать ролью классификатора для другой 
роли классификатора.
ClassifierRole cannot become the ClassifierRole for another ClassifierRole.

ClassifierRole
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No Содержание правила Модельный 
элемент

17

Отправитель и приемник сообщения должны участвовать в 
коллаборации, которая составляет контекст взаимодействия. 
Sender and receiver of a message must participate in the collaboration that 
constitutes the interaction context.

Message

18

Акторы могут иметь ассоциации которые, связаны только с 
прецедентами, классами или подсистемами. 
Actor can only have associations that are connected to UseCase, Class or 
Subsystem.

Actor

19 Композитное состояние может иметь только одно начальное состояние.
CompositeState can have a maximum of one initial state only. CompositeState

20 Композитное состояние может иметь только одну глубокую хронологию.
CompositeState can have a maximum of one deep history only. CompositeState

21
Композитное состояние может иметь максимум только одну 
поверхностную хронологию.
CompositeState can have a maximum of one shallow history only.

CompositeState

22
Конкурентное (параллельное) композитное состояние должно содержать 
минимум два композитных состояния. 
Concurrent composite state must contain a minimum of two composite states.

CompositeState

23
Конкурентное состояние может иметь композитное состояние только как 
суб-состояние.
Concurrent state can only have composite state as its sub state.

CompositeState

24 Заключительное состояние не может иметь исходящего перехода.
Final state cannot have outgoing transition. FinalState

25

Начальное состояние может иметь максимум один исходящий переход и 
не может иметь входящего перехода.
Initial state can have a maximum of one outgoing transition and cannot have 
incoming transition.

Псевдосостояние

26 Состояние хронологии может иметь максимум один исходящий переход.
History state can have a maximum of one outgoing transition. Псевдосостояние

27

Вершина соединения должна иметь минимум один входящий переход и 
один исходящий переход.
Junction vertex must have a minimum of one incoming transition and one 
outgoing transition each.

Псевдосостояние

28

Вершина выбора должна иметь минимум один входящий переход и один 
исходящий переход.
Choice vertex must have a minimum of one incoming transition and one 
outgoing transition each.

Псевдосостояние

29

Моделей состояний может быть интегрирована в классификатор или 
поведенческую сущность. 
StateMachine can be integrated either with Classifier or with 
BehavioralFeature.

StateMachine

30 Главное состояние должно всегда быть композитным состоянием.
Top state must always be composite state. StateMachine

31 Никакое состояние не может содержать главное состояние.
No state can contain top state. StateMachine

32 Главное состояния не может иметь исходящего перехода.
Top state cannot have outgoing transition. StateMachine
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No Содержание правила Модельный 
элемент

33 Субмодели состояний не могут иметь параллелизма.
SubmachineState cannot have concurrency. SubmachineState

34
Переходы, которые ведут к псевдосостоянию, не могут иметь 
переключения. 
Transition that points to Псевдосостояние cannot have Trigger.

Transition

35

Диаграмма действий может выражать динамическое поведение пакета, 
классификатора или иной поведенческой сущности.
ActivityGraph can express dynamic behavior of Package, Classifier or 
BehavioralFeature.

ActivityGraph

36
Действие не может иметь внутреннего перехода, действия выхода или 
иного активного действия.
ActionState cannot have internal transition, exit action or do activity.

ActionState

37
Исходящие переходы действия не могут иметь переключающего 
события.
Outgoing transition of ActionState cannot have trigger event.

ActionState

38 Субдейсвтвия должны иметь связь с диаграммой действий.
SubactivityState must have connection to ActivityGraph. SubactivityState
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Глава 10. Печать 
Эта глава описывает аспекты, связанные с печатью диаграмм: установка страницы, различные 

методы печати диаграмм и предварительный просмотр результата печати. 

• Параметры станицы 
• Печать диаграммы 
• Предварительный просмотр печати 

Параметры станицы 
Различные свойства (информация о диаграмме, отступы страницы, окаймления, и т.д.) могут 

быть сконфигурированы для печати страницы. 

Процедура просмотра информации о диаграмме: 

1. Выберите в меню [File] -> [Page Setup…] , чтобы открыть диалоговое окно Page Setup . 

  
2. Сначала, выберите, где будет напечатана информация о диаграмме. В группе [Options], 

выберите [None], если эта информация не должна быть напечатана. Выберите [Header], 
чтобы напечатать информацию о диаграмме наверху страницы, либо [Footer], чтобы 
напечатать её внизу страницы. 

3. Выберите, какая информация будет напечатана. Типы информации, доступной для печати 
включают: [Diagram name], [Project name], [Page number], [Diagram type] и [Date/Time] 

Процедура установки ориентации страницы: 

1. Выберите в меню [File] -> [Page Setup…], чтобы открыть диалоговое окно Page Setup. 
2. В группе [Page orientation] выберите [Portrait] для вертикальной ориентации, или 

[Landscape] для горизонтальной. 
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Процедура установки отступов страницы: 

1. Выберите в меню [File] -> [Page Setup…] чтобы открыть диалог Page Setup. 
2. В группе [Margins] введите размеры отстуов в миллиметрах в поля [Top], [Bottom], [Left], и 

[Right]. 

Процедура печати окаймлений страницы: 

1. Выберите меню [File] -> [Page Setup…], чтобы открыть диалог Page Setup. 
2. В группе [Border] укажите стороны для окаймления, выбрав флажки [Top], [Bottom], [Left], 

и [Right]. 
3. Введите толщину границы в поле [Thickness]. 

Печать диаграммы 
Диаграммы могут быть напечатаны различными способами. Эта секция описывает функции 

выбора диаграммы для печати, определение размера области печати диаграммы, печати диаграммы 
на нескольких страницах, и т.д. 

Процедура печати текущей диаграммы: 

1. Выберите меню [File] -> [Print…] чтобы открыть диалог Print. 
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2. В группе [Printer] введите имя принтера в поле [Name]. 
3. В группе [Print range] выберите [Current diagram] и нажмите кнопку [Print]. 

Процедура печати только выбранной диаграммы: 

1. Выберите меню [File] -> [Print…] чтобы открыть диалог [Print]. 
2. В группе [Printer], введите имя принтера, используя поле [Name]. 
3. В группе [Print range], выберите [Selected diagram(s)] и отметьте диаграммы, которые нужно 

напечатать. 
4. Щелкните кнопку [Print]. 

Процедура печати диаграммы в размер страницы: 

1. Выберите диаграмму(ы) для печати в диалоговом окне Print. 
2. В группе [Size], выберите [Fit to page] и щелкните кнопку [Print]. 

Процедура печати диаграммы на нескольких страницах: 

1. Выберите диаграмму(ы) для печати в диалоговом окне Print. 
2. В группе [Size], выберите [Tile]. Затем, введите целые числа в поля [page(s) wide] и [page(s) 

tall], чтобы определить, сколько страниц будет использоваться (например выбор 3 страницы 
в ширину и 2 страницы в высоту вызовет печать 6 страниц, 3*2=6 страниц). 

3. Щелкните кнопку [Print]. 

Предварительный просмотр 
Результат печати может быть предварительно просмотрен прежде, чем фактически напечатан на 

бумаге. 

Процедура предварительного просмотра результатов печати: 

1. Выберите меню [File] -> [Print…] чтобы открыть диалог Print и ввести информацию о 
диаграмме (см. раздел “Печать диаграммы”). 

2. Нажмите кнопку [Preview…] в нижней части диалогового окна Print. 
3. В диалоговом окне Print Preview, просмотрите результат печати, выбрав режим отображения 

одной или двух страниц. 
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4. Щелкните кнопку [Print], чтобы напечатать это окно, или щелкните кнопку [Close], чтобы 

просто закрыть окно предварительного просмотра. 
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Глава 11. Справочник по интерфейсу 
пользователя 

Эта секция подробно описывает все окна StarUML ™. 

• Главное окно 
• Меню 
• Инструментальные панели 
• Окно 
• Диалоговое окно 
• Горячий диалог 

Главное окно 
Главное окно StarUML ™ состоит из следующих компонентов.
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Главное меню 

Главное меню - находится наверху экрана. Большинство функции StarUML ™ доступны через 
главное меню. 

Инструментальные панели 

Инструментальные панели находятся ниже главного меню. Их кнопки дублируют часто 
используемые пункты меню. 

Область браузера 

Область браузера расположена в верхнем правом углу экрана. Эта область содержит 
инструменты, облегчающие просмотр составляющих элементов проекта. Эта область включает 
[Навигатор модели], который показывает модельные элементы в виде иерархической структуры, и 
[Навигатор диаграмм], который показывает диаграммы модели, сгруппированные по типам. 

Область инспектора 

Область инспектора расположена в нижнем правом  углу экрана. Эта область содержит 
инструменты, облегчающие редактирование детальной информации о модельных элементах. Эта 
область включает [Редактор свойств], который позволяет редактировать свойства, 
[Документационный редактор], который позволяет водить детальные описания элементов, и 
[Редактор вложений], который позволяет присоединять к элементам дополнительные файлы и 
URL. 

Информационная область 

Информационная область расположена в нижней части экрана. Эта область содержит 
инструменты, показывающие различные вспомогательные данные, касающиеся приложения 
StarUML ™. Эта область включает [Окно Вывода], которое показывает регистрационную 
информацию, и [Окно Сообщений], которое показывает результаты поиска и проверки модели. 

Область диаграммы 

Область диаграммы расположена в центре экрана. Эта область содержит инструментарий, 
позволяющий редактировать и управлять диаграммами. 

Палитра элементов

Расположена на левой стороне экрана. Палитра содержит инструменты для быстрого создания 
модельных элементов. 

Меню 
Эта секция описывает подробно все пункты в главное меню StarUML ™. 
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• Меню File 
• Меню Edit 
• Меню Format 
• Меню Model 
• Меню View 
• Меню Tools 
• Меню Help 
• Горячие клавиши 

Меню File 

Меню File содержит следующие пункты меню. 
Пункт меню Описание

 New Project[Ctrl+N] Создать новый проект.
New Project By 
Approach[Ctrl+I] Открывает диалог Select New Project.

 Open[Ctrl+O] Открывает файл проекта. 

 Save[Ctrl+S] Сохраняет файл проекта.
Save As[Ctrl+A]  Сохраняет проект в другом файле. 
Close Закрывает текущий проект. 
Unit->Control Unit Отделяет и сохраняет текущий выбранный элемент как секцию. 

Unit->Uncontrol Unit Объединяет выбранную секцию с родительской секцией (или 
проектом). 

Unit->Delete Unit Удаляет текущую секцию
Unit->Save Unit Сохраняет текущую секцию как файл. 
Unit->Save Unit As Сохраняет текущую секцию как другой файл. 
Import->Framework Импортирует фреймворк в текущий проект.
Import->Model Fragment Импортирует фрагмент модели в текущий проект.
Export->Model Fragment Сохраняет текущий элемент как файл фрагмента модели. 
Export Diagram[Shift+Ctrl+D] Сохраняет текущую активную диаграмму как файл изображения. 
Page Setup Конфигурирует страницу для печати 

 Print[Ctrl+P] Печатает диаграмму.
Recent Files Содержит список недавно открытых файлов. 
Exit Выходит из программы. 

 Меню Edit 

Меню Edit содержит следующие пункты меню. 
Пункт меню Описание

 Undo[Ctrl+Z] Отменяет самое недавнее действие, выполненное пользователем.

 Redo[Ctrl+Y] Повторяет самое недавнее действие, выполненное пользователем

 Cut[Ctrl+X] Копирует выбранные элементы в буфер обмена и удаляет их из текущего 
местоположения. 
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Пункт меню Описание

 Copy[Ctrl+C] Копирует выбранные элементы в буфер обмена. 
Copy 
Diagram[Shift+Ctrl+C] Копирует текущую активную диаграмму в буфер обмена. 

Copy Diagram as 
Bitmap[Shift+Ctrl+C] 

Копирует текущую активную диаграмму в буфер обмена как растровый 
рисунок. 

 Paste[Ctrl+V] Вставляет содержание буфера обмена в текущий элемент (или 
диаграмму). 

 Delete[Del] Удаляет выбранные визуальные образы на диаграмме.
Delete From 
Model[Ctrl+Del] Удаляет выбранные модельные элементы. 

 Find[Ctrl+F] Находит элемент.
Select All[Ctrl+A] Выбирает все элементы в текущей диаграмме. 

Меню Format 

Меню Format содержит следующие пункты меню. 
Пункт меню Описание

Font Определяет шрифт для выбранных визуальных образов. 

Line Color Определяет цвет строки для выбранных визуальных образов.

Fill Color Определяет цвет заливки для выбранных визуальных образов. 

Line Style-
>Rectilinear[Ctrl+L] 

Определяет тип линии выбранного элемента представления связи как 
прямолинейный. 

 Line Style-
>Oblique[Ctrl+B]

Определяет тип линии выбранного элемента представления связи как 
наклонный. 

 Stereotype Display-
>None[Shift+Ctrl+N] Не показывать стереотип выбранных визуальных образов. 

 Stereotype Display-
>Textual[Shift+Ctrl+T] Показывает стереотип выбранных визуальных образов в виде текста 

 Stereotype Display-
>Iconic[Shift+Ctrl+I] Показывает стереотип выбранных визуальных образов как иконку.

 Stereotype Display-
>Decoration[Shift+Ctrl
+E]

Показывает стереотип выбранных визуальных образов как декорацию.

 Suppress 
Attributes[Shift+Ctrl+
A]

Подавляет секцию, которая отображает атрибуты для выбранных 
визуальных образов (например класс, прецедент, и т.д.). 

 Suppress 
Operations[Shift+Ctrl+
O]

Подавляет секцию, которая отображает операции для выбранных 
визуальных образов (например класс, подсистема, и т.д.). 

 Suppress 
Literals[Shift+Ctrl+L]

 Подавляет секцию, которая отображает атрибуты для выбранных 
перечислений.

 Word Wrap Name Разрешает разрывать имена выбранных визуальных образов. 
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Пункт меню Описание

 Show Parent Name Показывает имя родителя в именах выбранных визуальных образов.

 Show Operation 
Signature

Показывает сигнатуру операции выбранных визуальных образов (например 
класс, подсистема, и т.д.). 

 Show Properties Показывает свойства элемента (например, теги и т.д.) в его визуальном 
образе. 

 Show Compartment 
Visibility

Показывает уровень видимости внутренних визуальных образов (например 
атрибутов, операций, и т.д.). 

 Show Compartment 
Stereotype

Показывает стереотипы внутренних визуальных образов (например 
атрибутов, операций, и т.д.). 

 Auto Resize Автоматически изменяет размеры выбранных визуальных образов.

Alignment->  Bring 
to Front Отображает выбранные элементы поверх остальных. 

Alignment->  Send to 
Back Отображает выбранные элементы под остальными. 

Alignment->  Align 
Left Выравнивает выбранные элементы по левому краю. 

Alignment->  Align 
Right Выравнивает выбранные элементы по правому краю

Alignment->  Align 
Middle Выравнивает выбранные элементы горизонтально по центру

Alignment->  Align 
Top Выравнивает выбранные элементы по верхнему краю. 

Alignment->  Align 
Bottom Выравнивает выбранные элементы по нижнему краю.

Alignment->  Align 
Center Выравнивает выбранные элементы вертикально по центру .

Alignment->  Space 
Equally, Horizontally Равномерно распределяет выбранные элементы горизонтально. 

Alignment->  Space 
Equally, Vertically Равномерно распределяет выбранные элементы вертикально.

 Layout Diagram Автоматически располагает элементы представления в текущей диаграмме. 

 Меню Model 

Меню Model содержит следующие пункты меню. 
Пункт меню Описание

Add->...
Добавляет модельный элемент. Модельные элементы, которые можно 
добавить под текущими модельными элементами, отображаются в суб-
меню. 

Add Diagram->... Добавляет диаграмму. Диаграммы, которые можно добавить под текущими 
модельными элементами, отображены в суб-меню. 

 Collection 
Editor[Ctrl+F5]

Открывает редактор коллекций, который может использоваться, чтобы 
редактировать дочерние элементы текущего модельного элемента. 
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Пункт меню Описание

 
Constraints[Ctrl+F6]

Открывает редактор ограничений, который может использоваться, чтобы 
редактировать ограничения текущего модельного элемента. 

 
TaggedValues[Ctrl+F
7]

Открывает редактор тэгов, который может использоваться, чтобы 
редактировать значения тэгов текущего модельного элемента. 

 Profiles[Ctrl+F8] Открывает менеджер профилей. 

 Verify Model[F9] Открывает диалоговое окно Verify Model, которое может использоваться, 
чтобы проверить модельные элементы в текущем проекте. 

Convert Diagram-
>Convert 
Sequence(Role) to 
Collaboration(Role)

Генерирует новую диаграмму, преобразовывая текущую диаграмму 
сообщений в диаграмму коллабораций (заданная по умолчанию функция 
Add-In). 

Convert Diagram-
>Convert 
Collaboration(Role) 
to Sequence(Role) 

Генерирует новую диаграмму, преобразовывая текущую диаграмму 
коллабораций в диаграмму сообщений (заданная по умолчанию функция 
Add-In).

 Меню View 

Меню View содержит следующие пункты меню. 
Пункт меню Описание
Close Diagram Закрывает текущую активную диаграмму.
Close All Diagrams Закрывает все открытые диаграммы.
Select In Model Explorer Показывает текущий элемент в навигаторе модели. 

 Referesh Обновляет текущую диаграмму.
Model Explorer Переключает навигатор модели вкл. и выкл.
Diagram Explorer Переключает навигатор диаграмм вкл. и выкл.
Properties Переключает редактор свойств вкл. и выкл.
Documentations Переключает документационный редактор вкл. и выкл.
Attachments Переключает редактор вложений вкл. и выкл.
Output Переключает окно вывода вкл. и выкл.
Messages Переключает окно сообщения вкл. и выкл.
Toolbox Переключает инструментарий вкл. и выкл.

Zoom->  Zoom In Делает масштаб диаграммы большим.

Zoom->  Zoom Out Делает масштаб диаграммы меньшим. 

Zoom->  Fit To Window Автоматически корректирует масштаб изображения так, чтобы вся 
диаграмма поместилась в окне. 

Zoom->xxx% Показывает текущую диаграмму в масштабе xxx%
Toolbars->Standard Переключает инструментальная панель Standard вкл. и выкл.
Toolbars->Format Переключает инструментальная панель Format вкл. и выкл.
Toolbars->View Переключает инструментальная панель View вкл. и выкл.
Toolbars->Alignment Переключает инструментальная панель Align вкл. и выкл.
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Меню Tools 

Меню Tools содержит следующие пункты меню. 
Пункт меню Описание

Add-In Manager...
Открывает Диспетчер надстроек (аддинов), который может использоваться, 
чтобы управлять дополнительно установленными программными 
расширениями StarUML

 Меню Help 

Справочное меню содержит следующие пункты меню. 
Пункт меню Описание
StarUML On the Web Открывает web-узел StarUML ™.
About Показывает этикетку StarUML ™. 

Горячие клавиши 

StarUML ™ обеспечивает горячие клавиши к функциям меню. Горячие клавиши могут 
увеличить эффективность и удобство при программном моделировании. 
Клавиша Описание
Del Delete
F1 StarUML™ Help
F5 Refresh
F6 Browser Window
F7 Inspector Window
F8 Information Window
F9 Verify Model
Ctrl+F4 Close Diagram
Ctrl+F5 Collection Editor
Ctrl+F6 Constraint Editor
Ctrl+F7 Tagged Values
Ctrl+A Select All
Ctrl+B Oblique
Ctrl+C Copy
Ctrl+F Find
Ctrl+I Select New Project
Ctrl+L Rectilinear
Ctrl+M Show in Model Explorer
Ctrl+N New Project
Ctrl+O Open
Ctrl+P Print
Ctrl+S Save
Ctrl+V Paste
Ctrl+X Cut

, 09.01.07
<!--begin!kadov{{-->
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Клавиша Описание
Ctrl+Y Redo
Ctrl+Z Undo
Ctrl+Del Delete Model
Shift+Ctrl+F4 Close All Diagrams
Shift+Ctrl+A Suppress Attributes
Shift+Ctrl+C Copy Diagram
Shift+Ctrl+D Export Diagram
Shift+Ctrl+E Decoration(Stereotype Display)
Shift+Ctrl+I Icon (Stereotype Display)
Shift+Ctrl+L Suppress Literals 
Shift+Ctrl+N None (Stereotype Display)
Shift+Ctrl+O Suppress Operations
Shift+Ctrl+S Save As
Shift+Ctrl+T Text (Stereotype Display)

Панели инструментов 
Эта секция описывает все элементы инструментальной панели StarUML ™. 

• Панель Standard. Включает команды меню File, Edit и Model. 
• Панель Format. Включает команды меню Format. 
• Панель View . Включает команды меню View. 
• Панель Align. Включает команды выравнивания из меню Format. 
• Панель Pallet. Содержит клавиши для размещения визуальных образов на диаграммах. 

Инструментальная палитра 

Инструментальная палитра содержит следующие функции для того, чтобы выбирать и создавать 
элементы в диаграмме. 

Общие инструменты палитры 

Следующие функции всегда доступны в инструментальной палитре независимо от типов 
диаграмм. 
Функция Описание

 Select Самый основной инструмент, который выбирает, перемещает или 
изменяет размеры элемента в диаграмме. 

 Note Создает элемент примечания в текущей диаграмме
 Note Link Связывает примечание с элементом диаграммы
 Text Создает строковый элемент в текущей диаграмме
 Rectangle Создает прямоугольник в текущей диаграмме. 
 Ellipse Создает эллипс в текущей диаграмме.  
 Rounded Rectangle Создает округленный прямоугольник в текущей диаграмме. 
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Инструменты палитры ориентированные на разные типы диаграмм 

Следующие функции создают элементы для диаграмм разных типов. 
Функция Описание Все диаграммы

 Subsystem Создаёт подсистему в текущей диаграмме Диаграмма классов

 Package Создаёт пакет в текущей диаграмме.

Диаграмма классов, 
Диаграмма компонентов, 
Диаграмма развёртывания, 
Диаграмма прецедентов

 Class Создаёт класс в текущей диаграмме Диаграмма классов, 
Композиционная диаграмма

 Interface Создаёт интерфейс в текущей диаграмме
Диаграмма классов, 
Диаграмма компонентов, 
Композиционная диаграмма 

 Enumeration Создаёт перечислимый тип в текущей 
диаграмме Диаграмма классов

 Signal Создаёт сигнал в текущей диаграмме Диаграмма классов

 Except Создаёт прерывание в текущей диаграмме Диаграмма классов

 Component Создаёт компонент в текущей диаграмме Диаграмма компонентов

 
ComponentInstance

Создаёт инстанцию компонента в текущей 
диаграмме Диаграмма компонентов

 Node Создаёт узел в текущей диаграмме Диаграмма развёртывания

 NodeInstance Создаёт инстанцию узла в текущей диаграмме Диаграмма компонентов, 
Диаграмма развёртывания

 Artifact Создаёт артефакт в текущей диаграмме Диаграмма прецедентов
 UseCase Создаёт прецедент в текущей диаграмме Диаграмма прецедентов

 Actor Создаёт актора в текущей диаграмме Диаграмма прецедентов

 SystemBoundary Создаёт системную границу в текущей 
диаграмме Диаграмма прецедентов

 Object Создаёт объект в текущей диаграмме
Диаграмма классов, 
Диаграмма сообщений, 
Диаграмма коллабораций

 Part Создаёт часть классификатора в текущей 
диаграмме

Диаграмма классов, 
Диаграмма компонентов, 
Диаграмма развёртывания, 
Композиционная диаграмма

 Port Создаёт порт классификатора в текущей 
диаграмме

Диаграмма классов, 
Диаграмма компонентов, 
Диаграмма развёртывания, 
Композиционная диаграмма

 ClassifierRole Создаёт роль классификатора в текущей 
диаграмме

Диаграмма сообщений ролей, 
Диаграмма коллаборации 
ролей

 Combined 
Fragment

Создаёт комбинированный фрагмент в 
текущей диаграмме

Диаграмма сообщений, 
Диаграмма сообщений ролей, 
Диаграмма коллабораций, 
Диаграмма коллаборации 
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Функция Описание Все диаграммы

ролей

 Interaction 
Operand

Создаёт операнд взаимодействия с 
комбинированным фрагментом в текущей 
диаграмме

Диаграмма сообщений, 
Диаграмма сообщений ролей, 
Диаграмма коллабораций, 
Диаграмма коллаборации 
ролей

 Frame Создаёт фрейм в текущей диаграмме

Диаграмма сообщений, 
Диаграмма сообщений ролей, 
Диаграмма коллабораций, 
Диаграмма коллаборации 
ролей

 CompositeState Создаёт композитное состояние в текущей 
диаграмме Диаграмма состояний

 SubmachineState Создаёт a суб-модель состояний в текущей 
диаграмме Диаграмма состояний

 InitialState Создаёт начальное состояние 
(Псевдосостояние) в текущей диаграмме

Диаграмма состояний, 
Диаграмма действий

 FinalState Создаёт конченое состояние в текущей 
диаграмме

Диаграмма состояний, 
Диаграмма действий

 Flow Final Создаёт глубокую хронологию(Состояние 
конечного потока) в текущей диаграмме

Диаграмма состояний, 
Диаграмма действий

 ChoicePoint Создаёт выбор (Псевдосостояние) в текущей 
диаграмме Диаграмма состояний

 JunctionPoint Создаёт соединение (Псевдосостояние) 
element в текущей диаграмме Диаграмма состояний

 ShallowHistory Создаёт поверхностную хронологию 
(Псевдосостояние) в текущей диаграмме Диаграмма состояний

 DeepHistory Создаёт глубокую хронологию 
(Псевдосостояние) в текущей диаграмме Диаграмма состояний

 Synchronization Создаёт синхронизацию (Псевдосостояние) в 
текущей диаграмме

Диаграмма состояний, 
Диаграмма действий

 ActionState Создаёт действие в текущей диаграмме Диаграмма действий
 SubactivityState Создаёт суб-действие в текущей диаграмме Диаграмма действий

 Decision Создаёт решение (Псевдосостояние) в 
текущей диаграмме Диаграмма действий

 ObjectFlow Создаёт объектный поток в текущей 
диаграмме Диаграмма действий

 Signal Accept 
State

Создаёт состояние принятия сигнала в 
текущей диаграмме Диаграмма действий

 Signal Send 
State

Создаёт состояние посылки сигнала в текущей 
диаграмме Диаграмма действий

 
Swimlane(Vertical)

Создаёт вертикальную область действия в 
текущей диаграмме Диаграмма действий

 
Swimlane(Horizonta
l)

Создаёт горизонтальную область действия в 
текущей диаграмме Диаграмма действий
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Функция Описание Все диаграммы

 Association Проводит семантическую ассоциацию между 
двумя классами в текущей диаграмме

Диаграмма классов, 
Диаграмма компонентов, 
Диаграмма развёртывания, 
Диаграмма прецедентов

 
DirectedAssociation

Проводит семантическую ассоциацию между 
двумя классами в текущей диаграмме

Диаграмма классов, 
Диаграмма развёртывания, 
Диаграмма прецедентов

 Aggregation Проводит семантическую ассоциацию между 
двумя классами в текущей диаграмме Диаграмма классов

 Composition Проводит семантическую ассоциацию между 
двумя классами в текущей диаграмме Диаграмма классов

 Generalization
Соединяет обобщаемый и специализируемый 
элементы отношением обобщения в текущей 
диаграмме

Диаграмма классов, 
Диаграмма прецедентов

 Dependency Соединяет два элемента отношением 
зависимости в текущей диаграмме

Диаграмма классов, 
Диаграмма компонентов, 
Диаграмма развёртывания, 
Диаграмма прецедентов, 
Композиционная диаграмма

 Realization
Соединяет спецификацию элемента и его 
реализацию отношением реализации в 
текущей диаграмме

Диаграмма классов, 
Диаграмма компонентов, 
Композиционная диаграмма

 AssociationClass
Соединяет класс и ассоциацию в текущей 
диаграмме так, что ассоциация сама 
становится подобной классу.

Диаграмма классов

 Include
Соединят два прецедента отношением 
включения в текущей диаграмме так, что один 
прецедент включает поведение другого.

Диаграмма прецедентов

 Extend

Соединят два прецедента отношением 
расширения в текущей диаграмме так, что 
один прецедент может быть расширен 
поведением другого.

Диаграмма прецедентов

 AssociationRole Соединяет две роли ассоциацией ролей в 
текущей диаграмме

Диаграмма коллаборации 
ролей

 
SelfAssociationRole

Создаёт ассоциацию роли к себе самой в 
текущей диаграмме

Диаграмма коллаборации 
ролей 

 Link Соединяет два объекта в текущей диаграмме Диаграмма классов, 
Диаграмма коллабораций

 SelfLink Соединяет объект с самим собой в текущей 
диаграмме

Диаграмма классов, 
Диаграмма коллабораций

 ForwardMessage Определяет сообщение между двумя ролями в 
текущей диаграмме

Диаграмма сообщений ролей, 
Диаграмма коллаборации 
ролей

 ReverseMessage Определяет сообщение между двумя ролями в 
текущей диаграмме

Диаграмма сообщений ролей, 
Диаграмма коллаборации 
ролей

 SelfMessage Создаёт сообщение роли себе самой в текущей 
диаграмме

Диаграмма сообщений ролей, 
Диаграмма коллаборации 
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Функция Описание Все диаграммы
ролей

 ForwardStimulus Определяет сообщение между двумя 
объектами в текущей диаграмме

Диаграмма сообщений, 
Диаграмма коллабораций

 ReverseStimulus Определяет сообщение между двумя 
объектами в текущей диаграмме

Диаграмма сообщений, 
Диаграмма коллабораций

 SelfStimulus Создаёт сообщение объекта самому себе в 
текущей диаграмме

Диаграмма сообщений, 
Диаграмма коллабораций

 Transition Соединяет исходное состояние и целевое 
состояние переходом в текущей диаграмме 

Диаграмма состояний, 
Диаграмма действий

 SelfTransition Создаёт переход состояния к самому себе  в 
текущей диаграмме

Диаграмма состояний, 
Диаграмма действий

 Connector
Соединяет целевой и исходный элементы 
коннектором в текущей диаграмме

Диаграмма классов, 
Диаграмма компонентов, 
Диаграмма развёртывания, 
Композиционная диаграмма

Средства просмотра 

Навигатор модели 

Навигатор модели помогает пользователю эффективно управлять и исследовать модельные 
элементы, показывая их в иерархическом виде. Выберите закладку [Model Explorer] в области 
[Browser], чтобы открыть Навигатор модели. 

Навигатор диаграмм 

Навигатор диаграмм помогает пользователю эффективно управлять и исследовать диаграммы, 
группируя их по типам. Выберите закладку [Diagram Explorer] в области броузера, чтобы открыть 
Навигатор диаграмм.
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Редактор свойств 

Редактор свойств используется чтобы редактировать свойства текущего модельного элемента. 
Выберите закладку [Properties] в области инспектора, чтобы открыть Редактор свойств. 

Документационный редактор 

Документационный редактор используется для того, чтобы редактировать дополнительное 
описание текущего модельного элемента. Выберите закладку [Documentation] в области 
инспектора, чтобы открыть Документационный редактор.
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Редактор вложений 

Редактор вложений позволяет прикреплять файлы или URL к модельному элементу. Выберите 
закладку [Attachments] в области инспектора, чтобы открыть Редактор вложений. 

Список вложений 

Показывает список файлов или URL, приложенных к элементу. 

Кнопка Open 

Открывает выбранный файл вложения или URL с помощью ассоциированной программы. 
Например, если выбран файл .doc , он будет автоматически открыт в Microsoft Word, а если адрес 
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типа http://www.staruml.com, он откроется в web-браузере. 

Кнопка Add 

Присоединяет новый файл или URL. Щелкните эту кнопку, чтобы открыть диалоговое окно 
Attachment Item. 

Кнопка Remove 

Удаляет выбранный элемент из списка вложений. 

Кнопка Edit 

Редактирует выбранный элемент списка вложений. Редактор элемента вложения может 
использоваться, чтобы изменить имя файла или ввести другой URL. 

Кнопка Move Up 

Продвигает вверх выбранный элемент в списке вложений. 

Кнопка Move Down 

Перемещает вниз выбранный элемент в списке вложений. 

Редактор элемента вложения 

Редактирует имя элемента вложения. Введите URL или путь для файла. Кнопка справа может 
использоваться, чтобы выбрать файл. 

Окно вывода 

Окно вывода сохраняет и показывает отчет событий в StarUML ™. Выберите закладку [Output] в 
информационной области, чтобы открыть Окно вывода.
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Окно сообщений 

Окно сообщений показывает результаты поиска элемента или результаты проверки 
корректности модели. Выберите закладку [Messages] в информационной области, чтобы открыть 
Окно сообщений.

 

Диалоги 

Редактор коллекций 

Редактор коллекций используется для того, чтобы управлять списком дочерних элементов 
указанного элемента. 
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Закладка 

Коллекции (списки дочерних элементов, содержавшихся в текущем элементе) показываются на 
отдельных закладках. Различные типы элементов имеют различные коллекции, и поэтому имеют 
различные закладки. Например, элемент класса имеет закладки для атрибутов и операций. 
Закладка Relations (отношения) всегда присутствует независимо от типа элемента. 

Список элементов коллекции 

Показывает список дочерних элементов. Выберите здесь элемент и редактируйте его 
спецификацию, используя редактор свойств, документационный редактор и редактор вложений в 
области инспектора. Для того, чтобы регулировать отображение стереотипов, признаков 
видимости и т.д., пожалуйста обращайтесь к закладке General Configurations диалога Environment 
Configurations. 

Кнопка Add 

Создает новый элемент и добавляет его в список. Эта кнопка может подключить существующие 
элементы вместо того, чтобы создавать новый элемент (например, резиденты, развёртываемые 
компоненты, генерируемые сигналы и т.п.). 

Кнопка Delete 

Удаляет выбранный элемент из списка элементов коллекции. Эта кнопка может удалить элемент 
только из списка вместо того, чтобы удалить его совсем (например, резиденты, развёртываемые 
компоненты, генерируемые сигналы и т.п). 

Кнопка Move Up 

Подвигает вверх выбранный элемент в списке элементов коллекции. 

Кнопка Move Down  

Перемещает вниз выбранный элемент в списке элементов коллекции. 

Редактор ограничений 

Редактор ограничений используется для того, чтобы управлять ограничениями (констрэйнтами) 
элементов.



StarUNL. Руководство пользователя. Глава 11. Справочник по интерфейсу пользователя 186 / 207

 

Список ограничений 

Показывает имена и содержание ограничений для элементов. 

Кнопка Add 

Добавляет новое ограничение к элементу. Эта кнопка открывает диалоговое окно Constraints. 

Кнопка Delete 

Удаляет выбранное ограничение из списка ограничений. 

Кнопка Edit 

Редактирует выбранное ограничение в списке ограничений. 

Кнопка Move Up 

Подвигает вверх выбранное ограничение в списке ограничений. 

Кнопка Move Down 

Перемещает вниз выбранное ограничение в списке ограничений. 

Редактор ограничения 

Используется для того, чтобы добавлять новое ограничение или редактировать имя и/или 
содержание существующих ограничений. Введите имя ограничения в поле [Name] а содержание 
ограничения в поле [Body]. Пользователь может свободно ввести любое содержание или записать 
его на UML OCL (Object Constraint Language). 
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Редактор тэгов 

Редактор тэгов используется чтобы редактировать значения тега, которые можно добавлять к 
специфическим элементам. 

Закладка профилей 

По умолчанию, значения тэгов определены в профилях. Если есть профиль, который содержит 
значения тэгов, которые могут быть применены к текущему элементу, он показывается как 
закладка. Определения тэгов, заданные в профиле, отображаются в полях [Tag Definition Set] и 
[Tagged Values]. 

Набор определений тэгов [Tag Definition Set]

Показывает набор определения тэгов, который может быть применен к текущему элементу. 
Значения тэгов, включенные в этот набор, отображаются в поле [Tagged Values]. 

Значения тэгов [Tagged Values]

Содержит тэги и их значения, включенные в набор определения тэгов, выбранный в [Tag 
Definition Set]. Пользователь может непосредственно изменять эти значения. 

Кнопка [Set As Default] (Используемый по умолчанию) 

Каждое определение тэга имеет значение по умолчанию. Выберите определение тэга в [Tagged 
Values] и щелкните эту кнопку, чтобы удалить измененное значение и вернуть значение по 
умолчанию. 
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Менеджер профилей 

Менеджер профилей может использоваться для включения или исключения профиля UML для 
текущего проекта. 

Список [Available profiles] (Доступные профили)

Показывает список профилей UML, зарегистрированных для использования в StarUML ™. 
Профили, используемые в настоящее время текущим проектом не показывают здесь. 

Список [Include profiles] (Включённые профили)

Показывает список профилей UML доступных текущему проекту. 

Кнопка Large/Icon Small Icon 

Переключает размер иконок списка профилей между большим и маленьким. Нажмите кнопку 
Small Icon , если имена профилей видны только частично или их трудно читать. 

Кнопка Include 

Включает профиль, выбранный в списке доступных профилей для использования текущим 
проектом. 

Кнопка Exclude 

Исключает профиль, выбранный в списке доступных профилей так, чтобы он больше не 
использовался текущим проектом. 
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Add-In Manager 

Диспетчер аддинов может использоваться, чтобы просматривать список установленных аддинов 
и включать или отключать их.

 

Список аддинов 

Показывает список установленных аддинов. Пользователь может выбрать или сбросить 
соответствующий флажок, чтобы включить или отключить соответствующий Аддин. 

Примечание 

• Список аддинов в окне Add-In Manager зависит от инсталлированного окружения 
пользователя. 

Диалог Select New Project 

Диалоговое окно Select New Project обеспечивает различные способы создания нового проекта. 
Диалоговое окно New Project состоит из трех страниц: 

Select Approach, Open Existing File, and Open Recent File. 

Подходы 

Пользователь может применить специфический подход чтобы создать новый проект.
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• Approaches: список подходов отображает имена и значки зарегистрированных подходов. 
Выберите пункт “Empty Project”, если никакой подход не нужен. 

• Кнопка Large Icon/Small Icon : Переключает размер иконок в списке подходов. Выберите 
маленькие значки, если имена подходов трудно читать. 

• Description: Эта область содержит краткое описание подхода, выбранного в списке. 
• Set as default Approach: выберите подход из списка и установите этот флажок, чтобы 

использовать данный подход как заданный по умолчанию. Заданный по умолчанию подход 
автоматически применяется при создании нового проекта. 

Open Files 

Пользователь может открыть предварительно созданный файл. Древовидная структура слева 
отображает список папок, а справа показывается список проектных файлов в выбранной папке. 
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Выберите файл и нажмите кнопку [Open], чтобы открыть выбранный файл. 

Recent Files 

Пользователь может просмотреть список недавно открывавшихся файлов и снова открыть 
любой из них. 

• Recent files: Показывает список недавно открывавшихся файлов. 
• Delete non-existent files from the list:  Находит файлы, которые больше не существуют, и 

удаляет их из списка. 
• Delete all recent files from the list: Удаляет все файлы из списка. 

Диалог Import Framework 

Диалоговое окно Import Framework позволяет выбрать доступный фреймворк и загрузить его в 
текущий проект. 
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Frameworks list 

Список фреймворков отображает имена и иконки зарегистрированных фреймворков. Выберите 
фреймворк для загрузки. 

Кнопка Large/Icon Small Icon 

Переключает размер иконок в списке фреймворков. . 

Description 

Эта область показывает краткое описание фреймворка, выбранного в списке. 

Диалог Page Setup 

Диалоговое окно Page Setup (Параметров станицы) позволяет определять, какая информация из 
диаграмм и как будет напечатана (ориентация бумаги, отступы и т.д).
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Option 

Пользователь может указать часть информации о диаграмме, которая будет напечатана. 

• On Header : Печатает информацию о диаграмме в верхнем колонтитуле. 
• On Footer : Печатает информацию о диаграмме в нижнем колонтитуле. 
• None : Не печатает информацию о диаграмме. 
• Diagram Name : Печатает имя диаграммы. 
• Project Title : Печатает название проекта. 
• Page Number : Печатает номера страниц. 
• Diagram Kind : Печатает тип диаграммы. 
• Date/Time : Печатает текущую дату и время. 

Margin 

Пользователь может указать верхние, нижние, левые и правые отступы на странице в 
миллиметрах. 

Page orientation 

Пользователь может определить, печатать ли страницу портретно или ландшафтно. 

Border 

Пользователь может определить, как будет напечатан бордюр страницы. Выберите сторону и 
определите толщину границы. 

Диалог Print

Диалоговое окно Print появляется, когда пользователь печатает диаграмму. Пользователь может 
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выбрать и определить различные варианты печати. 

Printer 

Пользователь может устанавливать параметры принтера. 

• Name : Выберите принтер, который хотите использовать. 
• Status : Указывает состояние выбранного принтера. 
• Location : Указывает местоположение выбранного принтера. 
• Page Setup : Открывает диалоговое окно Page Setup. 

Size 

Определяет размер диаграммы. 

• Diagram as is : Печатает диаграмму в ее оригинальном размере. Диаграмма напечатается на 
нескольких страницах, если она не умещается на одной странице. 

• Fit to page : Принудительно печатает диаграмму на одной странице. Эта опция 
предотвращает печать нескольких страниц, если диаграмма является слишком большой. 

• Tile : Печатает диаграмму, умещая её на указанном количестве страниц. 
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Print Range 

Определяет набор печатаемых диаграмм. 

• Current diagram : Печатает только текущую активную диаграмму. 
• All diagrams : Печатает все диаграммы текущего проекта. 
• Selected diagrams : Печатает только выбранные диаграммы. Кнопка [Select All] выбирает все 

диаграммы, а кнопка [Deselect All] отменят выбор. 

Preview 

Открывает диалоговое окно Preview. 

Диалог Print Preview 

Диалоговое окно Print Preview позволяет пользователю предварительно просматривать 
печатаемую диаграмму, до того как она будет напечатана. 

Print 

Стартует печать. 
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One Page / Two Pages 

Переключает режим предварительного просмотра на одностраничный или двустраничный. 

<<, <, >, >> 

Позволяет просматривать печатаемые страницы. 

Page Selection 

Пользователь может перейти к указанной странице, непосредственно введя её номер. 

Диалог Find  

Диалоговое окно Find позволяет быстро и легко находить модельные элементы.

 

Text to Find 

Введите искомую строку полностью или частично. Пользователь может также выбрать искомую 
строку из нескольких ранее введенных строк. 

Option-Element Type 

Определяет диапазон просматриваемых элементов. Доступные диапазоны: ‘All elements’, Model, 
Subsystem, Package, Class, Interface, Enumeration, Signal, Exception, Component, Node, Instance, 
UseCase, and Actor. 

Option-Case Sensitive 

Определяет учёт регистра символов при поиске. 

Диалог Verify Model 

Диалоговое окно Verify Model используется, чтобы проверить корректность модельных 
элементов. 
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Verification Rule 

Показывает применяемое правило проверки. 

Verifying Element 

Показывает имя проверяемого элемента. 

Progress 

Отображает прогрессор проверки. 

Failed 

Указывает число некорректных элементов. 

Диалог Options 

Диалоговое окно Options содержит различные опции конфигурации окружения StarUML ™ и 
позволяет пользователю редактировать их. 
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Option category 

Этот список показывает категории опций. Главная категория - "Environment", содержит 
подкатегории “General”, "Diagram", “General View”, и “Specific View”. Модули StarUML™ могут 
устанавливать дополнительные категории опций. 

Option item 

Показывает опции, содержащиеся в выбранной категории опций. Значения опций могут быть 
отредактированы. 

Description 

Показывает краткое описание выбранной категории опций или элемента. 

Reset to default values 

Устанавливает значение по умолчанию для выбранной опции. 

Revert to last value 

Возвращается опции последнее сохранённое значение. 

Диалог Select Stereotype 

Диалоговое окно Select Stereotype появляется, когда пользователь должен определить стереотип 
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выбранного элемента. Стереотип может быть введен непосредственно или выбран от списка.

 

Stereotypes 

В это поле пользователь может непосредственно ввести стереотип. Если стереотип был 
зарегистрирован, он присутствует в списке стереотипов. 

Список стереотипов

Показывает стереотипы, определенные в профилях UML, которые используются текущим 
проектом. Имя стереотипа и имя профиля, который определяет его, показываются вместе. 
Пользователь может выбрать стереотип от списка. 

Icon preview 

Показывает иконку, если выбранный стереотип связан с иконкой. 

Description 

Показывает описание выбранного стереотипа. 

Диалог Select Element 

Диалоговое окно Select Element позволяет выбрать элемент в иерархической структуре 
проектных элементов. Диалоговое окно Select Element появляется, когда пользователь должен явно 
указать элемент в редакторе свойств, редакторе коллекций, и т.д. В отличие от диалогового окна 
Element List, диалоговое окно Select Element перечисляет элементы в иерархической структуре. 
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Заголовок диалога 

Заголовок диалогового окна изменяется в зависимости от типа элемента, который будет выбран. 
Соответствующий заголовок отображается, чтобы определять тип атрибута, или тип объекта (то 
есть, классификатор). 

Список элементов

Показывает доступные элементы. Например, только элементы модели состояний отображаются 
при выборе модели состояний. 

Data Types 

Показывает доступные типы данных. Типы данных, показываемые здесь - определяются в 
профилях UML, которые используются текущим проектом. Этот список может не показываться, 
если тип данных не требуется указывать. 

Do not specify 

Установите этот флажок, чтобы не определять ничего. Это фактически присваивает пустое 
значение. 

Выбранный элемент

Нижняя часть диалогового окна показывает полное имя выбранного элемента. Эта информация 
может использоваться, чтобы проверить, какой элемент является текущим. 
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Диалог Element List 

Диалоговое окно Element List позволяет выбирать элемент из списка. Диалоговое окно Select 
Element появляется, когда пользователь должен присвоить элемент специфическому свойству в 
редакторе свойств, редакторе коллекций, и т.д. В отличие от диалогового окна Select Element, 
диалоговое окно Element List перечисляет элементы в одномерном списке. 

Заголовок диалога 

Заголовок диалогового окна изменяется в зависимости от типа элемента, который будет выбран. 

Список элементов 

Показывает доступные элементы. Например, только элементы модели состояний отображаются, 
если выбрана модель состояний. 

Do not specify 

Установите этот флажок, чтобы не определять ничего. Это фактически присваивает пустое 
значение. 

Диалог Model Filtering 

Диалоговое окно Model Filter может использоваться, чтобы показывать или скрывать 
специфические элементы в навигаторе модели.

 

Elements to show 

Показывает все элементы, которые могут быть отображены в навигаторе модели. Только 
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отмеченные элементы отображаются в навигаторе модели. 

Select Relations 

Позволяет выбрать все отношения (Transition, Dependency, Association, AssociationClass,  
Generalization, Link, AssociationRole, Stimulus, Message, Include, Extend, and Realization) из списка 
элементов. 

Deselect Relations 

Сбрасывает все элементы отношений. 

Select All 

Выбирает все элементы. 

Deselect All 

Отменяет все элементы. 

Set As Default 

Выбирает элементы, используемые по умолчанию программой. 

Горячие диалоги 
Эта секция описывает все горячие диалоги, доступные в StarUML™. 

• Стандартный горячий диалог 
• Горячий диалог "Subsystem" 
• Горячий диалог "Classifier" 
• Горячий диалог "Enumeration" 
• Горячий диалог "Literal" 
• Горячий диалог "Attribute" 
• Горячий диалог "Operation" 
• Горячий диалог "AssociationEnd" 
• Горячий диалог "Object" 
• Горячий диалог "ClassifierRole" 
• Горячий диалог "Message/Stimulus" 
• Горячий диалог "State" 
• Горячий диалог "Action" 
• Горячий диалог "Note/Text" 

Стандартный горячий диалог

Стандартный горячий диалог  - самая общая форма горячих диалогов. Она используется для 
большинства элементов. Она появляется, когда элемент дважды щёлкнут на диаграмме. Нажатие 



StarUNL. Руководство пользователя. Глава 11. Справочник по интерфейсу пользователя 203 / 207

клавиши [Enter] или щелчок вне горячего диалога принимают изменения. 

Кнопка Visibility 

Видимость элемента может принимать значения Public, Protected, Private, и Package. 

Поле редактирования 

Имя элемента, видимость и стереотип могут быть введены в поле редактирования согласно 
синтаксису. 

Синтаксис 

<< stereotype >> visibility name 

• << stereotype >> : Введите имя стереотипа . Оно может быть опущено. 
• visibility : Введите символ, который соответствует видимости элемента (‘+’: общедоступное, 

‘#’: защищенный, ‘-’: частный, ‘ ~ ’: пакет). Оно может быть опущено. 
• name : Введите имя элемента. 

Горячий диалог подсистемы 

Горячий диалог подсистемы применим только к элементам подсистемы. Он появляется, когда 
подсистема дважды щёлкнута на диаграмме. Нажатие клавиши [Enter] или щелчок вне горячего 
диалога применяет изменения. 

Синтаксис

<< stereotype >> visibility name

Кнопка добавления операции  

Создаёт и добавляет новую операцию 

Горячий диалог классификатора

Применяется для класса, интерфейса, сигнала, прерывания, актора, прецедента, артефакта.

Синтаксис

<< stereotype >> visibility name
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Кнопка добавления атрибута 

Создаёт и добавляет новый атрибут

Горячий диалог перечислимого типа

Синтаксис

<< stereotype >> visibility name

Содержит дополнительную кнопку добавления литеральной константы.

Горячий диалог атрибута

Синтаксис

<< stereotype >> visibility name : type = initialvalue

Кнопки

Кнопки в правой части диалога позволяют добавить атрибут, удалить атрибут, и передвинуть его 
на одну позицию вверх и вниз.  

Горячий диалог операции

Синтаксис

<< stereotype >> visibility name( parameters ) : returntype

Синтаксис объявления операции кроме видимости и имени позволяет ввести список параметров 
и тип возвращаемого значения (может быть опущен).

Параметры разделяются запятыми. Сигнатура параметра имеет следующий формат:

direction name : type

где:

• direction  - способ передачи параметра (‘in’, ‘inout’ или ‘out’), 
• name  - имя, 
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• type - тип. 

Горячий диалог конца ассоциации

Синтаксис

<< stereotype >> visibility name

Кнопка агрегации 

Признак агрегации может быть следующим : 

•  Association, 
•  Aggregation, 
•  Composition 

Направленность устанавливается флажком.

Кнопка выбора мощности   

Мощность  (кардинальное число) может быть выбрана из списка: 0..1, 1, 0..*, 1..* и * либо 
введена непосредственно.

Горячий диалог роли классификатора

Синтаксис

<< stereotype >> visibility name : type

Кнопка создания нового класса 

Создаёт новый классификатор в родительском пространстве имён коллаборации, где появляется 
роль классификатора. Роль классификатора ссылается на новый классификатор как на базовый 
элемент.

Горячий диалог объекта

Аналогичен диалогу роли классификатора
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Горячий диалог сообщения

Кнопка Connect Element 

Данный коннект определяет элемент, соответствующий типу сообщения. Если сообщение имеет 
тип CallAction, оно должно быть отправлено операционному объекту. Если это CreateAction, то оно 
направляется классификатору. Если это SendAction, оно присоединяется к сигналу.

Синтаксис

<< stereotype >> *[iteration] [condition] return := messagename ( arguments )

• << stereotype >> : Введите стереотип. Может быть опущено. 
• *[iteration] : Количество итераций сообщения. Должно иметь следующий формат 

“*[i=1..100]”. Может быть опущено. 
• [condition] : Условие сообщения. Может быть опущено. 
• return := : Выражение результата сообщения. Может быть опущено. 
• messagename : Имя сообщения. 
• ( arguments ) : Выражение передаваемого аргумента сообщения. Может быть опущено. 

Sequence number (for Collaboration Diagram) 

Порядковый номер, определяет очерёдность выполнения сообщений, может изменяться.

Горячий диалог состояния

Синтаксис

<< stereotype >> visibility name

Кнопка Add EntryAction 

Создаёт и добавляет новую EntryAction.

Кнопка Add DoAction 

Создаёт и добавляет новую DoAction.
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Кнопка Add ExitAction 

Создаёт и добавляет новую ExitAction.

Горячий диалог действия

Синтаксис

<< stereotype >> visibility name

Горячий диалог примечания

Содержит только поле ввода текста 


	Глава 1. Краткий обзор StarUML
	Что такое StarUML
	Инструмент UML, который адаптируется к пользователю
	Истинная поддержка MDA
	Превосходная расширяемость и гибкость 

	Главные особенности 
	Точное соответствие стандарту UML 
	Открытый формат программной модели
	Истинная поддержка MDA 
	Применимость методологий и платформ 
	Превосходная расширяемость
	Программная функция проверки модели
	Полезные аддины 

	Системные требования

	Глава 2. Основные концепции
	Модель, Представление и Диаграмма
	Проект и проектная секция 
	Проект
	Структура проекта
	Проектный файл
	Секции
	Состав секции
	Иерархическая структура секции
	Фрагменты модели

	Модуль
	Модуль
	Подходы (approaches)
	Структура подхода
	Фреймворки 
	Структура фреймворка 
	Профиль UML 
	Структура профиля UML
	Приложение профиля UML 
	Добавление модуля
	Добавление модуля в StarUML™


	Глава 3. Управление проектом
	Управление проектом 
	Создание нового проекта
	Процедура создания нового проекта #1 - New Project:
	Процедура создания нового проекта #2 - Select Select New Project

	Открытие проекта
	Процедура открытия проекта:

	Сохранение проекта
	Процедура сохранения проекта:
	Процедура сохранения проекта в новом файле:

	Закрытие проекта
	Процедура закрытия проекта:

	Управление элементами с помощью моделей, подсистем и пакетов
	Способы группировки элементов, реализованные в StarUML 

	Управление секциями
	Управление секцией
	Создание секции
	Процедура создания новой секции:

	Присоединение секции
	Процедура присоединения секции:

	Сохранение секции
	Процедура сохранения секции:
	Процедура сохранения секции другом файле:

	Удаление секции
	Процедура удаления секции: 


	Работа с фрагментами модели
	Создание фрагмента модели
	Процедура создания фрагмента модели:

	Импорт фрагмента модели
	Процедура импорта фрагмента модели:


	Импорт фреймворка 
	Процедура импорта фреймворка:

	Работа с профилями UML 
	Подключение профиля UML 
	Процедура включения профиля UML:

	Исключение профиля UML 
	Процедура исключения профиля UML:



	Глава 4. Моделирование с помощью StarUML 
	Редактирование элементов и диаграмм
	Создание новой диаграммы 
	Процедура создания новой диаграммы:
	Доступные типы диаграмм

	Создание элемента на диаграмме
	Процедура создания элемента из палитры элементов:
	Процедура одновременного создания нескольких однотипных элементов:

	Создание визуального образа элемента (View element) на диаграмме
	Процедура создания нового визуального образа (перетаскиванием):

	Редактирование элемента на диаграмме
	Процедура редактирования элемента:

	Изменение размеров и перемещение 
	Процедура изменения размера образа:
	Процедура изменения размеров образа, используя клавиатуру:
	Процедура перемещения образа: 
	Процедура перемещения образа, используя клавиатуру:

	Создание элемента с использованием "горячего синтаксиса" 
	Процедура создания элемента с помощью горячего синтаксиса:
	Горячий синтаксис генерации

	Копирование и вставка
	Процедура копирования и вставки модельных элементов:
	Процедура копирования и вставки визуального образа в диаграмме:
	Копирование/вставка для различных типов диаграмм

	Конфигурирование свойств
	Редактирование свойства имени
	Редактирование свойства стереотипа
	Редактирование свойства TypeExpression

	Документирование модельного элемента 
	Процедура документирования модельного элемента:

	Присоединение файла или URL 
	Процедура присоединения файла или URL:
	Процедура удаления присоединенного объекта: 

	Запись ограничений
	Процедура добавления ограничений:
	Процедура удаления ограничения: 
	Процедура редактирования ограничения: 

	Редактирование тэгов (дополнительных свойств) 
	Процедура редактирования тэгов: 
	Процедура возвращения отредактированному тэгу его значения по умолчанию: 

	Удаление визуального образа элемента 
	Процедура удаления визуального образа: 

	Присваивание цвета линии 
	Процедура установки цвета линии: 

	Назначение цвета заливки 
	Процедура изменения цвета заливки: 

	Выбор шрифта 
	Процедура изменения шрифта: 

	Установка стиля линии
	Процедура изменения стиля линии:

	Установка автоматической регулировки размера
	Процедура установки автоматической регулировки размера:

	Подавление отображения атрибутов
	Процедура скрытия отображений атрибутов:

	Подавление отображения операции
	Процедура скрытия отображения операций:

	Подавление отображения значений нумераторов 
	Процедура подавления изображения литералов:

	Управление разрывом слов
	Процедура включения разрыва слов:

	Показ составных имён
	Процедура включения показа составных имён

	Показ свойств
	Процедура включения показа свойств:

	Показ сигнатур операций
	Процедура включения показа сигнатур операций: 

	Показ атрибутов видимости 
	Процедура включения показа видимости:
	Процедура включения показа стереотипов:

	Открытие диаграммы
	Процедура открытия диаграммы:

	Активизация диаграммы
	Процедура активизации диаграммы через меню:

	Закрытие диаграммы
	Процедура закрытия диаграммы:
	Процедура закрытия всех открытых диаграмм:

	Удаление диаграммы
	Процедура удаления диаграммы:

	Поиск элемента
	Процедура поиска элемента:

	Выравнивание элемента
	Процедура выравнивания элементов:

	Настройка диаграммы
	Процедура расположения элементов диаграммы:

	Настройка масштаба диаграммы
	Процедура изменения масштаба диаграммы:

	Сохранение диаграммы в файле 
	Процедура сохранения диаграммы в файле изображения:

	Копирование диаграммы в формате точечного рисунка
	Процедура копирования диаграммы как точечного рисунка:

	Навигация в диаграмме
	Установка основной диаграммы  
	Для того, чтобы назначить основную диаграмму:


	Организация структуры модели
	Создание модельного элемента
	Процедура создания модельного элемента:

	Удаление модельного элемента
	Процедура удаления модельного элемента:

	Перемещение модельного элемента
	Процедура перемещения модельного элемента:

	Изменение порядка следования модельных элементов 
	Процедура изменения порядка следования модельного элемента:
	Процедура изменения порядка следования модельного элемента в редакторе коллекции: 

	Упорядочивание элементов


	Глава 5. Работа с диаграммами
	Использование диаграмм прецедентов
	Актор 
	Семантика
	Процедура создания актора
	Процедура создания нескольких прецедентов для одного актора 

	Прецедент
	Семантика
	Процедура создания прецедента 
	Чтобы добавить расширение 
	Чтобы ввести спецификацию прецедента 
	Чтобы создать несколько акторов для прецедента 

	Ассоциация / Направленная ассоциация
	Семантика
	Чтобы создать ассоциацию
	Чтобы создать направленную ассоциацию 
	Чтобы создать элемент, связанный с текущим ассоциацией/направленной ассоциацией 

	Обобщение
	Семантика
	Чтобы создать обобщение
	Чтобы создать несколько акторов, наследованных от текущего актора 

	Зависимость
	Семантика
	Чтобы создать зависимость
	Чтобы создать прецедент зависящий от текущего прецедента

	Включение
	Семантика
	Для создания включения
	Чтобы создать другой прецедент, включенный в текущий прецедент 

	Расширение
	Семантика
	Для создания расширения
	Чтобы создать другой прецедент, расширяющий текущий прецедент 

	Системная граница
	Семантика
	Чтобы создать системную границу

	Пакет 
	Семантика
	Чтобы создать пакет


	Использование диаграмм классов 
	Подсистема
	Семантика
	Чтобы создать подсистему
	Чтобы создать интерфейс, предоставляемый подсистемой 
	Чтобы создавать интерфейс и отношение реализации одновременно,
	Чтобы создать требуемый системе интерфейс 
	Чтобы добавить операцию к подсистеме

	Класс
	Семантика
	Чтобы создать класс
	Чтобы добавить атрибут
	Чтобы добавить операцию
	Чтобы добавить параметр к операции
	Чтобы добавить прерывание к операции:
	Чтобы переместить атрибут/операцию в другой класс
	Чтобы добавить параметр шаблона в класс
	Чтобы создать порт 
	Чтобы создать образ порта 
	Чтобы создать часть
	Чтобы создать соединитель
	Чтобы установить активность класса 

	Интерфейс
	Семантика
	Чтобы создать интерфейс
	Чтобы создать отношение реализации
	Чтобы создать отношение требования

	Перечислимый тип 
	Семантика
	Чтобы создать перечисление

	Сигнал
	Семантика
	Чтобы создать сигнал

	Прерывание
	Семантика
	Чтобы создать прерывание

	Ассоциация
	Семантика
	Чтобы создать ассоциацию
	Чтобы добавить квалификатор к ассоциации
	Чтобы сразу создать несколько классов, связанных с текущим классом

	Направленная ассоциация
	Чтобы создать направленную ассоциацию
	Процедура замены ассоциации на направленную ассоциацию
	Процедура создания направленной ассоциации с помощью горячего синтаксиса 

	Агрегация
	Семантика
	Процедура создания агрегата
	Процедура создания агрегированного класса с помощью горячего синтаксиса создания элементов 

	Композиция
	Семантика
	Процедура создания композиции
	Процедура создания компонентов класса-композита с помощью горячего синтаксиса 

	Обобщение
	Семантика
	Процедура создания обобщения
	Процедура создания нескольких дочерних классов сразу.
	Процедура создания сразу нескольких родительских классов для текущего класса

	Зависимость
	Семантика
	Процедура создания зависимости
	Процедура создания зависимого элемента с помощью горячего синтаксиса

	Реализация
	Семантика
	Процедура создания реализации
	Процедура создания реализующего элемента для выбранного элемента

	Класс-ассоциатор
	Семантика
	Процедура создания класс-ассоциатора 

	Объект
	Семантика
	Процедура создания объекта
	Процедура добавления значений атрибутов в объект

	Связь
	Семантика
	Процедура создания связи

	Отношение
	Процедура изменения соединения с другим элементом


	Использование диаграмм сообщений 
	Объект
	Процедура создания объекта
	Процедура установки активного объекта
	Процедуры создания объекта на основе класса
	Процедура создания класса на основе объекта
	Процедура создания, исходящего вызова от объекта, используя горячий синтаксис 

	сообщение 
	Семантика
	Чтобы создать сообщение, 
	Процедура использования операции класса как сообщения 
	Процедура создания операции класса из объекта
	Процедура создания предшествующего сообщения из текущего сообщения, используя горячий синтаксис 
	Процедура создания следующего сообщения из текущего сообщения, используя горячий синтаксис 
	Процедура создания под-сообщения, используя горячий синтаксис 
	Процедура пересоединения к другому объекту 
	Процедура изменения типа сообщения 

	Рекурсивное сообщение 
	Процедура создания сообщения себе

	Комбинированный фрагмент
	Процедура создания комбинированного фрагмента
	Процедура создания операнда взаимодействия 

	Рамка
	Процедура создания рамки

	Диаграмма
	Процедура отображения порядковых номеров сообщений на диаграмме 
	Процедура изменения стиля сигнатур сообщений на диаграмме
	Процедура изменения стиля активации на диаграмме 


	Использование диаграммы коллабораций 
	Объект
	Процедура создания объекта
	Процедура создания, исходящего сообщения с помощью горячего синтаксиса 
	Процедура установки активности объекта
	Процедура установки множественности объекта
	Процедура создания объекта на основе класса
	Процедура создания класса на основании объекта
	Процедура добавления AttributeLink к объекту 

	Связь
	Процедура создания связи

	Рекурсивная связь
	Процедура создания рекурсивной связи 
	Процедура создания рекурсивного сообщения 

	Сообщение
	Процедура создания сообщения
	Процедура изменения свойства ActionKind сообщения 

	Рамка
	Процедуры создания рамки

	Диаграмма
	Процедура изменения стиля сигнатуры сообщений в диаграмме


	Использование диаграммы состояний 
	Состояние
	Семантика
	Процедура создания состояния
	Процедура перемещения одного состояния в другое состояние
	Процедура перемещения нескольких состояний сразу
	Процедура добавления акций entry/do/exit 

	Субмодель состояний
	Семантика
	Процедура создания субмодели состояний 

	Начальное состояние
	Семантика
	Процедура создания начального состояния
	Процедура создания начального состояния из состояния

	Конечное состояние
	Семантика
	Процедура создания заключительного состояния
	Процедура создания заключительного состояния из состояния

	Точка соединения
	Семантика
	Процедура создания точки соединения

	Точка выбора
	Семантика
	Процедура создания точки выбора

	Поверхностная хронология
	Семантика
	Процедура создания поверхностной хронологии 
	Процедура создания поверхностной хронологии от состояния

	Глубокая хронология
	Семантика
	Процедура создания глубокой хронологии

	Синхронизация
	Процедура создания области синхронизации
	Процедура создания соединения

	Заключительный поток
	Процедура создания заключительного потока

	Переход
	Семантика
	Процедура создания перехода
	Процедура переключения на другой элемент

	Рекурсивный переход
	Процедура создания рекурсивного перехода 


	Использование диаграммы действий 
	Действие
	Семантика
	Процедура создания действия

	Субдейсвтвие
	Семантика
	Процедура создания субдействия 

	Решение
	Семантика
	Процедура создания решения
	Процедура создания решения от состояния

	Объектный поток
	Семантика
	Процедура создания объектного потока

	Состояние приёма сигнала
	Семантика
	Процедура создания состояния приёма сигнала

	Состояние передачи сигнала 
	Процедура создания состояния передачи сигнала 

	Область действия
	Семантика
	Процедура создания горизонтальной области действия
	Процедура создания вертикальной области действия


	Использование диаграммы компонентов 
	Компонент
	Семантика
	Процедура создания компонента
	Процедура добавления резидентного элемента
	Процедура создания отношения провайдера
	Процедура создания отношения требования

	Инстанция компонента 
	Семантика
	Процедура добавления атрибута к инстанции компонента

	Артефакт
	Семантика
	Процедура создания артефакта


	Использование диаграммы развертывания 
	Узел
	Семантика:
	Процедура создания узла
	Процедура добавления развернутого компонента
	Процедура добавления развертываемого артефакта

	Инстанция узла
	Семантика
	Процедура создания инстанции узла
	Процедура добавления атрибутной связи к инстанции узла


	Использование композиционной структурной диаграммы 
	Коллаборация
	Семантика
	Процедура создания коллаборации 



	Глава 6. Конфигурирование StarUML 
	Общая конфигурация 
	Опции [General] 
	Опции [Browser] 
	Опции [Collection Editor] 

	Конфигурация диаграмм 
	Опции [Diagram Size] 
	Опции [Grid]
	Опции [Interaction Diagram] 

	Общая конфигурация образов (представлений) 
	Опции [Default View Style]
	Опции [Default View Format] 

	Специфическая конфигурация образов 
	Опции [UseCase View] 
	 Опции [Actor View] 
	Опции [Enumeration View] 
	Опции [Interface View] 
	Опции [Artifact View] 
	Опции [Component View / ComponentInstance View]
	 Опции [Node View / NodeInstance View] 


	Глава 7. Управление модулями 
	Установка Модуля 
	Журнал загрузки модуля 

	Деинсталляция модуля 
	Деинсталляция модуля, содержащего аддин 
	Деинсталляция модуля, не содержащего аддина 


	Глава 8. Генерация кодов и документов
	Основные концепции
	Что такое генератор?
	Основные особенности

	Генерация по шаблону
	Генерация артефактов
	Регистрация шаблона
	Секция свойств [Basic]
	Секция свойства [Detail]
	Свойство [Parameters]

	Клонирование шаблона
	Свойства шаблона
	Открытие шаблона
	Удаление шаблона

	Использование пакетов
	Создание нового пакета
	Добавление шаблонов в существующий пакет
	Выполнение пакета
	Удаление шаблонов из пакета
	Создание пустого пакета
	Изменение пакета
	Удаление пакета

	Инсталляция и деинсталляция шаблонов
	Организация шаблонов
	Инсталляция и деинсталляция шаблона
	Инсталляция и деинсталляция пакета


	Глава 9. Проверка модели 
	Проверка модели 
	Процедура проверки модели: 

	Правила контроля 
	Список правил проверки


	Глава 10. Печать 
	Параметры станицы 
	Процедура просмотра информации о диаграмме: 
	Процедура установки ориентации страницы: 
	Процедура установки отступов страницы: 
	Процедура печати окаймлений страницы: 

	Печать диаграммы 
	Процедура печати текущей диаграммы: 
	Процедура печати только выбранной диаграммы: 
	Процедура печати диаграммы в размер страницы: 
	Процедура печати диаграммы на нескольких страницах: 

	Предварительный просмотр 
	Процедура предварительного просмотра результатов печати: 


	Глава 11. Справочник по интерфейсу пользователя 
	Главное окно 
	Главное меню 
	Инструментальные панели 
	Область браузера 
	Область инспектора 
	Информационная область 
	Область диаграммы 
	Палитра элементов

	Меню 
	Меню File 
	 Меню Edit 
	Меню Format 
	 Меню Model 
	 Меню View 
	Меню Tools 
	 Меню Help 
	Горячие клавиши 

	Панели инструментов 
	Инструментальная палитра 
	Общие инструменты палитры 

	Инструменты палитры ориентированные на разные типы диаграмм 

	Средства просмотра 
	Навигатор модели 
	Навигатор диаграмм 
	Редактор свойств 
	Документационный редактор 
	Редактор вложений 
	Список вложений 
	Кнопка Open 
	Кнопка Add 
	Кнопка Remove 
	Кнопка Edit 
	Кнопка Move Up 
	Кнопка Move Down 
	Редактор элемента вложения 

	Окно вывода 
	Окно сообщений 

	Диалоги 
	Редактор коллекций 
	Закладка 
	Список элементов коллекции 
	Кнопка Add 
	Кнопка Delete 
	Кнопка Move Up 
	Кнопка Move Down  

	Редактор ограничений 
	Список ограничений 
	Кнопка Add 
	Кнопка Delete 
	Кнопка Edit 
	Кнопка Move Up 
	Кнопка Move Down 

	Редактор ограничения 
	Редактор тэгов 
	Закладка профилей 
	Набор определений тэгов [Tag Definition Set]
	Значения тэгов [Tagged Values]
	Кнопка [Set As Default] (Используемый по умолчанию) 

	Менеджер профилей 
	Список [Available profiles] (Доступные профили)
	Список [Include profiles] (Включённые профили)
	Кнопка Large/Icon Small Icon 
	Кнопка Include 
	Кнопка Exclude 

	Add-In Manager 
	Список аддинов 

	Диалог Select New Project 
	Подходы 
	Open Files 
	Recent Files 

	Диалог Import Framework 
	Frameworks list 
	Кнопка Large/Icon Small Icon 
	Description 

	Диалог Page Setup 
	Option 
	Margin 
	Page orientation 
	Border 

	Диалог Print
	Printer 
	Size 
	Print Range 
	Preview 

	Диалог Print Preview 
	Print 
	One Page / Two Pages 
	<<, <, >, >> 
	Page Selection 

	Диалог Find  
	Text to Find 
	Option-Element Type 
	Option-Case Sensitive 

	Диалог Verify Model 
	Verification Rule 
	Verifying Element 
	Progress 
	Failed 

	Диалог Options 
	Option category 
	Option item 
	Description 
	Reset to default values 
	Revert to last value 

	Диалог Select Stereotype 
	Stereotypes 
	Список стереотипов
	Icon preview 
	Description 

	Диалог Select Element 
	Заголовок диалога 
	Список элементов
	Data Types 
	Do not specify 
	Выбранный элемент

	Диалог Element List 
	Заголовок диалога 
	Список элементов 
	Do not specify 

	Диалог Model Filtering 
	Elements to show 
	Select Relations 
	Deselect Relations 
	Select All 
	Deselect All 
	Set As Default 


	Горячие диалоги 
	Стандартный горячий диалог
	Кнопка Visibility 
	Поле редактирования 
	Синтаксис 

	Горячий диалог подсистемы 
	Синтаксис
	Кнопка добавления операции  

	Горячий диалог классификатора
	Синтаксис
	Кнопка добавления атрибута 

	Горячий диалог перечислимого типа
	Синтаксис

	Горячий диалог атрибута
	Синтаксис
	Кнопки

	Горячий диалог операции
	Синтаксис

	Горячий диалог конца ассоциации
	Синтаксис
	Кнопка агрегации 
	Кнопка выбора мощности   

	Горячий диалог роли классификатора
	Синтаксис
	Кнопка создания нового класса 

	Горячий диалог объекта
	Горячий диалог сообщения
	Кнопка Connect Element 
	Синтаксис
	Sequence number (for Collaboration Diagram) 

	Горячий диалог состояния
	Синтаксис
	Кнопка Add EntryAction 
	Кнопка Add DoAction 
	Кнопка Add ExitAction 

	Горячий диалог действия
	Синтаксис

	Горячий диалог примечания



